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Regarding Readers Subject to This Manual 
 

This manual is made targeting the following personnels who possess knowledge of electricity 
(knowledge of a qualified electrician or equivalent). 

● Personnel in charge to introduce FA devices 
● Personnel who designs FA system 
● Personnel who install or link FA devices 
● Personnel who manages FA site 

This manual is also made targeting personnels who understand the contents specified in the 
international standard IEC61131-3 or domestic standard JIS B 3503 regarding programing 
languages. 

 

  



ME0479-1A 

Please Read Before Use 
 
 

Thank you for purchasing our product. 

 

This instruction manual explains the handling methods, structure and maintenance of this product, 

providing the information you need in order to use the product safely. 

 

Before using the product, be sure to read this manual and fully understand the contents explained 

herein to ensure safe use of the product. 

 

Please downloaded the user’s manual from our website. 

You can download it free of charge. User registration is required for the first time downloading. 

  URL : www.iai-robot.co.jp/data_dl/CAD_MANUAL/ 

 

When using the product, print out of the necessary portions of the relevant manual, or please display 

it on your computer, tablet terminal, etc. so that you can check it immediately. 

 

After reading the instruction manual, keep it in a convenient place so that whoever is handling the 

product can refer to it quickly when necessary. 

 
 
 

 

 

 

 

 

 

 

 

 

 

  

[Important] 
● This instruction manual is an original document dedicated for this product. 
● This product cannot be used in ways not shown in this instruction manual. IAI shall not be 

liable for any result whatsoever arising from the use of the product in any other way than 
what is noted in the manual. 

● The information contained in this instruction manual is subject to change without notice for 
the purpose of product improvement. 

● If any issues arise regarding the information contained in this instruction manual, contact 
our customer center or the nearest sales office. 

● Use or reproduction of this instruction manual in full or in part without permission is 
prohibited. 

● The company names, names of products and trademarks of each company shown in the 
text are registered trademarks. 

● CODESYS is a registered trademark or trademark of CODESYS Development GmbH. 
● EtherNet/IPTM is a trademark used under ODVA licenses. 
● Windows is a registered trademark or a trademark of Microsoft Corporation in the United 

States of America and other countries and regions. 
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Safety Guide 
 
“Safety Guide” has been written to use the machine safely and so prevent personal injury or property 
damage beforehand. Make sure to read it before the operation of this product. 
 

Safety Precautions for Our Products 
The common safety precautions for the use of any of our robots in each operation. 

No. Operation 
Description Description 

1 Model 
Selection 
 

● This product has not been planned and designed for the application where 
high level of safety is required, so the guarantee of the protection of human 
life is impossible.  
Accordingly, do not use it in any of the following applications. 
1) Medical equipment used to maintain, control or otherwise affect human 

life or physical health. 
2) Mechanisms and machinery designed for the purpose of moving or 

transporting people (For vehicle, railway facility or air navigation facility) 
3) Important safety parts of machinery (Safety device, etc.) 

● Do not use the product outside the specifications.  
Failure to do so may considerably shorten the life of the product. 

● Do not use it in any of the following environments. 
1) Location where there is any inflammable gas, inflammable object or 

explosive 
2) Place with potential exposure to radiation 
3) Location with the ambient temperature or relative humidity exceeding the 

specification range 
4) Location where radiant heat is added from direct sunlight or other large 

heat source 
5) Location where condensation occurs due to abrupt temperature changes  
6) Location where there is any corrosive gas (sulfuric acid or hydrochloric 

acid) 
7) Location exposed to significant amount of dust, salt or iron powder 
8) Location subject to direct vibration or impact 

● For an actuator used in vertical orientation, select a model which is 
equipped with a brake. If selecting a model with no brake, the moving part 
may drop when the power is turned OFF and may cause an accident such 
as an injury or damage on the work piece. 
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No. Operation 
Description Description 

2 Transportation ● When carrying a heavy object, do the work with two or more persons or 
utilize equipment such as crane. 

● When the work is carried out with 2 or more persons, make it clear who is to 
be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers. 

● When in transportation, consider well about the positions to hold, weight 
and weight balance and pay special attention to the carried object so it 
would not get hit or dropped. 

● Transport it using an appropriate transportation measure. 
The actuators available for transportation with a crane have eyebolts 
attached or there are tapped holes to attach bolts. Follow the instructions in 
the instruction manual for each model. 

● Do not step or sit on the package. 
● Do not put any heavy thing that can deform the package, on it. 
● When using a crane capable of 1t or more of weight, have an operator who 

has qualifications for crane operation and sling work. 
● When using a crane or equivalent equipments, make sure not to hang a 

load that weighs more than the equipment’s capability limit. 
● Use a hook that is suitable for the load. Consider the safety factor of the 

hook in such factors as shear strength. 
● Do not get on the load that is hung on a crane. 
● Do not leave a load hung up with a crane. 
● Do not stand under the load that is hung up with a crane. 

3 Storage and 
Preservation 

● The storage and preservation environment conforms to the installation 
environment. However, especially give consideration to the prevention of 
condensation. 

● Store the products with a consideration not to fall them over or drop due to 
an act of God such as earthquake. 

4 Installation and 
Start 

(1) Installation of Robot Main Body and Controller, etc. 
● Make sure to securely hold and fix the product (including the work part). A 

fall, drop or abnormal motion of the product may cause a damage or injury. 
Also, be equipped for a fall-over or drop due to an act of God such as 
earthquake. 

● Do not get on or put anything on the product.  
Failure to do so may cause an accidental fall, injury or damage to the 
product due to a drop of anything, malfunction of the product, performance 
degradation, or shortening of its life. 

● When using the product in any of the places specified below, provide a 
sufficient shield. 
1) Location where electric noise is generated 
2) Location where high electrical or magnetic field is present 
3) Location with the mains or power lines passing nearby 
4) Location where the product may come in contact with water, oil or 

chemical droplets 
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No. Operation 
Description Description 

2 Transportation ● When carrying a heavy object, do the work with two or more persons or 
utilize equipment such as crane. 

● When the work is carried out with 2 or more persons, make it clear who is to 
be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers. 

● When in transportation, consider well about the positions to hold, weight 
and weight balance and pay special attention to the carried object so it 
would not get hit or dropped. 

● Transport it using an appropriate transportation measure. 
The actuators available for transportation with a crane have eyebolts 
attached or there are tapped holes to attach bolts. Follow the instructions in 
the instruction manual for each model. 

● Do not step or sit on the package. 
● Do not put any heavy thing that can deform the package, on it. 
● When using a crane capable of 1t or more of weight, have an operator who 

has qualifications for crane operation and sling work. 
● When using a crane or equivalent equipments, make sure not to hang a 

load that weighs more than the equipment’s capability limit. 
● Use a hook that is suitable for the load. Consider the safety factor of the 

hook in such factors as shear strength. 
● Do not get on the load that is hung on a crane. 
● Do not leave a load hung up with a crane. 
● Do not stand under the load that is hung up with a crane. 

3 Storage and 
Preservation 

● The storage and preservation environment conforms to the installation 
environment. However, especially give consideration to the prevention of 
condensation. 

● Store the products with a consideration not to fall them over or drop due to 
an act of God such as earthquake. 

4 Installation and 
Start 

(1) Installation of Robot Main Body and Controller, etc. 
● Make sure to securely hold and fix the product (including the work part). A 

fall, drop or abnormal motion of the product may cause a damage or injury. 
Also, be equipped for a fall-over or drop due to an act of God such as 
earthquake. 

● Do not get on or put anything on the product.  
Failure to do so may cause an accidental fall, injury or damage to the 
product due to a drop of anything, malfunction of the product, performance 
degradation, or shortening of its life. 

● When using the product in any of the places specified below, provide a 
sufficient shield. 
1) Location where electric noise is generated 
2) Location where high electrical or magnetic field is present 
3) Location with the mains or power lines passing nearby 
4) Location where the product may come in contact with water, oil or 

chemical droplets 
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No. Operation 
Description Description 

4 Installation and 
Start 

(2) Cable Wiring 
● Use our company’s genuine cables for connecting between the actuator and 

controller, and for the teaching tool. 
● Do not scratch on the cable. Do not bend it forcibly. Do not pull it. Do not coil 

it around. Do not insert it. Do not put any heavy thing on it.  
Failure to do so may cause a fire, electric shock or malfunction due to 
leakage or continuity error. 

● Perform the wiring for the product, after turning OFF the power to the unit, 
so that there is no wiring error. 

● When the direct current power (+24V) is connected, take the great care of 
the directions of positive and negative poles. If the connection direction is 
not correct, it might cause a fire, product breakdown or malfunction. 

● Connect the cable connector securely so that there is no disconnection or 
looseness. Failure to do so may cause a fire, electric shock or malfunction 
of the product. 

● Never cut and/or reconnect the cables supplied with the product for the 
purpose of extending or shortening the cable length. Failure to do so may 
cause the product to malfunction or cause fire. 

(3) Grounding 
● The grounding operation should be performed to prevent an electric shock 

or electrostatic charge, enhance the noise-resistance ability and control the 
unnecessary electromagnetic radiation. 

● For the ground terminal (PE) on the AC power cable of the controller and 
the grounding plate in the control panel, make sure for grounding work. For 
security grounding, it is necessary to select an appropriate wire thickness 
suitable for the load.  
Perform wiring that satisfies the specifications (electrical equipment 
standards and criteria). 
For detail, follow the description in [an instruction manual of each controller 
or controller built-in actuator]. 

● Conduct functional grounding on the FG terminal for a controller supplying 
24V DC or a controller built-in type actuator. In order to minimize influence 
to mechanical operation given by electromagnetic interference (noise) to an 
electrical device or insulation failure, conduct grounding on a terminal or a 
conductor that is electrically stable. The reference impedance should be 
Type D (Former Class 3, ground resistance 100Ω or less). 
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No. Operation 
Description Description 

4 Installation and 
Start 

(4) Safety Measures 
● When the work is carried out with 2 or more persons, make it clear who is to 

be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers. 

● When the product is under operation or in the ready mode, take the safety 
measures (such as the installation of safety and protection fence) so that 
nobody can enter the area within the robot’s movable range.  
When the robot under operation is touched, it may result in death or serious 
injury. 

● Make sure to install the emergency stop circuit so that the unit can be 
stopped immediately in an emergency during the unit operation. 

● Take the safety measure not to start up the unit only with the power turning 
ON. Failure to do so may start up the machine suddenly and cause an injury 
or damage to the product. 

● Take the safety measure not to start up the machine only with the 
emergency stop cancellation or recovery after the power failure. Failure to 
do so may result in an electric shock or injury due to unexpected power 
input. 

● When the installation or adjustment operation is to be performed, give clear 
warnings such as “Under Operation; Do not turn ON the power!” etc. 
Sudden power input may cause an electric shock or injury. 

● Take the measure so that the work part is not dropped in power failure or 
emergency stop. 

● Wear protection gloves, goggle or safety shoes, as necessary, to secure 
safety. 

● Do not insert a finger or object in the openings in the product. Failure to do 
so may cause an injury, electric shock, damage to the product or fire. 

● When releasing the brake on a vertically oriented actuator, exercise 
precaution not to pinch your hand or damage the work parts with the 
actuator dropped by gravity. 

5 Teaching ● When the work is carried out with 2 or more persons, make it clear who is to 
be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers. 

● Perform the teaching operation from outside the safety protection fence, if 
possible. In the case that the operation is to be performed unavoidably 
inside the safety protection fence, prepare the “Stipulations for the 
Operation” and make sure that all the workers acknowledge and understand 
them well. 

● When the operation is to be performed inside the safety protection fence, 
the worker should have an emergency stop switch at hand with him so that 
the unit can be stopped any time in an emergency. 

● When the operation is to be performed inside the safety protection fence, in 
addition to the workers, arrange a watchman so that the machine can be 
stopped any time in an emergency. Also, keep watch on the operation so 
that any third person can not operate the switches carelessly. 

● Place a sign “Under Operation” at the position easy to see. 
● When releasing the brake on a vertically oriented actuator, exercise 

precaution not to pinch your hand or damage the work parts with the 
actuator dropped by gravity. 

* Safety protection Fence : In the case that there is no safety protection fence, 
the movable range should be indicated. 
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No. Operation 
Description Description 

4 Installation and 
Start 

(4) Safety Measures 
● When the work is carried out with 2 or more persons, make it clear who is to 

be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers. 

● When the product is under operation or in the ready mode, take the safety 
measures (such as the installation of safety and protection fence) so that 
nobody can enter the area within the robot’s movable range.  
When the robot under operation is touched, it may result in death or serious 
injury. 

● Make sure to install the emergency stop circuit so that the unit can be 
stopped immediately in an emergency during the unit operation. 

● Take the safety measure not to start up the unit only with the power turning 
ON. Failure to do so may start up the machine suddenly and cause an injury 
or damage to the product. 

● Take the safety measure not to start up the machine only with the 
emergency stop cancellation or recovery after the power failure. Failure to 
do so may result in an electric shock or injury due to unexpected power 
input. 

● When the installation or adjustment operation is to be performed, give clear 
warnings such as “Under Operation; Do not turn ON the power!” etc. 
Sudden power input may cause an electric shock or injury. 

● Take the measure so that the work part is not dropped in power failure or 
emergency stop. 

● Wear protection gloves, goggle or safety shoes, as necessary, to secure 
safety. 

● Do not insert a finger or object in the openings in the product. Failure to do 
so may cause an injury, electric shock, damage to the product or fire. 

● When releasing the brake on a vertically oriented actuator, exercise 
precaution not to pinch your hand or damage the work parts with the 
actuator dropped by gravity. 

5 Teaching ● When the work is carried out with 2 or more persons, make it clear who is to 
be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers. 

● Perform the teaching operation from outside the safety protection fence, if 
possible. In the case that the operation is to be performed unavoidably 
inside the safety protection fence, prepare the “Stipulations for the 
Operation” and make sure that all the workers acknowledge and understand 
them well. 

● When the operation is to be performed inside the safety protection fence, 
the worker should have an emergency stop switch at hand with him so that 
the unit can be stopped any time in an emergency. 

● When the operation is to be performed inside the safety protection fence, in 
addition to the workers, arrange a watchman so that the machine can be 
stopped any time in an emergency. Also, keep watch on the operation so 
that any third person can not operate the switches carelessly. 

● Place a sign “Under Operation” at the position easy to see. 
● When releasing the brake on a vertically oriented actuator, exercise 

precaution not to pinch your hand or damage the work parts with the 
actuator dropped by gravity. 

* Safety protection Fence : In the case that there is no safety protection fence, 
the movable range should be indicated. 
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No. Operation 
Description Description 

6 Trial Operation ● When the work is carried out with 2 or more persons, make it clear who is to 
be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers. 

● After the teaching or programming operation, perform the check operation 
one step by one step and then shift to the automatic operation. 

● When the check operation is to be performed inside the safety protection 
fence, perform the check operation using the previously specified work 
procedure like the teaching operation. 

● Make sure to perform the programmed operation check at the safety speed.  
Failure to do so may result in an accident due to unexpected motion caused 
by a program error, etc. 

● Do not touch the terminal block or any of the various setting switches in the 
power ON mode.  
Failure to do so may result in an electric shock or malfunction. 

7 Automatic 
Operation 

● Check before starting the automatic operation or rebooting after operation 
stop that there is nobody in the safety protection fence. 

● Before starting automatic operation, make sure that all peripheral equipment 
is in an automatic-operation-ready state and there is no alarm indication. 

● Make sure to operate automatic operation start from outside of the safety 
protection fence. 

● In the case that there is any abnormal heating, smoke, offensive smell, or 
abnormal noise in the product, immediately stop the machine and turn OFF 
the power switch. Failure to do so may result in a fire or damage to the 
product. 

● When a power failure occurs, turn OFF the power switch. Failure to do so 
may cause an injury or damage to the product, due to a sudden motion of 
the product in the recovery operation from the power failure. 
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No. Operation 
Description Description 

8 Maintenance 
and Inspection 

● When the work is carried out with 2 or more persons, make it clear who is to 
be the “leader” and who to be the “follower(s)” and communicate well with 
each other to ensure the safety of the workers. 

● Perform the work out of the safety protection fence, if possible. In the case 
that the operation is to be performed unavoidably inside the safety 
protection fence, prepare the “Stipulations for the Operation” and make sure 
that all the workers acknowledge and understand them well. 

● When the work is to be performed inside the safety protection fence, 
basically turn OFF the power switch. 

● When the operation is to be performed inside the safety protection fence, 
the worker should have an emergency stop switch at hand with him so that 
the unit can be stopped any time in an emergency. 

● When the operation is to be performed inside the safety protection fence, in 
addition to the workers, arrange a watchman so that the machine can be 
stopped any time in an emergency. Also, keep watch on the operation so 
that any third person can not operate the switches carelessly. 

● Place a sign “Under Operation” at the position easy to see. 
● For the grease for the guide or ball screw, use appropriate grease according 

to the instruction manual for each model. 
● Do not perform the dielectric strength test. Failure to do so may result in a 

damage to the product. 
● When releasing the brake on a vertically oriented actuator, exercise 

precaution not to pinch your hand or damage the work parts with the 
actuator dropped by gravity. 

● The slider or rod may get misaligned OFF the stop position if the servo is 
turned OFF. Be careful not to get injured or damaged due to an 
unnecessary operation. 

● Pay attention not to lose the removed cover or screws, and make sure to 
put the product back to the original condition after maintenance and 
inspection works. 
Use in incomplete condition may cause damage to the product or an injury. 

* Safety protection Fence : In the case that there is no safety protection fence, 
the movable range should be indicated. 

9 Modification 
and Dismantle 

● Do not modify, disassemble, assemble or use of maintenance parts not 
  specified based at your own discretion. 

10 Disposal ● When the product becomes no longer usable or necessary, dispose of it 
properly as an industrial waste. 

● When removing the actuator for disposal, pay attention to drop of 
components when detaching screws. 

● Do not put the product in a fire when disposing of it. 
The product may burst or generate toxic gases. 

11 Other ● Do not come close to the product or the harnesses if you are a person who 
requires a support of medical devices such as a pacemaker. Doing so may 
affect the performance of your medical device. 

● See Overseas Specifications Compliance Manual to check whether 
complies if necessary. 

● For the handling of actuators and controllers, follow the dedicated 
instruction manual of each unit to ensure the safety. 
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No. Operation 
Description Description 

8 Maintenance 
and Inspection 

● When the work is carried out with 2 or more persons, make it clear who is to 
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each other to ensure the safety of the workers. 
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that the operation is to be performed unavoidably inside the safety 
protection fence, prepare the “Stipulations for the Operation” and make sure 
that all the workers acknowledge and understand them well. 

● When the work is to be performed inside the safety protection fence, 
basically turn OFF the power switch. 

● When the operation is to be performed inside the safety protection fence, 
the worker should have an emergency stop switch at hand with him so that 
the unit can be stopped any time in an emergency. 

● When the operation is to be performed inside the safety protection fence, in 
addition to the workers, arrange a watchman so that the machine can be 
stopped any time in an emergency. Also, keep watch on the operation so 
that any third person can not operate the switches carelessly. 

● Place a sign “Under Operation” at the position easy to see. 
● For the grease for the guide or ball screw, use appropriate grease according 

to the instruction manual for each model. 
● Do not perform the dielectric strength test. Failure to do so may result in a 

damage to the product. 
● When releasing the brake on a vertically oriented actuator, exercise 

precaution not to pinch your hand or damage the work parts with the 
actuator dropped by gravity. 

● The slider or rod may get misaligned OFF the stop position if the servo is 
turned OFF. Be careful not to get injured or damaged due to an 
unnecessary operation. 

● Pay attention not to lose the removed cover or screws, and make sure to 
put the product back to the original condition after maintenance and 
inspection works. 
Use in incomplete condition may cause damage to the product or an injury. 

* Safety protection Fence : In the case that there is no safety protection fence, 
the movable range should be indicated. 

9 Modification 
and Dismantle 

● Do not modify, disassemble, assemble or use of maintenance parts not 
  specified based at your own discretion. 

10 Disposal ● When the product becomes no longer usable or necessary, dispose of it 
properly as an industrial waste. 

● When removing the actuator for disposal, pay attention to drop of 
components when detaching screws. 

● Do not put the product in a fire when disposing of it. 
The product may burst or generate toxic gases. 

11 Other ● Do not come close to the product or the harnesses if you are a person who 
requires a support of medical devices such as a pacemaker. Doing so may 
affect the performance of your medical device. 

● See Overseas Specifications Compliance Manual to check whether 
complies if necessary. 

● For the handling of actuators and controllers, follow the dedicated 
instruction manual of each unit to ensure the safety. 
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Alert Indication 

The safety precautions are divided into “Danger”, “Warning”, “Caution” and “Notice” according to the 
warning level, as follows, and described in the Instruction Manual for each model. 
 

Level Degree of Danger and Damage Symbol 

Danger 
This indicates an imminently hazardous situation which, if the 
product is not handled correctly, will result in death or serious 
injury.  

Danger 

Warning 
This indicates a potentially hazardous situation which, if the 
product is not handled correctly, could result in death or serious 
injury.  

Warning 

Caution 
This indicates a potentially hazardous situation which, if the 
product is not handled correctly, may result in minor injury or 
property damage.  

Caution 

Notice This indicates lower possibility for the injury, but should be kept to 
use this product properly.  Notice 
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Precautions for Use 
 

 Have a safety circuit equipped outside the programing controller so the whole system activates to 
the safety side even when there is an error occurred on an external power source or a 
malfunction occurred in the programing controller itself. Otherwise, it may cause an accident due 
to error output or error operation. 

(1) Construct interlock circuits for inconsistent operations such as emergency stop circuit, 
protection circuit and normal/reversed rotations and interlock circuits for mechanical damage 
prevention such as upper/lower limits of positioning outside the programing controller. 

(2) The programing controller stops the arithmetic operation once it detects the following error 
conditions and the output gets to the following status. 
● All outputs turn OFF when the overvoltage protection device is activated. 
● All outputs are to be retained or turned off depending on parameter settings when an error 

is detected with the self-diagnosis feature such as watchdog timer error in the programing 
controller. 

(3) All outputs may get turned on during an error that cannot be detected in the CPU unit such 
as the input and output control part. Construct a fail-safe circuit or equip a safety feature 
outside the programing controller so the operation of the mechanism activates in the safety 
side at that moment. 

(4) Outputs may remain ON or OFF due to malfunction of an output circuit relay or transistor. 
Have a circuit externally to monitor such output signals that may leads to crucial accidents. 

 
 As there is a risk of emitting smoke or fire at the output circuit when overcurrent flows for long 

period of time due to load current or load short-circuit above the ratings, have a safety circuit 
such as a fuse equipped externally. 

 
 Construct a circuit to have an external power supply gets turned on after the power to the 

programing controller is turned on. Having the external power supply turned on first may cause 
accident due to error output or error in operation. 

 
 Refer to a manual of each network for the operation status of each station when there is a 

communication error in the network. An accident may be caused due to error output or error in 
operation.   
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 When it is necessary to have a control (data change) to a programing controller under operation 
by connecting an external device, have an interlock circuit constructed on the program so the 
whole system always activate to the safety side.  
Also, read the manual well to understand safety fully when conducting other controls (program 
change, parameter change, compulsory output or operation status change (status control)) to a 
programing controller under operation. Failure to do so may cause mechanical damage or 
accident due to operation mistakes. 

 
 In case of control from an external device to a programing controller in a remote location, an 

immediate action to a trouble in the programing controller side may be difficult due to a data 
communication error. Construct an interlock circuit in the program. Also, set up a countermeasure 
as a system between the external device and the programing controller for any case of 
occurrence of a data communication error at the same time. 

 
 The communication line gets unstable when a communication cable breaks, which could cause 

communication error in the network to several stations. Construct an interlock circuit in a program 
so the system activates in the safety side. An accident may be caused due to error output or error 
in operation. 

 
 Implementation of a countermeasure by a user is required when it is necessary to secure safety 

of a programing controller from unauthorized access from an external device via network. Also, 
implementation of a countermeasure such as firewall is required when it is necessary to secure 
safety of a programing controller from unauthorized access from an external device via internet. 

 
 Pay special attention to safety for operation such as program change or compulsory output while 

the system is running. It may cause damage to the machinery or accident by operation mistake. 
 
  



 
Precautions for Use 

 

Intro-10 ME0479-1A 

 The CODESYS for XSEL2 window display shown in this manual may differ partially depending 
on the versions. See the used CODESYS for XSEL2 for the actual contents of display on the 
window. 

 
● In arithmetic operation of real numbers: 

- Negative square root 
- Negative logarithm 
- Any number less than -1 or more than +1 in ASIN/ACOS command arithmetic operation 
- Arithmetic operation using NaN (Not a Number) 

These factors should make the result NaN (Not a Number). 
As the following arithmetic operation cannot be made properly using that result, make sure to 
make programing with the calculation result not to become NaN (Not a Number). 

 
●The behavior when a value overflows: 

- Overflow of integral number: Overflow occurs and proper result cannot be gain 
- Overflow of real number: Makes result of Infinity (actual positive infinity) and -Infinity 

(actual negative infinity). 

As the following arithmetic operation after overflow cannot be made properly using that result, 
make sure to make programing with no overflow. 
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Application of Product 
 
(1) In order to use our product, it is the condition of use that it is used for a purpose that would not 

cause crucial accident even in case there is a malfunction or error on the product, and that 
backup and fail-safe feature is performed systematically in an external device in case of 
malfunction or error. 

 
(2) IAI should not be responsible for any loss, damage or expense directly or indirectly caused 

even if any of IAI product, installed software, computer devices, computer programs, network 
or data base is infected by DDoS attach (Distributed Denial of Service Attack), computer virus, 
any other technically harmful program or unauthorized access. 
Users must have sufficient measures for: 

1) Anti-virus protection 
2) Data input and output 
3) Recovery of lost data 
4) Protection from computer virus infection to IAI product or PC that the software is installed 
5) Protection from unauthorized access to IAI products 

 
(3) IAI products are designed and manufactured as a general product subject to general industrial 

purpose. Therefore, application of IAI products should be exclusive from any use in such 
special purposes of devices and systems as shown below. IAI should not be responsible for 
quality, performance or safety of its products (including responsibility in debt default, 
responsibility in warranty against defects, responsibility in quality assurance, responsibility to 
illegal actions, responsibility to products and others) in case of use in such purposes. 

● Purpose where influence is large to public such as a nuclear power plant or any other power 
plant of power companies 

● Purpose where there are some requirements to IAI to construct special quality assurance 
organizational structure such as railway companies and the government and municipal 
offices 

● Purpose where large influence is expected to human life, physical and properties such as 
aerospace, medical, railway, combustion and fuel equipment, passenger vehicle, manned 
transportation equipment, entertainment machinery or safety machinery 
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However, even in the purposes above, under a condition of the purpose is to be specified or 
no requirement of special quality (quality requirement above general specifications), we may 
permit to apply our IAI program controllers. For details, consult with our sales office or contact 
our call center. 

  



 
Application of Product 

 

Intro-12 ME0479-1A 

However, even in the purposes above, under a condition of the purpose is to be specified or 
no requirement of special quality (quality requirement above general specifications), we may 
permit to apply our IAI program controllers. For details, consult with our sales office or contact 
our call center. 

  

 
Trademark and Patent 

 

ME0479-1A Intro-13 

Trademark and Patent 
 

[1] About Registered Trademark 
● CODESYS is a registered trademark of CODESYS Development GmbH. 
● ODVA, CIP and EtherNet/IP are a trademark of ODVA, Inc. 
● OPC, OPC UA are a trademark of OPC Foundation. 
● Microsoft and Windows are the registered trademark or trademark of U.S. Microsoft Corporation 

in the United States and other countries. 
● Ethernet is a registered trademark of FUJIFILM Business Innovation Corp. 
● PLCopen is a registered trademark that PLCopen possesses. 
● And other company names and product names described are the trademarks and registered 

trademarks of each company. 
 
 

[2] About Patent 
Screenshots are using under permission of Microsoft. 
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Software License Agreement 
 
Before opening the software package, please read this Software License Agreement (hereinafter 
referred to as “Agreement”). 
This Agreement is applied to the simple installation application for this product (hereinafter referred 
to as “this Software”, and also includes updated versions.). 
Regardless of the reason, opening the this Software package will be regarded as your 
acknowledgement of consenting to this Agreement. You may not use this software if you do not 
agree to the terms of this Agreement. 
IAI Corporation (hereinafter referred to as “IAI”) shall grant to the user (hereinafter referred to as “the 
User”), and the User shall accept, a non-transferable, non-exclusive right to use the Licensed 
Software supplied with this Agreement, based on the following terms and conditions. 
 

Witnesseth 
1. Term of the Agreement 
This Agreement shall take effect the moment the User opens the Licensed Software and remain 
effective until the User submits a termination request to IAI in writing or the Agreement is otherwise 
terminated pursuant to the provision of Section 3. 
 
2. Licensing 
If the User owns an electronic medium, such as DVD-R, which is sold by IAI and which this Software 
is recorded to, or if user registration has been held to this Software, it should be allowed that the 
User uses this Software on multiple computers. 
The user should not be allowed to have himself or a third party performs modification, reverse 
engineering, disassembly, decompile, translation or adaptation entirely or partially in this Software. 
If the User violates anything in the agreement and causes any loss to IAI, the User is to compensate 
the loss caused to IAI. 
 
3. Termination of the Agreement 
In the event of breach by the User of any of the terms and conditions hereunder, or upon discovery 
of a material cause that makes continuation of this Agreement impossible, IAI may immediately 
terminate this Agreement without serving any prior notice to the User. 
In this case, the User should delete or dispose everything of this Software (including software 
copies) and dedicated connection cables within ten days after the day when the Agreement is 
terminated. 
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4. Range of Guarantee 
IAI does not guarantee that this Software works in normal condition in every operational 
environment. 
IAI may change all the specifications related to this Software without serving any prior notice. Also, 
IAI should not take any responsibility to any loss or damage caused as a result of use of this 
Software. 
The User or a third party agrees not to claim compensation for damage from IAI for any loss suffered 
by the User or a third party as a result of installing and using the Licensed Software. 
Based on this Agreement, the upper limit of the responsibility that IAI may take should be the amount 
of money that the User has actually paid to purchase this Software. 
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About License of Used Software 
 
About Software License Used for This Product 
 
The software of IAI products include the program for the open source software (OSS) below. 
• OpenSSL 3.0.11 (Apache License 2.0) 
 
For the license terms of the applicable software, refer to [9.3 License of Software Used in CODESYS 
for XSEL2] in this manual. 
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Terms List 
 

Here explains the terms used in this manual. 

Terns Explanation 

CA (Certificate Authority) It is an institution to issue digital certificate necessary for encrypted 
communications. 

CIP 
It is an abbreviation for Common Industrial Protocol. 
It is the standard specifications for industrial communication defined in 
Open DeviceNet Vendors Association (ODVA). 

CODESYS for XSEL2 It is a support software of CODESYS installed in the products of IAI.  
It may be expressed as “CODESYS” in this manual. 

EDS File It is a file that input and output counts for EtherNet/IP devices and 
parameters available for setting via EtherNet/IP are written in. 

FB It is an abbreviation for Function Block. 

IEC 61131-3 

It is the international standard specifications as a programming language 
for PLC. 
As a programing description language, there are 5 languages specified 
as follows: 
・Ladder Diagram (LD) 
・Sequential Function Charts (SFC) 
・Function Block Diagram (FBD) 
・Structured Text (ST) 
・Instruction List (IL). 

I/O Refresh It is the periodical data exchange with external of memory area defined in 
advance. 

ISO3166 It is the standard for the country codes issued by ISO. 

MES 

It is an abbreviation for Manufacturing Execution System. 
It is the production execution system that is the data system to grasp and 
manage condition of production process and to make instruction to 
operators. 

OPC UA It is the standard specifications for industrial communication defined in 
OPC Foundation. 

OPC UA Client 
The side to access the OPC UA server and conduct data reading/writing 
request is called a client. SCADA, MES and a display device are typical 
examples of the OPC UA client. 

OPC UA Server The data is stored in OPC UA, and the side open is called a server.  
In this manual, XSEL2 should activate as the OPC UA server. 

PLC It is an abbreviation of Programmable Logic Controller. 
Control devices used for control of devices and equipment are so-called. 

PLC-MIX 

It is what gives the index for the calculation performance of PLC, and is 
the number of commands capable of executing in a unit time prioritized 
following the command distribution ratio. 
As the related terms, there are “Basic PLC-MIX”, “Practical PLC-MIX” and 
“Integrated PLC-MIX”. 

POU 

It is an abbreviation for Program Organization Unit. 
POU (Program Organization Unit) is the minimum unit for program 
management constructed with several command languages, and there 
are three types, "Program", "Function" and "Function Block". 

PTP It is a control system with no indication of any point to go through when 
moving from the current position to the target position. 
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Terns Explanation 

RPI 
It is an abbreviation of Requested Packet Interval. 
It is the communication period determined by the originator in 
communication among EtherNet/IP devices. 

SCADA 
It is an abbreviation for Supervisory Control and Data Acquisition. 
It is a type of the industrial control system, and is the data system to 
perform system monitoring and process control by a computer. 

SEL Program It is a program described in our own programing language of IAI. 
SEL is an abbreviation for Shimizukiden Ecology Language. 

UTC (Coordinated 
Universal Time) It is the time used as the origin of the universal standard time. 

Adapter In EtherNet/IP, the "slave" in other field network is called "adapter" 
instead. 

Edge Transition of boolean variance "from 0 to 1" is called rising edge, while 
transition of boolean variance "from 1 to 0" is called "falling edge". 

End Point (URL) 

It is the address of OPC UA server necessary for OPC UA clients to 
access. 
Format: opc.tcp:// [IP address]: [Port number] 
Example: opc.tcp://192.168.0.10:4840 

Practical PLC-MIX 
It is the average number of commands available to execute in 1μs when 
combining practical commands such as each type of calculation and transfer 
applicable to words (16 bits) in a certain ratio. 

Pressing It is a feature to have a rod or slider being pressed and retained towards a 
workpiece. 

Originator It is a device to command connection establishment in EtherNet/IP. 

Basic PLC-MIX 
It is the average number of commands available to execute in 1μs when 
combining only the input and output processes and timer/counter 
processes in a certain ratio. 

Basic Data Types 

It is the data types defined in IEC 61131-3. 
There are boolean datatype, bit string type, integer type, real data type, 
duration type, date data type, time data type, date time type and string 
type. 

Union Type It is the data type that enables to handle the same data in different data types. 

Client Certificate 

It is an electronic certificate to prove identity of OPC UA client with the 
application authentication. 
Authentication should be conducted by registering the client certificate to 
OPC UA server. 

Global Variables It is the variables available for reading and writing from all the POU 
(programs, function blocks and functions) 

Home return The datum point for positioning is called the home position and it is the 
operation to move an actuator to this position. 

Structure Type It is the data type that several different data types are hierarchically 
combined. 

Comment It is a text to write a program or an explanation of variables. 

Server Certificate 

It is an electronic certificate to prove identity of OPC UA server with the 
application authentication. 
Authentication should be conducted by registering the server certificate to 
OPC UA client. 

Servo OFF It is the status that the motor power is turned off. 

Servo ON It is the status that the motor power is turned on. 



 
Terms List 

 

Intro-18 ME0479-1A 

Terns Explanation 
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Terns Explanation 

Initial value 
It is one of the attributes for variables. It is the value of variable to be set 
for the following. 
● When power is turned on 

Sustain 

It is one of the attributes of a variable. 
The values will be maintained even during power cutoff as it is stored in 
non-volatile memory. 
The keyword "PERSISTANT" should be used in IEC 61131-3. 

Scanner In EtherNet/IP, the "master" in other field networks is called "scanner" 
instead. 

Integrated PLC-MIX 
It is the average number of commands available to execute in 1μs when 
combining the basic commands and the practical commands in a certain 
ratio. 

Target It is the devices that connection is required to be established in 
EtherNet/IP. 

Time zone It is the whole region that use standard time and civil time in common. 

Task The task shows a unit of execution. By registering a program in a task, 
the program can be executed. 

Linear Interpolation It is an interpolation control that controls the operation of an 
actuator/robot as a linear track. 

Constant 

It is one of the attributes for variables. 
A variable that a constant is indicated should not be available for writing in 
a value by a command. 
The keyword "CONSTANT" should be used in IEC 61131-3. 

Device It is a general term for those that a CPU unit conducts I/O Refresh. 
Specific examples are EtherNet/IP scanner and SEL interface. 

Namespace It is the structure to manage functions, function block definitions and data 
type names divided and hierarchized. 

Layout Indication 

It is one of the indications for variables. 
Elements in the same data type are consolidated and made as one 
variable. Each element is to be indicated in serial numbers (index) from 
the top. 

Partial Range Indication 
(Subrange Indication) 

It is one of the indications for variables. 
It clarifies that variables can be taken only from those in the specified 
range. 

Function It is a POU used to generate a component that an output can be 
determined uniquely to an input such as arithmetic processing. 

Function Block It is a POU used to generate a component that an output may differ to the 
same input depending on the status of timer or counter. 

Program It is a POU that operates by assigning to a task. 

Variable It is a name of a data memory domain defined by the data type and the 
data in the variable declaration. 

Retain 

It is one of the attributes for variables. 
The values will be maintained even during power cutoff as it is stored in 
non-volatile memory. 
The keyword "RETAIN" should be used in IEC 61131-3. 

Position Data It is data of table format to register "Target Position Coordinates", 
"Velocity" and "Acceleration/Deceleration" of an actuator and robot. 

Command It is a processing element in the minimum unit to be described in a POU. 

Enumerated Type It is the data type that one in a name list (enumerator) prepared in 
advance should be taken as a value. 
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Terns Explanation 

Enumerator 

It is what several values that the variables in the enumerated type may 
take are expressed in characters. 
A value of variables in the enumerated type should take one in the 
enumerators. 

Level Detection To detect the status itself that the Boolean variable “is 1” (or “is 0”) is 
called the level detection (level sensing). 

Local Variable It is a variable accessible only in the defined POU. 
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1.1 Introduction 

 
In addition to the SEL language interpreter, the software PLC feature is capable of control complied 
with the PLC language international standard IEC 61131-3. Also, the software PLC is equipped with 
"CODESYS", and applicable for the EtherNet/IP scanner feature and the OPC UA server feature. 
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1.2 Subject Products 

 
In this manual, subjects to the following products. 
● XSEL2-T□ 
● XSEL2-T□X 
 
* PLC features are equipped in XSEL2 in standard. 
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1.3 Characteristics 

 
(1) Applicable for all programing languages complied with international standard IEC 61131-3 

Development not dependent to vendors is enabled, which leads to efficient programing and 
sharing of programing properties. 

 
(2) Equipped with OPC UA Server Feature 

OPC UA server complied with the standard communication specifications recommended in 
Industry 4.0. 
It simplifies connection with SCADA, MES and display devices. 

 
(3) Applicable for EtherNet/IP Scanner Feature 

As it is an open field network, connection and control of products from other companies is 
capable as well as IAI products. 

 
(4) Integrated Sequence Control and Actuator Robot Control 

It provides the dedicated function block to control IAI actuators and SEL programs from a PLC. 
 

(5) Capable of consolidated management of PLC, EtherNet/IP scanner feature and OPC UA server 
feature in the CODESYS for XSEL2. 

 
In one software, PLC setup, programing and debugging are capable, which enables efficient 
development works. 
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CODESYS Support Tools 

It is necessary for setting to create programs, of EtherNet/IP scanner features and OPC UA server 
features in PLC. 
 

No. Part name Model Number 

1 CODESYS for XSEL2 - 

 
Teaching Tool 

A teaching tool is necessary for setup operations such as creating SEL programs, position setting 
in teaching of robot and actuators and parameter setting. 
 
Use one of the following teaching tools. 
 

No. Part name Model Number 

1 XSEL PC software IA-101-* 

2 Teaching pendant 
(Normal / with a dead man’s switch） TB-02/TB-02D 

3 Teaching pendant TB-03 

 

Single-Axis Robot 

Cartesian Robot 

SCARA Robot 

(To be prepared by user) 
MES, SCADA, Display Device, etc. 

OPC UA 

EtherNet/IP 

CODESYS for  
XSEL2 

(To be prepared  
by user) 

PLC TB-02 

PC software for XSEL Regenerative  
Resistor Unit 

Sensor / Actuator, etc. 
(To be prepared by user) 
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Number Name 

(1) Panel window 

(2) Switches between AUTO/MANU mode 

(3) Ethernet connector 

(4) Status LED 

(5) USB connector 

(6) Teaching connector 

(7) I/O slot 1 

(8) I/O slot 2 

 
  

(1) 

(2) 
(3) 
(4) 

(5) 

(6) 

(7) (8) 
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(1) Panel window 

The status of a controller should be displayed with the 7-segment display with 4 digits and 4 LED 
lamps. 
The PLC status display is as shown below. 

 
 

Name Meaning 

PLC RUN 
Operation status of software PLC is displayed. 
In Operation: Illuminated, Stopped: OFF 

PLC ERR 
Error status of software PLC is displayed. 
Error Occurred: Illuminated, Error Not Occurred: OFF 

 
Alphanumeric characters do not show the PLC status. For details about alphanumeric display, 
refer to the separate volume [XSEL2 Controller Instruction Manual (ME0478)]. 

 
 

（2）Switches between AUTO/MANU mode 

It is a switch to indicate the operation mode of a controller. 

 
 

Name Meaning 

MANU 
(MANU mode) 

Left side 
It is a mode to set up PLC and make a trial run. 
Turn the power on or reboot the system and the PLC stops operation. 

AUTO 
(AUTO mode) 

Right side 
It is a mode to operate PLC. 
Turn the power on or reboot the system and the PLC starts operation. 

  

PLC ERR PLC RUN 
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(3) Ethernet connector 

It is a connector to link an external Ethernet communication device. 
PLC uses this Ethernet port to use the following features. 
 EtherNet/IP Scanner feature 
 OPC UA server feature 
 Connection of CODESYS for XSEL2 

 
 Ethernet Connector Specifications 
 

Connector to be Used RJ-45 connector (8 Pin) 1-2301994-1 (TE) 

Physical Layer Standard 10/100/1000BASE-T  

Communication speed 10/100/1000Mbps Auto negotiation 

Connected unit PC, etc. (Ethernet)  

Connection cable Ethernet (LAN) Cable 
Recommended Cable: STP cable 
(Manufactured by 3M) 
Category 5e or higher 

 
 Pin Assignment of Ethernet Connector 
 

Pin No. 
Signal name 

Signal content 
1000Mbps 10/100Mbps 

1 TRD0+ TXP Sending Receiving Differential + (Data 0) / Sending + 

2 TRD0- TXN Sending Receiving Differential - (Data 0) / Sending - 

3 TRD1+ RXP Sending Receiving Differential + (Data 1) / Sending + 

4 TRD2+ - Sending Receiving Differential + (Data 2) 

5 TRD2- - Sending Receiving Differential - (Data 2) 

6 TRD1- RXN Sending Receiving Differential - (Data 1) / Sending - 

7 TRD3+ - Sending Receiving Differential + (Data 3) 

8 TRD3- - Sending Receiving Differential - (Data 3) 

 
  

8 

1 
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(4) Status LED 

It is the status display LED of the EtherNet/IP scanner. 

 
 

Name Color Display 
status Content 

ML 

Green 
Light ON Normal operation 

Blinking No PLC application 

Orange 

Light ON Status not capable to recover (PLC not possible to execute, etc.) 

Blinking 

Status capable to recover 
(IEC program excluded, IEC program memory error, etc. Status 
capable to recover in reset of software PLC and download of 
application) 

- Light OFF Functions disabled 

NL 

Green 
Light ON Connection of one or more is established 

Blinking Connection not established 

Orange 
Light ON IP addresses duplicated 

（(Duplication not detected in XSEL2) 
Blinking Connection of one or more is timed out 

- Light OFF IP address not set, functions disabled 

* ML and NL turn on in turns of Green on ML → Orange on ML → Green on NL → Orange on NL 
while the power gets turned on (in self-test). 

 
  

ML 

NL 
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ML 

NL 
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(5) USB connector 

It is a USB connector to connect a PC. Work such as setup of PLC is available by connecting to 
CODESYS for XSEL2. 
The connector is mini-B. In order to operate an actuator and a robot in MANU Mode, the dummy 
plug needs to be inserted to the teaching connector. 

 
 USB Connector Specifications 

 
Connector to be Used USB mini-B 51387-0530 (Molex) 

Connector name USB  

Communication 
Specification Conformed to USB 2.0 480M (High Speed)/12Mbps (Full Speed) 

Maximum connection 
distance 5m  

Connected unit PC (USB port)  

Recommended cable USB cable Controller side: mini-B 

Power Bus-Power  

 
 Pin Assignment of USB Connector 

 
Pin No. Signal Name Signal content 

5 Vbus USB Power supply input (+5V) 

4 D- USB Differential transmitted/received data - side 

3 D+ USB Differential transmitted/received data + side 

2 ID USB ID (dentification) terminal (Open at cable end) 

1 GND Power supply ground 

Shell GND Power supply ground 

 
  

5 

1 
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(6) Teaching connector 

It is a connector to connect a teaching pendant or a PC (XSEL PC software). It is to be used for 
teaching such as operation and setup of an actuator. 

 
 Teaching Connector Specifications 

 
Connector model HDR-EC26LFDT1-SLD+ 

Manufacturer HONDA TSUSHIN KOGYO CO., LTD 

Rated voltage AC125Vrms 

Rated current 0.5A 

Voltage Endurance AC350Vrms 

Contact Resistance 70mΩ or less 
 

Pin Assignment of Teaching Connector 
 
Pin 
No. 

Signal 
name Description Pin 

No. 
Signal 
name Description 

1 SG Signal Grounding 14 CTS 

Connected to RTS 
externally. 
Connector connection 
detection input. 

2 NC  15 TXD Transmit data 

3 VCC Power supply output 
(Power for teaching pendant) 16 RXD Receive data 

4 DTR Terminal ready  
(Connected to DSR inside) 17 DSR 

Equipment ready 
(Connected to DTR 
inside) 

5 EMGS2+ Emergency Stop Contact Output 2+ 18 NC Unconnected 

6 EMGS2- Emergency Stop Contact Output 2- 19 NC Unconnected 

7 NC Unconnected 20 NC Unconnected 

8 RSVVCC 24V power supply for teaching 
pendant 21 NC Unconnected 

9 EMGS1- Emergency Stop Contact Output 1- 22 ENBS2+ Enable contact output 2 + 

10 NC Unconnected 23 ENBS1- Enable contact output 1 - 

11 NC Unconnected 24 ENBS1+ Enable contact output 1 + 

12 EMGS1+ Emergency Stop Contact Output 1+ 25 ENBS2- Enable contact output 2 - 

13 RTS Connected to CTS externally 26 SG Signal Grounding 
 

1 
14 

13 26 
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(7) I/O slot 1 
The following option boards are available to mount. They can also be used as an external input 
and output interface. 
 

Name Expression of 
Model Codes Remarks 

PIO board (NPN)(16/16) type NP  

PIO board (PNP)(16/16) type PN  

DeviceNet board DV  

CC-Link board CC  

PROFIBUS-DP board PR  

IA-NET board IA PIO can be increased by connecting the 
remote I/O unit (model code: EIOU-1). 

Pulse Train Input + PIO Input 
and Output (4 points / 4 points) 
Board 

PIN 
It is available only for PIO input and output in 
PLC. 
The pulse train input is not available. 

ELECYLINDER Connection 
Module Board EL  

 
(8) I/O slot 2 

The following option boards are available to mount. They can also be used as an external input 
and output interface. 
 

Name Expression of 
Model Codes Remarks 

PIO board (NPN)(16/16) type NP  

PIO board (PNP)(16/16) type PN  

CC-Link IE Field board CIE  

EtherCAT board EC  

EtherNet/IP board EP  

PROFINET IO board PRT  

IA-NET board IA PIO can be increased by connecting the 
remote I/O unit (model code: EIOU-1). 

Pulse Train Input + PIO Input 
and Output  
(4 points / 4 points) Board 

PIN 
It is available only for PIO input and output in 
PLC. 
The pulse train input is not available. 

ELECYLINDER Connection 
Module Board EL  
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(7) (8) I/O slot 1, I/O slot 2 

By occupying two slots, I/O Slot 1 and I/O Slot 2, 50-pin PIO board compatible to existing XSEL. 
The boards can be divided to the following specifications. 
As it uses I/O Slot 1 and I/O Slot 2, another field network module cannot be used. It can also be 
used as an external input and output interface of PLC. 

 

Name Expression of 
Model Codes Input point Output point Polarity 

XSEL Compatible 
PIO Board 

N1 32 16 NPN 

P1 32 16 PNP 

N2 16 32 NPN 

P2 16 32 PNP 

N4 24 24 NPN 

P4 24 24 PNP 
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1.6 Flow Till Operation 

 
Here, explains the workflow from installing the XSEL2 controller till operation. 
 

Step1. Installation and Wiring 

Install a controller, robot and connected devices, and conduct wiring. 
 
 

Step2. Power on 

Turn on the power to the controller and connected devices. 
 
 

Step3. SEL parameter setting 

Connect a teaching tool (XSEL PC software or teaching pendant) and set up the parameters. 
 
 

Step4. Communication setting on Host PLC (When using the upper PLC) 

Refer to [an instruction manual of PLC to be used] for the host PLC. 

 
 

Step5. CODESYS Parameter Communication Feature Setup 

When PLC feature is to be used, connect a teaching tool and set up the parameters to use 
the software PLC feature. After that, connect to CODESYS for XSEL2 to set up the SEL 
interface feature and EtherNet/IP scanner feature. (*1) 
Refer to  
● [Chapter 4 How to Use CODESYS] 
● [Chapter 5 SEL Interface feature] 
● [6.1 EtherNet/IP Scanner feature]. 

*1 As the OPC UA server feature requires variables used in the user program of CODESYS to 
be registered, it is necessary to set it up after the CODESYS program is created. 

 
 

Step6. Confirming Establishment of Communication with Host PLC (When using the 
upper PLC) 

Establishment of communication can be confirmed on LED for XSEL2. 
For the host PLC, refer to [an instruction manual of PLC to be used]. 
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Step7. Checking the safety circuit 

Check if the emergency stop circuit (such as drive cutoff circuit) works properly. 

 
 

Step8. Creating CODESYS Program 
Connect to CODESYS for XSEL2 and create a program. 
Refer to  
● [4.5 Programming] 
●Separate volume [PLC Feature Programing Manual (ME0480)]. 

 
 

Step9. Creating SEL Program, Setting up Position Data 
Connect a teaching tool, create the SEL program, and set up the position coordinate, velocity 
and acceleration/deceleration to the position data. 
Refer to the separate volume [PLC Feature Programing Manual (ME0480)]. 

 
 

Step10. Setting up OPC UA Server Feature and Confirmation of Connection (When Using 
OPC UA) 

Connect to CODESYS for XSEL2 and set up the OPC UA server feature. 
Refer to [6.2 OPC UA server feature]. 

 
 

Step11. Motion Check and Operation on Actual Unit 

Check the motions with the actual unit. 

 
 

 
Caution 
● The procedures may differ depending on the environment of use for this product and 

used system types. 
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2.1 PLC Performance / Feature Specifications 

 
 

Item Specification 

Runtime Version V3.5.18.20 + EtherNet/IP 4.4.1.0 

Cyclic Frequency 1ms to 

IEC Program Capacity 3MB 

Source Capacity 10MB 

Data Capacity 1MB 

Data Capacity (RETAIN) 8KB 

Data Capacity (PERSISTENT) 4KB 

Executed Task Count 8 (However, freewheel counted as 1) 

Program specification Conformed to IEC 61131-3, 5 languages (LD, IL, FBD, 
ST, SFC) + CFC 

Program Type Cyclic, Event, Status, Freewheel 

Calculation Control System Stored Program Type 

Input and Output Control System Refresh Type 

Calculation 
Process 
Performance 
(Execution 
Time) 

Bit Operations 5ns to 
Integer Operations  
(except for division) 9ns to 

Integer Operations (division) 97ns to 
Real Number Operations 
(except for division) 66ns to 

Real Number Operations 
(division) 87ns to 

Data Transfer (Integers) 5ns to 

Data Transfer (Real numbers) 5ns to 
Calculation 
Process 
Performance 
(PLC-MIX) 

Basic 15.905 

Practice 5.710 

Integrated 9.974 

Connection to CODESYS for XSEL2 

Ethernet, USB 
* CODESYS for XSEL2 not available to connect other 

tools (PC software and teaching pendants) at the 
same time when using USB 

Number of Used Ethernet Ports 
1740:  CODESYS for XSEL2 Connection 
2222, 44818: EtherNet/IP scanner 
4840:  OPC-UA server 
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Item Specification 

Number of Input and Output Points to SEL Part Input 1024 points / Output 1024 points (Fixed) 

EtherNet/IP 

Number of Connected Adapters 16 

Communication Cycles (RPI) 10ms to  

Status LED ML, NL 

Address Conflict (ACD) Not Supported 

OPC UA 
Information Model PLC open Information Model for IEC 61131-3 

Connectable Client Count 2 

Switches / 
Display 

Panel window 
Seven-Segment LED 
(PLC RUN, PLC ERR. Alphanumeric characters do 
not show PLC status.) 

Switches between AUTO/MANU 
mode 

AUTO/MANU (Refer to [4.10 Operation / Stop / Reset] 
for operation) 

Clock Feature Retention time: Approx. 10 days, Charging time: 
Approx. 100 hours 

External Memory None 

Startup Time Approx. 20 seconds to 1 minutes 

Instantaneous Power Failure 20ms (When power supply frequency 50Hz used) 
17ms (When power supply frequency 60Hz used) 

Diagnosis Feature Memory error, watchdog timer error, etc. 
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2.2 Installation and Storage/preservation environment 

 
Usage is possible in environments of pollution degree 2 (*1) or equivalent. 
*1 Pollution degree 2: Environment in which generally only nonconductive pollution occurs, but 

temporary conductive pollution may occur due to condensation. (IEC60664-1) 
 

2.2.1 Installation environment 
 

Avoid the following locations for installation. 
• Where the ambient temperature exceeds the range of 0 to 55°C  
• Where the temperature changes rapidly and condensation occurs 
• Where the relative humidity exceeds the range of 5%RH to 85%RH 
• Where the unit is exposed to odorous or combustible gases 
• Where the unit is exposed to significant amounts of dust, salt or iron powder 
• Where the unit is subject to direct vibration or impact 
• Where the unit receives direct sunlight 
• Where the unit may come in contact with water, oil or chemical spray 
• Where vents are blocked (Refer to [XSEL2 Instruction manual (ME0478) 3.2 Installation and 

Mounting] 
• Where the altitude exceeds 1,000m 

 
If the unit is used in any of the following locations, provide sufficient shielding measures: 
• Where noise is generated due to static electricity, etc. 
• Where there are strong electrical or magnetic fields 
• Where mains or power lines pass nearby 

 
2.2.2 Storage/preservation environment 

 
The storage and preservation environment are as follows. 
• The storage/preservation environment is based on the installation environment. However, the 

ambient temperature should be -20 to 70°C and the relative humidity should be 85%RH or less. 
Especially when storing for a long time, please take sufficient care to prevent condensation from 
forming. 
Unless especially specified, desiccant is not included in the package at shipping. If the product is 
to be stored/preserved in an environment where condensation is anticipated, take condensation 
preventive measures for the package overall from the exterior, or directly after opening the 
package. 
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2.3 Components 

 
2.3.1 Components (excluding options) 
 
This product should consist of the following components for the standard structure. 
If you find any fault in the contained model or any missing parts, contact us or our distributor. 
 

No. Part name  Model / Remarks Quantity 

1 Controller body  Refer to [How to read the model nameplate, 
How to Read the Model Number] 

 

Accessories 

2 System I/O Connector 

 

DFMC1.5/12-ST-3.5 
(Manufacturer: Phoenix Contact) 
* A jumper cable should be equipped on 

delivery. 
(For details, refer to [XSEL2 Instruction 
manual (ME0478) 3.5.2]) 

1 

3 

Motor Power Connector 
●Single-Phase 200V Type 
●3-Phase Type 200V Type 

 

BVF 7.62HP/04/180MF2 SN BK BX LRP 
(Manufacturer: Japan Weidmüller) 
* The print on the connector should differ for 

the single-phase 200V specification and 
three-phase 200V specification. 

1 

Motor Power Connector 
●Single-Phase 100V Type 

 

MPS 7S/03 S F 2 TN B B D 
(Manufacturer: Japan Weidmüller) 

4 Control power connector 

  

BVF 7.62HP/03/180MF2 SN BK BX LRP 
(Manufacturer: Japan Weidmüller) 

1 

5 Brake power supply input 
connector 

 

FMC1.5/2-ST-3.5-RF 
(Manufacturer: Phoenix Contact) 

1 

6 Dummy plug 

 

DP-4S 
(For Teaching Connector) 

1 

7 Dummy plug 
 

DP-6 
(For Driver Stop Connector) 

1 

8 Brake release switch 
connection connector 

 

1-1827862-5 
(Manufacturer: TE) 

1 
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1 Controller body  Refer to [How to read the model nameplate, 
How to Read the Model Number] 

 

Accessories 

2 System I/O Connector 

 

DFMC1.5/12-ST-3.5 
(Manufacturer: Phoenix Contact) 
* A jumper cable should be equipped on 

delivery. 
(For details, refer to [XSEL2 Instruction 
manual (ME0478) 3.5.2]) 

1 

3 

Motor Power Connector 
●Single-Phase 200V Type 
●3-Phase Type 200V Type 

 

BVF 7.62HP/04/180MF2 SN BK BX LRP 
(Manufacturer: Japan Weidmüller) 
* The print on the connector should differ for 

the single-phase 200V specification and 
three-phase 200V specification. 

1 

Motor Power Connector 
●Single-Phase 100V Type 

 

MPS 7S/03 S F 2 TN B B D 
(Manufacturer: Japan Weidmüller) 

4 Control power connector 

  

BVF 7.62HP/03/180MF2 SN BK BX LRP 
(Manufacturer: Japan Weidmüller) 

1 

5 Brake power supply input 
connector 

 

FMC1.5/2-ST-3.5-RF 
(Manufacturer: Phoenix Contact) 

1 

6 Dummy plug 

 

DP-4S 
(For Teaching Connector) 

1 

7 Dummy plug 
 

DP-6 
(For Driver Stop Connector) 

1 

8 Brake release switch 
connection connector 

 

1-1827862-5 
(Manufacturer: TE) 

1 
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No. Part name  Model / Remarks Quantity 

9 Absolute battery box *1 

 

UT-XSEL2-ABB 
Battery Model Code: AB-5 
Absolute battery box connection cable 
(Model: CB-XSEL2-AB002) is included. 

1 

10 Pulse train control 
connector 

 

DMFC 0,5/5-ST-2,54 
(Manufacturer: Phoenix Contact) 
* Enclosed when PIN (pulse train input + PIO 

input and output (4/4)) specification for I/O 
slot is selected 

1 

11 Pulse train control 
connector 

 

DFMC 0,5/10-ST-2,54 
(Manufacturer: Phoenix Contact) 
* Enclosed when PIN (pulse train input + PIO 

input and output (4/4)) specification for I/O 
slot is selected 

1 

12 
ELECYLINDER Connection 
Board 24V Power Supply 
Input Connector  

B2CF 3.50/06/180 SN OR BX 
(Manufacturer: Japan Weidmüller) 
* Enclosed when EL (ELECYLINDER 

connection) specification for I/O slot is 
selected 

1 

13 Connector for CC-Link 

 

MSTB2,5/5-STF-5,08 AU 
(Manufacturer: Phoenix Contact) 
* There should be terminal registers 110Ω 

and 130Ω enclosed. 
* Enclosed only in CC-Link specifications 

1 

14 Connector for DeviceNet 
 

MSTB2,5/5-STF-5,08 AU M 
(Manufacturer: Phoenix Contact) 
* There should be no terminal registers 

enclosed. 
* Enclosed only in DeviceNet specifications 

1 

15 IA Net Terminal Resister 
 

EIOU-TR 
* Enclosed only in IA net connection 

specifications 
2 

16 First Step Guide  ME0481 1 

17 Safety Guide  M0194 1 
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3.1 Wiring for USB port 

 
Connect a PC to the USB port (mini-B), and CODESYS for XSEL2 and PC teaching software can 
be used. 
When operating an actuator, insert a dummy plug (DP-4S) to the teaching connector. 
A USB cable should be prepared by the user. 

 
 Example of Wiring Between USB Port on XSEL2 and PC 

 
 

 
Caution 
● CODESYS for XSEL2 and the PC software for XSEL cannot be connected with USB at 

the same time and use. In case to use them at once, use different communication ports 
for connection. 

● When CODESYS for XSEL2 is set to connect with USB, CODESYS for XSEL2 should 
occupy the USB port and the PC software for XSEL may not be able to connect. When 
trying to connect the PC software for XSEL with USB and Error No. 780 “Port Open 
Error” occurs, right-click “CODESYS Gateway SysTray” in the task bar and click “Stop 
Gateway”.  
(For how to operate, refer to [4.2.1 Operating environment]). 
 

 
  

Dummy plug 
DP-4S 

PC 

XSEL2 
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 Specifications of USB Connector 

 
Connector to be Used USB mini-B 51387-0530 (Molex) 

Connector name USB  

Communication 
Specification Conformed to USB 2.0 12Mbps (Full Speed) /480Mbps (High Speed) 

Maximum connection 
distance 5m  

Connected unit PC (USB port)  

Recommended cable USB cable Controller side: mini-B 

Power Self-Power  

 
 Pin Assignment of USB Connector 

 
Pin No. Signal Name Signal content 

1 Vbus USB Power supply input (+5V) 

2 D- USB Differential transmitted/received data - side 

3 D+ USB Differential transmitted/received data + side 

4 ID USB ID (dentification) terminal (Open at cable end) 

5 GND Power supply ground 

 
 External view of USB Connector 

 
 

 
 

5 
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 Specifications of USB Connector 

 
Connector to be Used USB mini-B 51387-0530 (Molex) 
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Specification Conformed to USB 2.0 12Mbps (Full Speed) /480Mbps (High Speed) 

Maximum connection 
distance 5m  

Connected unit PC (USB port)  

Recommended cable USB cable Controller side: mini-B 

Power Self-Power  

 
 Pin Assignment of USB Connector 

 
Pin No. Signal Name Signal content 

1 Vbus USB Power supply input (+5V) 

2 D- USB Differential transmitted/received data - side 

3 D+ USB Differential transmitted/received data + side 

4 ID USB ID (dentification) terminal (Open at cable end) 

5 GND Power supply ground 

 
 External view of USB Connector 
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3.2 Wiring for Ethernet 

 
It should be used when using the EtherNet/IP scanner features, OPC UA server features and 
Ethernet connection in CODESYS for XSEL2. The PC software is also available for use. 
When operating an actuator, insert a dummy plug (DP-4S) to the teaching connector. 

 
 Example of Wiring Between Ethernet Port on XSEL2 and PC 

 
 

 Example for Ethernet Wiring 
 

 
Fig. 3.2-1 Example for EtherNet/IP Wiring   

Dummy plug 
DP-4S 

PC 

XSEL2 

Ethernet cable 

XSEL2 XSEL2 

Other slave devices 

Ethernet Cable (*1) 
Ethernet Cable (*1) 

Ethernet Cable (*1) 

Ethernet Cable (*1) 

PLC 
(EtherNet/IP Master unit) 

Hub (*2) 
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* There is no need of terminal process for connection to Ethernet. 
*1 Ethernet Cable: Straight Cable in Category 5e or higher with 100m or less 

(Double shielded cable braided with aluminum tape recommended) 
Also, the cable should be prepared by the user. 

*2 For the network configuration, use a switching hub, and do not use a repeater hub. Using a 
repeater hub may make the tag data link operate unstable. 
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* There is no need of terminal process for connection to Ethernet. 
*1 Ethernet Cable: Straight Cable in Category 5e or higher with 100m or less 

(Double shielded cable braided with aluminum tape recommended) 
Also, the cable should be prepared by the user. 

*2 For the network configuration, use a switching hub, and do not use a repeater hub. Using a 
repeater hub may make the tag data link operate unstable. 
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3.3 Wiring for teaching tool 

 
 
3.3.1 Wiring for Teaching port 
 
The teaching connector is for operation and setting of equipment by connecting a teaching pendant 
provided by IAI or a PC (PC software). 
An actuator would not activate without anything inserted to this connector. 
In order to activate an actuator without a teaching tool connected, connect a dummy plug (DP-4S). 
When the mode switch is to be set to AUTO, connect the enclosed dummy plug to the teaching 
connector. 

 
 How to Wire Teaching Tool 

 
 

 
 

Caution 
● This connector cannot be used for a purpose of communication with PLC features. 

To use the PLC features, use the USB connection or Ethernet connection. 
 

 
 

  

PC connection cable 
(Enclosed to PC software) 

Dummy plug 
DP-4S Teaching pendant 

PC 

XSEL2 
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 Cable Enclosed to PC Software, Conversion Unit Specification 

 
1) PC Connection Cable 5m + Emergency Stop Box 

Model: CB-ST-E1MW050-EB (Model Code for Cable Only: CB-ST-E1MW050) 
* Supplied with A-101-X-MW, IA-101-X-MW-JS, IA-101-X-USBMW 

 
 
2) PC Connection Cable 5m Complied with Safety Category 4 + Emergency Stop Box 

Model: CB-ST-A2MW050-EB (Model Code for Cable Only: CB-ST-A2MW050) 

  

5,000 

Emergency stop 
Box 

PC side 
Teaching Pendant 
Relay box side 

(Shield) 

Emergency stop box 
Red 1 

Black 2 

D-Sub 9-pin socket 

Cable color No. 

Connector Hood FG 
Brown 2 

Brown/Black 3 
Orange 

5 
Orange/Black 

(Short circuit) 
4 
6 

(Short circuit) 
7 
8 

非常停止ボックス 

信
号
名 

線色 No. 

D-Sub 9-pin socket 

No. Cable color 
Connector Hood FG 

2 Brown 
3 Brown/Black 

7 
Orange 

Orange/Black 
4 

(Short circuit) 
5 
6 

(Short circuit) 
20 
18 

(Short circuit) 
19 
13 Red 
12 Red/Black 
1 Shield FG 

[Wiring diagram] 

5,000 

Emergency stop 
Box 

PC side Teaching port side 
(Connector conversion cable 
side) 

(Shield) 

Emergency stop box 

Signal name Cable color No. 
EMG1 Orange 1 
EMG1 Glay 2 
EMG2 white 3 
EMG2 Yellow 4 

   

D-Sub 9-pin socket 

Signal name Cable color No. 
RXD Orange/Black Dot 2 
TXD Orange/Red Dot 3 

SG 
Gray/Black Dot 

5 
Gray/Red Dot 

DTR 
(Short circuit) 

4 
DSR 6 
RTS 

(Short circuit) 
7 

CTS 8 
Connector Hood FG 

D-Sub 25-pin socket 

No. Cable color Signal name 
2 Orange/Black Dot TXD 
3 Orange/Red Dot RXD 

7 
Gray/Black Dot 

SG 
Gray/Red Dot 

4 
(Short circuit) 

RTS 
5 CTS 
6 

(Short circuit) 
DSR 

20 DTR 
17 

(Short circuit) 
ENB1 

19 ENB1 
21 

(Short circuit) 
ENB2 

22 ENB2 
12 White/Black Dot EMG1 
13 White/Red Dot EMG1 
16 Yellow/Black Dot EMG2 
24 Yellow/Red Dot EMG2 
1 Shield FG 

Connector Hood FG 

* Supplied with IA-101-XA-USBMW-JS 

[Wiring diagram] 
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 Cable Enclosed to PC Software, Conversion Unit Specification 

 
1) PC Connection Cable 5m + Emergency Stop Box 

Model: CB-ST-E1MW050-EB (Model Code for Cable Only: CB-ST-E1MW050) 
* Supplied with A-101-X-MW, IA-101-X-MW-JS, IA-101-X-USBMW 

 
 
2) PC Connection Cable 5m Complied with Safety Category 4 + Emergency Stop Box 

Model: CB-ST-A2MW050-EB (Model Code for Cable Only: CB-ST-A2MW050) 

  

5,000 

Emergency stop 
Box 
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Teaching Pendant 
Relay box side 

(Shield) 

Emergency stop box 
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Cable color No. 

Connector Hood FG 
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5 
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(Short circuit) 
7 
8 

非常停止ボックス 

信
号
名 

線色 No. 

D-Sub 9-pin socket 

No. Cable color 
Connector Hood FG 

2 Brown 
3 Brown/Black 

7 
Orange 

Orange/Black 
4 

(Short circuit) 
5 
6 

(Short circuit) 
20 
18 

(Short circuit) 
19 
13 Red 
12 Red/Black 
1 Shield FG 

[Wiring diagram] 
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side) 
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Gray/Black Dot 
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Gray/Red Dot 

4 
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(Short circuit) 
ENB2 

22 ENB2 
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* Supplied with IA-101-XA-USBMW-JS 

[Wiring diagram] 

 
3.3 Wiring for teaching tool 

ME0479-1A 3-7 

 
3) USB conversion adapter 

Model: IA-CV-USB 
* Supplied with IA-101-XA-USBMW-JS 

 
 

4) Connector conversion cable 
Model: CB-SEL-SJS002 (Cable length 0.2m) 
* Supplied with IA-101-XA-USBMW-JS 

 
 
5) USB cable (3m) 

Model: CB-SEL-USB030 
* Supplied with IA-101-XA-USBMW-JS 

 
 
  

USB Cable side PC connection cable side 

65 25 

45
 

200 
PC connection cable side Controller side 

3000 

USB conversion adaptor side PC side 
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4.1 PLC Feature Parameter Setting 

 
The PLC feature is enabled on delivery. In order to make a change, it is necessary to connect a 
teaching tool. 
 
1) From the XSEL PC software, connect to XSEL2 and edit the PLC parameters from the tree on 

the left side of the window. 
 

 
 
2) In the Edit Parameter window, set PLC Parameter No. 1 “PLC Feature Setup”. 
 
 PLC Parameter 

 
No. Name Set Value Remarks 

1 PLC feature Setup 1 
0: Not in use 
1: Used 
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3) The following I/O parameters should be set up when using the EtherNet/IP scanner features, 

OPC UA server features and Ethernet connection in CODESYS for XSEL2. 
 I/O Parameter 
 

No. Name Set Value Remarks 

129 Network Attribute 10 10h TCP/IP message communication 
enabled 

172 
 to 175 Ethernet own IP address Adjust to network 

environment 
IP address of XSEL2 itself 
(Example: 192.168.0.100) 

176 
 to 179 Subnet Mask Adjust to network 

environment (Example: 255.255.255.0) 

180 
 to 183 Default gateway Adjust to network 

environment (Example: 0.0.0.0) 

 
Write the parameters in the flash ROM after the setup is completed, and reboot the power to the 
controller or reset the software. This is the end of the XSEL2 parameter setup. 

 
 
 



4. H
ow

 to use C
O

D
ESYS

 
4.1 PLC Feature Parameter Setting 

4-2 ME0479-1A 

 
3) The following I/O parameters should be set up when using the EtherNet/IP scanner features, 

OPC UA server features and Ethernet connection in CODESYS for XSEL2. 
 I/O Parameter 
 

No. Name Set Value Remarks 

129 Network Attribute 10 10h TCP/IP message communication 
enabled 

172 
 to 175 Ethernet own IP address Adjust to network 

environment 
IP address of XSEL2 itself 
(Example: 192.168.0.100) 

176 
 to 179 Subnet Mask Adjust to network 

environment (Example: 255.255.255.0) 

180 
 to 183 Default gateway Adjust to network 

environment (Example: 0.0.0.0) 

 
Write the parameters in the flash ROM after the setup is completed, and reboot the power to the 
controller or reset the software. This is the end of the XSEL2 parameter setup. 
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4.2.1 Operating environment 
 
 

Item Content 

Operating system 
Windows10 (64bit) 
Windows11 (64bit) 

Computer body PC available for operation of applicable OS (Windows) 

CPU x64 based processor 2.5GHz or more recommended 

Main memory 8GB or more recommended 

Hard disk 12GB or more recommended 

Display WXGA (1366 × 768) or more 

Keyboard 
Keyboard suitable for PC available for operation of applicable 
OS (Windows) 

Pointing device Tools such as mouse and applicable drivers 

Communication Port USB or Ethernet Port 

Supported language Japanese / English / German / Chinese (Simplified characters) 
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4.2.2 How to Install 

 
[1] Installation procedure 

Double-click the installation execution file setup.exe and follow the procedures to install it. 
 

1) Double-click setup.exe to execute the installer. Once the User Account Control window appears, 
click  Yes . 

 

 
 

2) Once the User Account Control window appears, click  Yes . 
 

 
 

3) Click  Next  to continue the process. 
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4.2.2 How to Install 

 
[1] Installation procedure 

Double-click the installation execution file setup.exe and follow the procedures to install it. 
 

1) Double-click setup.exe to execute the installer. Once the User Account Control window appears, 
click  Yes . 

 

 
 

2) Once the User Account Control window appears, click  Yes . 
 

 
 

3) Click  Next  to continue the process. 
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4) A license agreement should be shown. Check the contents and select “I accept the terms in 

the license agreement” if there is no problem, and click  Next . 
 

 
 

5) As the very important information opens, check the contents and select "I have read the 
information" if there is no problem, and click  Next . 
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6) Indicate the destination for installation. 

When it is desired to install to a directory other than what is displayed in default,  
click  Change  to change the destination directory for installation. 
If the indication of the directory is finished, click  Next . 

 

 
 

7) When it is required to install all the programs, select “Complete” and click  Next . 
 

 
 
8) Click  Install  to start installation. 
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6) Indicate the destination for installation. 

When it is desired to install to a directory other than what is displayed in default,  
click  Change  to change the destination directory for installation. 
If the indication of the directory is finished, click  Next . 

 

 
 

7) When it is required to install all the programs, select “Complete” and click  Next . 
 

 
 
8) Click  Install  to start installation. 
 

 

 
4.2 Installing CODESYS for XSEL2 

ME0479-1A 4-7 

 

9) Installation should be executed. Installation may require several tens of minutes. 
 

 
 

10) Once the installation is finished, the following window should appear. Click  Finish  to close the 
dialog. 

 

 
 

 

This is the end of the installation process. 
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4.2.3 Starting the software 

 
1) After installing it, open the grogram tree from the Windows button, and execute “CODESYS for 

XSEL2 V*.*.*.*”. 
(V1.0.1.0 is selected in the example.) 

 

 
 

2) Confirm that CODESYS for XSEL2 has started up. 
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4.2.3 Starting the software 

 
1) After installing it, open the grogram tree from the Windows button, and execute “CODESYS for 

XSEL2 V*.*.*.*”. 
(V1.0.1.0 is selected in the example.) 

 

 
 

2) Confirm that CODESYS for XSEL2 has started up. 
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4.3 Creating New Project 

 
Shown below is how to create a project. 
 

1) Select “File” → “New Project…” from the menu at the top. 

 
 

2) The New Project window opens. Conduct the following operations. 
● Select “Standard Project” 
● Input “Project Name” 
● Select “Project to Save to” 
Click  after all the operations are done. 
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3) The selection window for the standard project opens. Select the development language. 
 

 
 

4) If a window like shown below comes up, the project has completed to be created. 
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3) The selection window for the standard project opens. Select the development language. 
 

 
 

4) If a window like shown below comes up, the project has completed to be created. 
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4.4 Adding I/O Device Configuration 

 
By adding a device object (hereinafter called as a device), exchange of data with various interfaces 
should become available. 
 

 
 
In this manual, mentions the following interfaces. 
● XSEL2_Interface (Refer to [Chapter 5 SEL Interface Features]) 
● EtherNet/IP (Refer to [6.1 EtherNet/IP Scanner Feature]) 

 
In this chapter, having XSEL2_Interface as an example, explains how to add a new device. 
By adding XSEL2_Interface in the device, the input and output ports in SEL part equipped in 
XSEL2 in standard can be shared. 
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4.4.1 Adding I/O Device 
 
Here, shows the process to add a device. 
 

1) Right-click “Device” → select “Add Device…” in the device view. 

 
 

2) A window to add a device opens. Click “Others” to expand the tree. 
 
 

3) After the tree is expanded, select “XSEL2_Interface” and click  Add Device . 
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4.4.1 Adding I/O Device 
 
Here, shows the process to add a device. 
 

1) Right-click “Device” → select “Add Device…” in the device view. 

 
 

2) A window to add a device opens. Click “Others” to expand the tree. 
 
 

3) After the tree is expanded, select “XSEL2_Interface” and click  Add Device . 
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4) Confirm that “XSEL2_Interface (XSEL2 Interface)”, a device newly displayed in the device tree, 

is displayed, and it is completed to add a device. 
 

 
 
 
 

  



4.
 H

ow
 to

 u
se

 C
O

D
ES

YS
 
4.4 Adding I/O Device Configuration 

4-14 ME0479-1A 

 
4.4.2 Defining I/O Variables 
 
In order to perform I/O operation in CODESYS, it is necessary to define the variables for the input 
and output channels in an I/O device. Set up the names of variables in the I/O mapping or 
parameters. 
 

1) Double-click “XSEL2_Interface (XSEL2 Interface)” in the device tree, and the contents of the 
device should be displayed in a window. Select the “Internal I/O Mapping” tab here, and the 
details of shared port can be confirmed. 

 
 

2) The variables in the input and output channels should be declared in advance in the variable 
declaration window. 

 
* Double-click PLC (PRG) for the variable declaration. It should be displayed in the window same 

as the selected program (default setting). The variable declaration can be edited either in 
“Character String” or “Display Table”. 

  

Example） 
Have a variable that you would like to 
link to %IX1.1 defined in advance 
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4.4.2 Defining I/O Variables 
 
In order to perform I/O operation in CODESYS, it is necessary to define the variables for the input 
and output channels in an I/O device. Set up the names of variables in the I/O mapping or 
parameters. 
 

1) Double-click “XSEL2_Interface (XSEL2 Interface)” in the device tree, and the contents of the 
device should be displayed in a window. Select the “Internal I/O Mapping” tab here, and the 
details of shared port can be confirmed. 

 
 

2) The variables in the input and output channels should be declared in advance in the variable 
declaration window. 

 
* Double-click PLC (PRG) for the variable declaration. It should be displayed in the window same 

as the selected program (default setting). The variable declaration can be edited either in 
“Character String” or “Display Table”. 

  

Example） 
Have a variable that you would like to 
link to %IX1.1 defined in advance 
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3) Click “...” In the variable line that needs to be changed (in here %X1.1). 

 
 

4) As the input assistance window opens, open the “Application” tree and select the applicable 
variable. 

 
 

5) Once the selection of variables is completed, the display should be updated as shown below. 
Confirm the contents and the setup is finished. 

 
 

 
Caution 
● Although there are two ways of usage in the external I/O, global variables that can be 

used in common in all POU and local variables effective only in each POU, it is 
recommended to defined as the global variables in normal use. Refer to the separate 
volume [PLC Feature Programming Manual (ME0480)] for how to make a variable 
declaration. 
 

  

Have a variable that you would 
like to link to %IX1.1 selected 
in advance. 

Make sure that the variable you set for %IX1.1 
is linked. 
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4.4.3 I/O Refresh 
 
Data sending and receiving should be conducted by reading at the beginning of tasks for external 
input data and writing at the end of tasks for external output data. Settings related to I/O refresh 
should be conducted in the “PLC Setup” tab in the Device Setup window (double-click Device in the 
tree or right-click and select “Edit Object”). Only the I/O used in the program should be updated, 
and the I/O not in use should not be updated. 
 

 
 
 Updating I/O During Stop 

If there is a checkmark, refresh (update) of I/O should be performed even if the PLC is stopped. 
 
● Output Operation During Stop 

 
Item Description 

Retain Current Value 
The current value (value just before stop) should be 
retained. When the refresh setting during stop is disabled, 
the output data should not be updated. 

Set All Outputs to Default The default values in the I/O mapping should be output. 

Execute Project 
Behavior of an output can be written in a program in a 
project. Input a name of a program to execute and it should 
be executed once when PLC is stopped. 

 
● Output Operation During Stop 

 
Item Description 

Disabled 
(Updated only when used in task) 

I/O variables should be updated only when they are used in 
a task. 

Enabled 1 
(Bus cycle task to be used when not 
in use for any task) 

When there are no I/O variables used in any other task, it 
should be updated in the bus cycle task. 
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4.4.3 I/O Refresh 
 
Data sending and receiving should be conducted by reading at the beginning of tasks for external 
input data and writing at the end of tasks for external output data. Settings related to I/O refresh 
should be conducted in the “PLC Setup” tab in the Device Setup window (double-click Device in the 
tree or right-click and select “Edit Object”). Only the I/O used in the program should be updated, 
and the I/O not in use should not be updated. 
 

 
 
 Updating I/O During Stop 

If there is a checkmark, refresh (update) of I/O should be performed even if the PLC is stopped. 
 
● Output Operation During Stop 

 
Item Description 

Retain Current Value 
The current value (value just before stop) should be 
retained. When the refresh setting during stop is disabled, 
the output data should not be updated. 

Set All Outputs to Default The default values in the I/O mapping should be output. 

Execute Project 
Behavior of an output can be written in a program in a 
project. Input a name of a program to execute and it should 
be executed once when PLC is stopped. 

 
● Output Operation During Stop 

 
Item Description 

Disabled 
(Updated only when used in task) 

I/O variables should be updated only when they are used in 
a task. 

Enabled 1 
(Bus cycle task to be used when not 
in use for any task) 

When there are no I/O variables used in any other task, it 
should be updated in the bus cycle task. 
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Caution 
● As an I/O not used in a program should not get updated, the status would not be 

monitored even if double-click on the I/O module shown in the I/O mapping table device 
tree in each I/O module or right-click and select Edit Object. 
The following setting should be established when it is necessary to monitor an I/O not in 
use. 

 
1) When it is required to set it up for the whole PLC, select “Enable 1 (Use Bus 

Cycle Task if No Task is Used)” in “Always Update Variables” in “PLC Setting” in 
the previous page. 

 
2) When it is required to set it up for individual I/O modules, set “Always Update 

Variables” in “PLC Setting” in the previous page to “Disable (Update Only When Task 
is Used), and set “Always Update Variables” at the right bottom of the mapping table 
in that I/O module that you would like to set to “Enable 1 (Use Bus Cycle Task if No 
Task is Used)”. 
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4.5 Programing 

 
4.5.1 Creating POU (Program Organization Unit) Object 
 
POU (Program Organization Unit) is the basic unit organizing programs and projects in IEC 61131-
3. There should be only one programing language that can be used in one POU. 
If it is required to use several POU or another programing language, right-click “Application” and 
select “Add Object” → “POU”. 

 

 
 
There are three types in the organizing factors of POU. 

 

Type Readout from 
Task 

Readout from 
Other POU 

Limitation in 
Input and Output 

Counts 

Retaining 
Internal 

Variables 

Program  POU name None  

Function Block × Instance None  

Function × POU name Input: None 
Output: 1 × 

 
For the details of programing, refer to the separate volume [PLC Feature Programming Manual 
(ME0480)]. 
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4.5 Programing 
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3. There should be only one programing language that can be used in one POU. 
If it is required to use several POU or another programing language, right-click “Application” and 
select “Add Object” → “POU”. 

 

 
 
There are three types in the organizing factors of POU. 

 

Type Readout from 
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Readout from 
Other POU 

Limitation in 
Input and Output 

Counts 

Retaining 
Internal 

Variables 

Program  POU name None  

Function Block × Instance None  

Function × POU name Input: None 
Output: 1 × 

 
For the details of programing, refer to the separate volume [PLC Feature Programming Manual 
(ME0480)]. 
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4.5.2 Ladder Logic Diagram (LD Language) 
 

 
Here, explains the basis operations of CODESYS for XSEL2 in programing with LD Language. 
By selecting “Ladder Logic Diagram (LD)” in “Create A New Project” or when adding POU 
(program), a program in the ladder language can be created. 
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The window for LD Language should be divided as shown below. 
● Variable Definition Area 
● Program Main Area 
● Toolbox 

 
To construct a ladder program, select the necessary parts from the “Toolbox” area and add them to 
the program by drag & drop to the program main area. 

 
  

Variable Definition Area 

Program Main Area 
Toolbox 

a-contact 
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The window for LD Language should be divided as shown below. 
● Variable Definition Area 
● Program Main Area 
● Toolbox 

 
To construct a ladder program, select the necessary parts from the “Toolbox” area and add them to 
the program by drag & drop to the program main area. 

 
  

Variable Definition Area 

Program Main Area 
Toolbox 

a-contact 
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Also, when the variable of the added part is input, if the variable name is not registered in the 
“Variable Definition Area”, the automatic declaration window should open. Select  and it 
should be automatically registered to the “Variable Definition Area”. 

 
 

  

Define Variable Name 
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4.5.3 Structuring Text (ST Language) 
 
Here, explains the basis operations of CODESYS for XSEL2 in programing with ST Language. 
By selecting “Structuring Text (ST)” in “Create A New Project” or when adding POU (program), a 
program in ST Language can be created. 
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4.5.3 Structuring Text (ST Language) 
 
Here, explains the basis operations of CODESYS for XSEL2 in programing with ST Language. 
By selecting “Structuring Text (ST)” in “Create A New Project” or when adding POU (program), a 
program in ST Language can be created. 
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The window for ST Language should be divided as shown below. 
● Variable Definition Area 
● Program Main Area 

 

 
 
Write in a program in the “program main area” and write in the used variable in the “variable definition 
area”. 

 

Variable Definition Area 

Program Main Area 
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4.6 Task and program 

 
 
In order to execute a program, it is necessary to add the program (POU object) to a task. 

 
4.6.1 Adding Task 
 
1) Right-click  Task Configuration  in the device tree and select “Add object” → “Task”. 
 

 
 

2) The “Add Task” dialog box should be displayed. 
Input a task name and click . 

 

 
  

 

 

 

Input a task name. 
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4.6 Task and program 

 
 
In order to execute a program, it is necessary to add the program (POU object) to a task. 

 
4.6.1 Adding Task 
 
1) Right-click  Task Configuration  in the device tree and select “Add object” → “Task”. 
 

 
 

2) The “Add Task” dialog box should be displayed. 
Input a task name and click . 

 

 
  

 

 

 

Input a task name. 
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3) An object of the task should be added. 
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4.6.2 Task Configuration Setting 
 
In the task configuration window, setting related to task execution such as priority of execution, 
execution system, execution frequency, watchdog, etc. 
 

 
 

Item Description 

Priority Set range: 0 to 31 
The priority of 0 is highest and that of 31 is the lowest. 

Type 

Cyclic 

A task should be executed in a cycle of the time period set in “Frequency”. 
If the actual programing execution time period has exceeded the indicated 
frequency, the next program execution should start from the next indicated 
frequency cycle. 

Event It should be executed in the rising edge of the variable set in the event. 

Free Wheel 

The task executes the indicated POU, and once it is executed till the end, 
it goes back to the top of the first POU and repeats the execution. The 
frequency is not defined. As this task gets executed continuously, the 
priority is the lowest, and in addition, there is an interval of 3ms in one 
cycle so tasks in higher priority can be executed. 

Status It should be executed when the variable set in the event is true. 

Watchdog 

Once the watchdog is set enabled, as soon as the program execution time 
has exceeded the set time, the task goes to an error status and the 
operation stops. 
There are two conditions as stated below when it stops. 
 
・When the program execution time has executed the count set in the 

sensitivity or the time set in the time continuously 
・When the program execution time has executed Sensitivity × Time in 

one cycle 
(Example: When the sensitivity is “and time” is t#, it should stop if the 

execution time in one cycle has exceeded 15ms.) 
 
When a task has stopped by the watchdog, it should be recorded in the 
log tab of the device editor. 
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4.6.2 Task Configuration Setting 
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Free Wheel 

The task executes the indicated POU, and once it is executed till the end, 
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Status It should be executed when the variable set in the event is true. 

Watchdog 

Once the watchdog is set enabled, as soon as the program execution time 
has exceeded the set time, the task goes to an error status and the 
operation stops. 
There are two conditions as stated below when it stops. 
 
・When the program execution time has executed the count set in the 

sensitivity or the time set in the time continuously 
・When the program execution time has executed Sensitivity × Time in 
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(Example: When the sensitivity is “and time” is t#, it should stop if the 

execution time in one cycle has exceeded 15ms.) 
 
When a task has stopped by the watchdog, it should be recorded in the 
log tab of the device editor. 
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Caution 
● In order to avoid the XSEL2 system to stop when the calculated load in the CPU of 

XSEL2, monitoring of timeout should always be executed. Even when the watchdog 
option is not activated in the task configuration window, it may stop with an exception 
error as the CPU calculated load gets increased. 
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4.6.3 Adding Program to Task 
 
Adding POU (PRG) to MainTask as an example, here shows the procedures. 
 

1) Double-click  MainTask  in the Device tree. 

 
 

2) The configuration window of MainTask should open. 
 

 
 

3) Click . 
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4.6.3 Adding Program to Task 
 
Adding POU (PRG) to MainTask as an example, here shows the procedures. 
 

1) Double-click  MainTask  in the Device tree. 

 
 

2) The configuration window of MainTask should open. 
 

 
 

3) Click . 
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4) The “Input Assistant” dialog box should be displayed. 

Select a POU object (POU) of a program to be added in the task, and click . 

 
 

5) The POU object of the program should be added in the task. 

 
 

  

 

 

Select POU object 
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4.6.4 Oders to Execute POU 
 
POU registered in a task should be executed in the order of being registered. 
If there are three units of POU registered in Task01 as shown in the figure below, startup “Task01” 
and the POU should be executed in the order of “POU_1” → “POU_2” → “POU_3”. 

 
 

The order to execute POU change swapped with “Move Up” and “Move Down” buttons in the POU 
registration part in the task setup window. 
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4.6.4 Oders to Execute POU 
 
POU registered in a task should be executed in the order of being registered. 
If there are three units of POU registered in Task01 as shown in the figure below, startup “Task01” 
and the POU should be executed in the order of “POU_1” → “POU_2” → “POU_3”. 

 
 

The order to execute POU change swapped with “Move Up” and “Move Down” buttons in the POU 
registration part in the task setup window. 
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4.6.5 Precautions 

 
 When creating a program using several tasks with different priorities, it is necessary to design 

the time schedule. 
 
 As a task with higher priority should be executed when the startup frequency is in the same 

timing, a task with lower priority may have dispersion in executed frequency. Also, when a 
design is made to have long time to execute a task with higher priority, it may disable to secure 
time for operation of a task with lower priority. 

 
 When the watchdog feature of a task with low priority is activated, be cautious that the 

execution of a program should stop as the CPU detects a watchdog error. 
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4.7 Building Program 

 
 
1）For a build, select “Build” → “Generate Code” in the menu. 

 
 

2) The result of a build should get displayed in a message window. 
If there is an error being occurred, double-click an error message and it leads to a point that 
needs correction. Make a correction there. 
Remove all errors and a build should complete. 

 
 

 
Caution 
● If there is any unknown error message displayed, execute “Build”, “Clear All” and 

execute “Creating Code” again. 
 Execute “Clear All” and old data already compiled should be all deleted. 
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4.7 Building Program 
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2) The result of a build should get displayed in a message window. 
If there is an error being occurred, double-click an error message and it leads to a point that 
needs correction. Make a correction there. 
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4.8 Downloading program 

 
To download and execute a program, it is necessary to connect CODESYS for XSEL2 and XSEL2 
and activate them. 

 
Caution 
● When having a change to a program during operation, pay attention well to safety before 

conducting. 
It may cause damage to the machinery or accident by operation mistake. 
 

 
4.8.1 Preparation for USB Connection 

 
When CODESYS for XSEL2 and XSEL2 are to be connected with USB, follow the procedures 
below in this chapter. 
 

1) Connect a PC and an XSEL2 controller with a USB cable. 
 

 
Caution 
● When connection is established with USB, do not attempt to connect between a PC and 

XSEL2 with an Ethernet cable. As Ethernet should be prioritized to USB, USB 
connection may not be established. 
 

 
2) Double-click “Device” and open the pulldown menu in “Gateway”. 

Next, click “Configure the Local Gateway…”. 
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3) Once the gateway configuration window opens, select  in the left, and select “Add 

Interface” in the open tree. 

 
4) Add “COM Port” in the interface. 

 
5) Change the setting in the COM port. 

Name: Change it to an easy name (optional) 
Port: Input a COM port number that the USB is assigned (COM6 in this example) 
Baud rate: It is not necessary to change the value from the default. Regardless of the setting 

value, the baud rate should be constant. 

 
 

 
Caution 
● In order to reflect the setting in the COM port, it is necessary to reboot the gateway. 

Reboot the gateway on the next page [Complement How to Check COM Port Number 
after Procedure 6)]. 
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3) Once the gateway configuration window opens, select  in the left, and select “Add 

Interface” in the open tree. 

 
4) Add “COM Port” in the interface. 

 
5) Change the setting in the COM port. 

Name: Change it to an easy name (optional) 
Port: Input a COM port number that the USB is assigned (COM6 in this example) 
Baud rate: It is not necessary to change the value from the default. Regardless of the setting 

value, the baud rate should be constant. 

 
 

 
Caution 
● In order to reflect the setting in the COM port, it is necessary to reboot the gateway. 

Reboot the gateway on the next page [Complement How to Check COM Port Number 
after Procedure 6)]. 
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Complement  How to Check COM Port Number 

1) Connect PC and XSEL2 with a USB cable, and turn the power to XSEL2 on. 
2) Right-click the Start button of Windows and click  Device Manager . 

 
3) Double-click [Port (COM and LPT)] in the Device Manager window. 

 
The COM port number at the (COM**) part should differ depending on the condition 
of use of a PC. 
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6) Reboot the gateway. 

Click the CODESYS icon  at the right bottom of the window, and select “Stop Gateway”.  

 
 

7) Confirm the red color in the icon gets turned off, click the CODESYS icon in the same way and 
select “Start Gateway”. 

 
 

8) Confirm that the CODESYS icon has turned into red again, and the reboot has completed. 

 
 

  

 

 

 

Confirm the icon color 
is grayed out 

Confirm that the icon 
color has turned back 
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6) Reboot the gateway. 

Click the CODESYS icon  at the right bottom of the window, and select “Stop Gateway”.  

 
 

7) Confirm the red color in the icon gets turned off, click the CODESYS icon in the same way and 
select “Start Gateway”. 

 
 

8) Confirm that the CODESYS icon has turned into red again, and the reboot has completed. 

 
 

  

 

 

 

Confirm the icon color 
is grayed out 

Confirm that the icon 
color has turned back 
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4.8.2 Setup for Connection to XSEL2 

 
1) Link a PC and a controller with a USB cable or Ethernet cable. 

 
 

Caution 
● Set a cable only to the communication port that will actually be used. 

When there are a USB and Ethernet cables are wired at the same time, as USB should 
be prioritized, Ethernet connection should not be established. 
 

 
 

2) Double-click “Device” and click  Scan Network . 

 
 

3) As the Select Device window opens, XSEL2 in the network should automatically be scanned. 
Once the detected device got displayed, select it with double-click to complete the setting. 
Confirm the setting in Procedure 7). 

 
  

 

 

Double-click it to 
complete setting. 
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4) If the device is not detected, remove the checkbox at “Hide non matching devices, filter by 

Target ID”. Scanning automatically begins again. 
(If required to scan again actively, select “Scan Network” on the top right) 

 
 

5) Double-click the detected device. 

 
6) When a window to confirm the update of the device, select . 

 
  

 

 

Double-click it to 
complete setting 
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4) If the device is not detected, remove the checkbox at “Hide non matching devices, filter by 

Target ID”. Scanning automatically begins again. 
(If required to scan again actively, select “Scan Network” on the top right) 

 
 

5) Double-click the detected device. 

 
6) When a window to confirm the update of the device, select . 

 
  

 

 

Double-click it to 
complete setting 
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7) Once the selected device is shown in the window, build and transference of the source gets 

available. 
 

  
8) If it is the connection for the first time, a confirmation window for administration should appear. 

(It should not show up once the administration (adding device user) setup is completed.) 
Select “Yes”. 

 

  
The “Register Device User” dialog box should open. 
“Administrator” for the administrator privilege should be requested as the default group.  
Set up the username and password for an administrator. 
Refer to [7.2.1 Device User Feature] for the user groups. 

 

  

 



4.
 H

ow
 to

 u
se

 C
O

D
ES

YS
 
4.8 Downloading program 

4-40 ME0479-1A 

 
 

Caution 
● If you forget the username and password, you will not be able to log in. 

Be careful not to forget. 
 

 
As the login window should open, input the username and password that you have just set to log in. 

 
For how to register / change / delete a user, refer to [7.2.1 Device User Feature]. 
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Caution 
● If you forget the username and password, you will not be able to log in. 

Be careful not to forget. 
 

 
As the login window should open, input the username and password that you have just set to log in. 

 
For how to register / change / delete a user, refer to [7.2.1 Device User Feature]. 
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4.8.3 Login / Logout 

 
[1] Login 

When writing in a program to XSEL2 after the build is established, it is necessary to log in. 
To log in, select the “Login” or go to “Login” from the “Online” menu. 

 
If the application (program) is not found, the following message should be displayed. 
Click  and the download should start. 

 
If there is an unknown application in the PLC, the following message should be displayed. 
Click  and the download should start. 
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Log in, and it should show “Connect Complete” in the “Device” box in the device tree. 

 
 
Online Change: 
The online change is a feature to change a program without stopping operation while the PLC is 
operating. The online change downloads only program parts that were changed. 
 
How to Make Online Change 
When it is necessary to change a PLC program in operation, it is required to log out before 
changing the program. 
Select “Online” → “Login” after that. 

 
 
As the following dialog will be shown, select “Login after Online Change”. 
The detail of operation for each option is as described below. 
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Log in, and it should show “Connect Complete” in the “Device” box in the device tree. 

 
 
Online Change: 
The online change is a feature to change a program without stopping operation while the PLC is 
operating. The online change downloads only program parts that were changed. 
 
How to Make Online Change 
When it is necessary to change a PLC program in operation, it is required to log out before 
changing the program. 
Select “Online” → “Login” after that. 

 
 
As the following dialog will be shown, select “Login after Online Change”. 
The detail of operation for each option is as described below. 
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● Login after Online Change: Only differential programs should be transferred without stopping 

other programs. 
● Download and Login: All programs should be transferred. All the programs should be 

compulsorily stopped. 
● Login without Change: Only login should be conducted without transferring the changed 

programs. 
 

 
 

Caution 
● The online change should change programs in execution and reboot. Some systems 

may make error to operation of devices, which could cause damage or accident. Have 
enough validation to ensure that a new program operates in normal condition in the 
applicable system. 

● The pointer variables when the online change is conducted, the last value in a cycle 
should be retained. When the pointer points at a variable that the size has been 
changed as a result of the online change, it gets unavailable to refer to the correct value. 
Confirm that the pointers are reallocated in each cycle. 
 

 
[2] Logout 

Click the icon or select “Online” → “Logout”. 
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4.8.4 Creating Boot Application 

 
It should not be written in as a boot application in the default setting when logging in after a build. 
Therefore, once the power gets turned off, the transferred application should be erased. 
In order to make the application launched even after the power gets turned on again, it is necessary 
whether to update the boot application at the same time as download at login or to write in the boot 
application by executing “Generate Boot Application” from the “Online” menu. 
 
 Option Setting at Download 
● Select “Login with download” 
● Put a checkmark at “Update boot application”. 
 

 
 
 Execute “Create Boot Application” from the “Online” menu. 

 
 

 
Caution 
● The downloaded application requires to have a few tens of seconds or a few minutes to 

write into the flash ROM. While in process, do not attempt to “reset”, “reboot” or “turn the 
power OFF”. 
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4.8.4 Creating Boot Application 

 
It should not be written in as a boot application in the default setting when logging in after a build. 
Therefore, once the power gets turned off, the transferred application should be erased. 
In order to make the application launched even after the power gets turned on again, it is necessary 
whether to update the boot application at the same time as download at login or to write in the boot 
application by executing “Generate Boot Application” from the “Online” menu. 
 
 Option Setting at Download 
● Select “Login with download” 
● Put a checkmark at “Update boot application”. 
 

 
 
 Execute “Create Boot Application” from the “Online” menu. 

 
 

 
Caution 
● The downloaded application requires to have a few tens of seconds or a few minutes to 

write into the flash ROM. While in process, do not attempt to “reset”, “reboot” or “turn the 
power OFF”. 
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4.8.5 Precautions 

 
In CODESYS for XSEL2, there are status of “logged in” and “logged out” which are switched over 
during development. 
 
 Status Logged Out 

It is the status that CODESYS for XSEL2 is launched. 
Change in codings and settings can be made. 

 Status Logged In 
Operation and debugging in a program can be made. 
Also, when the status is logged in, operation and stop in a program can be switched over. 

 
Work Status Logged In Status Logged Out 

Program Change available unavailable 

Setting Change available unavailable 
Switchover between Operation/Stop in 
Program unavailable available 

Break Point and Step Movement unavailable available 

Watch Feature unavailable available 

Connection to XSEL2 Unnecessary Unnecessary 

 

 

Execution program 
Debug 

Operation 

Program Change 
Setting Change 

 

Stop 

Operation 
button 

Stop 
button 

Status Logged Out Status Logged In 

(Build)  
Login button 

Logout button 
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4.9 Downloading / Uploading of Source 

 
The source file is a base file for an application file that PLC executes that includes all the data such 
as variable name, comment and program languages. 
 
To write a source file into PLC, go to “Online (O)” → “Source Download to Connected Device” or 
“File (F)” → “Source Download…”. 
To read a source file out from PLC, to to “File (F)” → “Source Upload…”. 
 
 Writing to PLC 

 
 Readout from PLC 

 
 

 
Point ! When there is no CODESYS project file which a user program was created with, it is 

recommended to safe it to PLC as the user program program cannot make any 
change without a source file. 
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4.9 Downloading / Uploading of Source 

 
The source file is a base file for an application file that PLC executes that includes all the data such 
as variable name, comment and program languages. 
 
To write a source file into PLC, go to “Online (O)” → “Source Download to Connected Device” or 
“File (F)” → “Source Download…”. 
To read a source file out from PLC, to to “File (F)” → “Source Upload…”. 
 
 Writing to PLC 

 
 Readout from PLC 

 
 

 
Point ! When there is no CODESYS project file which a user program was created with, it is 

recommended to safe it to PLC as the user program program cannot make any 
change without a source file. 
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 Transfer Timing 

The timing to transfer the source file can be changed at “Project” in the menu from “Project 
Settings” → (Project window opens) → “Source Download”. 
It is set to “Transfer Only when Required” in the default setting. When it is required to change an 
application program and always to link, select “Create Boot Application, Download, Implicitly 
Transfer in Online Change”. 
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 Download Data File 

What data is to be included in the source file can be selected as required in “Project” → “Project 
Settings” → “Source Download” → . 

 
The “download data file” in the additional files is necessary when conducting online change 
without stopping PLC. When there is a source file including the download data in PLC, online 
change gets available by uploading the source. 
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 Download Data File 

What data is to be included in the source file can be selected as required in “Project” → “Project 
Settings” → “Source Download” → . 

 
The “download data file” in the additional files is necessary when conducting online change 
without stopping PLC. When there is a source file including the download data in PLC, online 
change gets available by uploading the source. 
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4.10 Operation / Stop / Reset 

 
 

4.10.1 Operation / Stop 
 

Operation / stop of a program should be conducted with “Start” / “Stop” in the CODESYS for XSEL2 
“Debug Menu” or AUTO/MANU switch on an XSEL2 Controller. 
The position of the switches and PLC status by user operation are as shown below. 
 

Switch Position 
User Operation MANU AUTO 

Power On or System Reboot Stop Operation 

Operation from CODESYS for XSEL2 Start Operation 

Stop from CODESYS for XSEL2 Operation Stop 

 
 Operation methods 

Click the icon or select the debug “Start”. 

 
 
 Stop methods 

Click the icon or select the debug “Stop”. 
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4.10.2 Single Cycle 

 
In order to check that the created program will be executed as expected, the application can be run 
for one cycle only. 
Press “Single Cycle” in “Debug Menu” in CODESYS for XSEL2, and the program should be 
executed for one cycle only. 
If there are several tasks, regardless of the task frequency, all the tasks should be executed for one 
cycle only. 
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4.10.2 Single Cycle 

 
In order to check that the created program will be executed as expected, the application can be run 
for one cycle only. 
Press “Single Cycle” in “Debug Menu” in CODESYS for XSEL2, and the program should be 
executed for one cycle only. 
If there are several tasks, regardless of the task frequency, all the tasks should be executed for one 
cycle only. 
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4.10.3 Reset 

 
When an “exception error” such as a watchdog error and division by zero is occurred, the program 
should stop. If CODESYS for XSEL2 is connected, the exception display should be shown at the 
bottom of the window. 
 
Have a reset operation to cancel the exception error. Make operation without the reset operation, 
and it will stop again. Select Reset Warm / Reset Cold / Reset Origin from the “Online” menu. 

 
There are “Reset Warm” and “Reset Cold” in the reset, and the details of initialization should differ. 
For initialization, refer to [4.10.4 Initialization]. 
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4.10.4 Initialization 

 
It is necessary to conduct the initializing operation to cancel an exception error and initialize the 
contents of the non-volatile memory. 
The impact to data by reset operation and user operation are shown in the table below. 
 

: Retention, ×: Initialization 

Data 
 

User operation 

Standard 
Variable 

(VER) 

Retaining 
Variable 

(VER 
RETAIN) 

Persistent 
Variable 

(VER 
PERSIS 
_TENT) 

Application 
（Volatile 
memory） 

Boot 
Application 

（Non-volatile 
memory） 

Stop      

Warm Reset ×     

Cold Reset × ×    

Reset (PLC initialization) × × × × × 

Download × ×  Update Update*1 

Online Change    Update Update*2 

System restart    ×  

*1 If Select Option is shown, it should follow that settings, and update will be done when it is not 
shown. 

*2 If Select Option is shown, it should follow that settings, and update will not be done when it is 
not shown. 
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4.10.4 Initialization 

 
It is necessary to conduct the initializing operation to cancel an exception error and initialize the 
contents of the non-volatile memory. 
The impact to data by reset operation and user operation are shown in the table below. 
 

: Retention, ×: Initialization 

Data 
 

User operation 

Standard 
Variable 

(VER) 

Retaining 
Variable 

(VER 
RETAIN) 

Persistent 
Variable 

(VER 
PERSIS 
_TENT) 

Application 
（Volatile 
memory） 

Boot 
Application 

（Non-volatile 
memory） 

Stop      

Warm Reset ×     

Cold Reset × ×    

Reset (PLC initialization) × × × × × 

Download × ×  Update Update*1 

Online Change    Update Update*2 

System restart    ×  

*1 If Select Option is shown, it should follow that settings, and update will be done when it is not 
shown. 

*2 If Select Option is shown, it should follow that settings, and update will not be done when it is 
not shown. 
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4.11 Debug 

 
 

4.11.1 Monitoring 
 

Log in, and the current values of the variables can be checked in the variable declaration part and 
in the program window. 
 
 Monitoring in Variable Declaration Part 

 
Variables can be written over as required. The procedures are as below. 

 
1) Click “Values Already Set” in the variable definition part, and make a change to the settings. 

If the variables are in such as BYTE Format, input a desired number directly. 

 
2) Right-click the setting after changed to show the menu tree, select “Write All Values of 

‘Device.Application’” and the changed values should be reflected to the variables. 
 

 
  

 

Current 
Values 

 

Click it and it changes  
FALSE → TRUE 
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3) The indicated variables should be overwritten. Confirm that it is reflected to the output. 

 
 
 In-Line Monitoring in Program Window 

 
The current value should be shown beside the variables. 
For the contact, coil and link line should be displayed in blue when the current value is “TRUE”. 
 
The in-line monitoring should get disabled. 
Show the option window in “Tool” → “Option” and remove the checkmark at “Enable In-Line 
Monitoring” from the “Monitoring” tab in the “Text Editor” category. 

 
  

It changes  
FALSE → TRUE 
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3) The indicated variables should be overwritten. Confirm that it is reflected to the output. 

 
 
 In-Line Monitoring in Program Window 

 
The current value should be shown beside the variables. 
For the contact, coil and link line should be displayed in blue when the current value is “TRUE”. 
 
The in-line monitoring should get disabled. 
Show the option window in “Tool” → “Option” and remove the checkmark at “Enable In-Line 
Monitoring” from the “Monitoring” tab in the “Text Editor” category. 

 
  

It changes  
FALSE → TRUE 
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4.11.2 Break Point 

 
By setting up a break point in a program, execution of the program can be paused. 
After the pause, the operation should be able to check one line by one by executing steps. 
 

[1] Break Point Setting 
In order to set up a break point, right-click at the applicable line in Online Mode and select 
“Toggle Breakpoint”. 

 
Example) When setting a break point to the 3rd line 
 

 
Start operation, and the operation should stop at the point where the break point was 
set. 

 

 
 

The following debugging operation are available to execute while in stop. 
 Step Over 
 Step In 
 Step Out 
 Execution up to cursor line 
 Set to next sentence 
 Show current sentence 

 

To delete a set break point, right-click again and select “Switch Break Point”.  
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A condition to stop operation at a break point can be set. Select “Debug” → “New Breakpoint” in 
the menu bar, and the “New Breakpoint” dialog box should open. 
Select the “Condition” tab, and input a condition to stop at a break point. 

 
In the break point view, the settings of break points can be checked in a list. A position of a break 
point, break condition and reached count can be checked. Adding, deleting, activating and 
deactivating of a break point is also available. 
To display the break point view, select “Menu bar Display” → “Breakpoints”. 
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A condition to stop operation at a break point can be set. Select “Debug” → “New Breakpoint” in 
the menu bar, and the “New Breakpoint” dialog box should open. 
Select the “Condition” tab, and input a condition to stop at a break point. 

 
In the break point view, the settings of break points can be checked in a list. A position of a break 
point, break condition and reached count can be checked. Adding, deleting, activating and 
deactivating of a break point is also available. 
To display the break point view, select “Menu bar Display” → “Breakpoints”. 
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Caution 
● If a break point is set in the following conditions, a PLC program should stop and 

connection to CODESYS for XSEL2 may get disabled. In order to recover the 
communication, reboot of XSEL2 should be required. 

 
[Conditions Tend to Occur] 
(1) When PLC programs are used in multi-tasks 

 

 
(Next page) 
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(2) When “Reached Count” and “Conditions” are indicated in the conditions at the same 

time 
 

 
 
(3) When “Break only when the breakpoint is hit in one of the following tasks” option is 

activated in the conditions 
 

 
 

(4) When a break point is set in another program during stop at a break point 
 
[Example of Countermeasure when Problem Occurred] 

Do not use the break point feature in CODESYS for XSEL2, add a contact (“BP” in the 
following example) used as a pseudo break point to a position that you would like to 
stop at a break point in a PLC program, and switch the contact for debugging from true 
(stop) to false (execute) from the watch window to conduct a debugging. 

 

 
 

  

Add a contact for debugging. 
Switch stop or execute in the 
watch window for variables. 
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(2) When “Reached Count” and “Conditions” are indicated in the conditions at the same 

time 
 

 
 
(3) When “Break only when the breakpoint is hit in one of the following tasks” option is 

activated in the conditions 
 

 
 

(4) When a break point is set in another program during stop at a break point 
 
[Example of Countermeasure when Problem Occurred] 

Do not use the break point feature in CODESYS for XSEL2, add a contact (“BP” in the 
following example) used as a pseudo break point to a position that you would like to 
stop at a break point in a PLC program, and switch the contact for debugging from true 
(stop) to false (execute) from the watch window to conduct a debugging. 

 

 
 

  

Add a contact for debugging. 
Switch stop or execute in the 
watch window for variables. 
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[2] Setting Execution Point 

Set an execution point, and the process indicated the point set as the execution point in advance 
should be executed and can be output to the device log. The application should not stop at the 
position set as the execution point. 

 

[Setting Procedures] 
1) Select a point that you would like to set the execution point, select “Debug” → “New 

Breakpoint” in the menu bar, and the "New Breakpoint" dialog box should open. 
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2) Click the “Execution Point Settings” tab, and the setting window for the execution point should 

open. 

 
3) Put a checkmark to “Execution Point” and input the “Executed Code” and “Message to Output 

to Log” in the execution point. 
In parallel, describe an execution code in the ST program in the “Execute the following code” 
box, and input a message to output to a log in the “Output a message to device log” box. 

 
4) Click  OK , and the execution point should be set. 
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2) Click the “Execution Point Settings” tab, and the setting window for the execution point should 

open. 

 
3) Put a checkmark to “Execution Point” and input the “Executed Code” and “Message to Output 

to Log” in the execution point. 
In parallel, describe an execution code in the ST program in the “Execute the following code” 
box, and input a message to output to a log in the “Output a message to device log” box. 

 
4) Click  OK , and the execution point should be set. 
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5) When it is output to a device log, it should get displayed in the device log window. 
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[3] Callout History View
In the callout history view, the stop position can be checked during a stop at a break point and so 
on. When the position is called out from another block, that point can also be checked.

 Select “Display” → “Call Stack” in the menu bar, and the callout history view can be displayed.

 Set a break point and stop the application.
The stop position and the POU calling out the POU at the stop position should be shown.
Example) When stopped at the 1st line of “ADD 100” function and the “POU” is calling out 

“ADD 100”.
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 Set a break point and stop the application.
The stop position and the POU calling out the POU at the stop position should be shown.
Example) When stopped at the 1st line of “ADD 100” function and the “POU” is calling out 

“ADD 100”.
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4.11.3 Executing Steps 

 
There are four types of the step execution feature. The step execution feature should come 
available after a break point is set in a user program and the program is paused. 
 
 Step Over 

The steps should be executed one by one, and if the current execution step is under a callout of 
POU, all the POU to call out should be executed and then it goes back to the next step to the one 
that called POU. 

 
 
 Step Into 

The steps should be executed one by one, and if the current execution step is under a callout of 
POU, it should go into the called POU. 
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 Step Out 

All the remaining programs should be executed and it goes back to the top program. If the 
current execution step is inside the called out POU, all the programs in that POU should be 
executed and then it goes back to the next step to the one that called POU. 

 
 
 Run to Cursor 

Programs up to one line before a position where a cursor is placed should be executed. 
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 Step Out 

All the remaining programs should be executed and it goes back to the top program. If the 
current execution step is inside the called out POU, all the programs in that POU should be 
executed and then it goes back to the next step to the one that called POU. 

 
 
 Run to Cursor 

Programs up to one line before a position where a cursor is placed should be executed. 
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4.12 Simulation 

 
In the simulation feature of CODESYS for XSEL2, a program can be transferred to the virtual 
controller inside a PC and be executed without an actual device of XSEL2. 
 
Select “Online” → “Simulation” and it goes to the simulation mode. After that, log in the same way 
as normal online operation and conduct operation / debug. To cancel the simulation mode, select 
“Simulation” again. 
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4.13 Tracing Feature 

 
Use the tracing feature, and the variables history of CODESYS in XSEL2 Controller can be 
checked in CODESYS for XSEL2. 
The timing to start tracing can be indicated in the option. The recorded data can be checked in a 
graph. 
Also, data acquired by the tracing feature can be stored in a PC. 
 
 

4.13.1 Setting up Tracing 
 

1) Right-click “Application” displayed in the device tree, and select “Add Object” → “Trace...”. 
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4.13 Tracing Feature 

 
Use the tracing feature, and the variables history of CODESYS in XSEL2 Controller can be 
checked in CODESYS for XSEL2. 
The timing to start tracing can be indicated in the option. The recorded data can be checked in a 
graph. 
Also, data acquired by the tracing feature can be stored in a PC. 
 
 

4.13.1 Setting up Tracing 
 

1) Right-click “Application” displayed in the device tree, and select “Add Object” → “Trace...”. 
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2) Set up the “tracing name”. Set up “Task for Trace Recording” as necessary. The execution 

frequency of a task set here will be the sampling frequency in tracing. 
Click  once setting is complete.  

 
 
Point ! If the load of tracing tasks is too high, it may impact the process in the user program. 

It is recommended to lower the priority of the tracing tasks. 
 

 
3) Click  Configuration  in the Trace window. 

 
  

 

Enter a trace name 
 

Set as necessary 
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4) Once the Trace Configuration window has shown up, set up tasks to trace in “Task”. Set up 

others as necessary. Once the setup is finished, click  Add Variable . 

 
 

Item Description 
Trigger 
Variables 

Input a variable to be used as a trigger. 
String Type, WString Type and Array Variables are no available as a trigger. 

Trigger Edge 

Select an edging condition for triggering. 
●  Positive: Rising edge for boolean variables 

For those other than boolean variables, when raised to trigger 
level value 

●  Negative: Falling edge for boolean variables 
For those other than boolean variables, when fell to trigger level 
value 

●  Both: For boolean variables, when a value changed 
For those other than boolean variables, when reached trigger 
level value 

Post Trigger 
(Sample) 

Input the record count for each trace variable put in buffer after triggering. 
Default: 50, Value Range：0 to (232 -1) 

Trigger level Input a value in trigger level. 

Task Select a task to trace. 
Record 
condition 

Input the record condition. 
Input it referring to the online help. 

Comments Input a comment. 

Precision 
Select a unit of the recorded time stamp. 
・ms : Millisecond 
・µs : Microsecond 

Automatic 
resume 

Select enable/disable of automatic resume. 
Put a checkmark on this and tracing should automatically start if triggering still 
continues even after a device gets rebooted. 
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4) Once the Trace Configuration window has shown up, set up tasks to trace in “Task”. Set up 

others as necessary. Once the setup is finished, click  Add Variable . 

 
 

Item Description 
Trigger 
Variables 

Input a variable to be used as a trigger. 
String Type, WString Type and Array Variables are no available as a trigger. 

Trigger Edge 

Select an edging condition for triggering. 
●  Positive: Rising edge for boolean variables 

For those other than boolean variables, when raised to trigger 
level value 

●  Negative: Falling edge for boolean variables 
For those other than boolean variables, when fell to trigger level 
value 

●  Both: For boolean variables, when a value changed 
For those other than boolean variables, when reached trigger 
level value 

Post Trigger 
(Sample) 

Input the record count for each trace variable put in buffer after triggering. 
Default: 50, Value Range：0 to (232 -1) 

Trigger level Input a value in trigger level. 

Task Select a task to trace. 
Record 
condition 

Input the record condition. 
Input it referring to the online help. 

Comments Input a comment. 

Precision 
Select a unit of the recorded time stamp. 
・ms : Millisecond 
・µs : Microsecond 

Automatic 
resume 

Select enable/disable of automatic resume. 
Put a checkmark on this and tracing should automatically start if triggering still 
continues even after a device gets rebooted. 
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5) Set up a variable to trace in “Variable” box. Set up others as necessary. In the same way, click  

 Add Variable  to set it up when a new variable is required to be added. 
Once the setup is finished, click . 

 

 
 

6) The variable subject to tracing should be added. 
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4.13.2 Executing and Stopping Tracing 

 
After login, click “Trace” → “Download Trace” in the menu to download the tracing data. 

 
 

The tracing data should be shown following the set contents. 
 

 
 

To stop tracing, click “Stop Trace” in the trace menu to stop it. 
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4.13.2 Executing and Stopping Tracing 

 
After login, click “Trace” → “Download Trace” in the menu to download the tracing data. 

 
 

The tracing data should be shown following the set contents. 
 

 
 

To stop tracing, click “Stop Trace” in the trace menu to stop it. 
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4.13.3 Tracing Result, Saving and Loading 

 
To save the result of tracing, select “Save Trace…” in the trace menu. 

 
 

To load the result of tracing, select “Load Trace…” in the trace menu. 

 
  

 

 



4.
 H

ow
 to

 u
se

 C
O

D
ES

YS
 
4.13 Tracing Feature 

4-72 ME0479-1A 

 
4.13.4 Showing Multiple Channels 

 
To trace multiple variables, there are the single channel display and multiple channel display 
available to select from. The figure below is the signal channel display. 
 

 
 

In order to show the multiple channel display, select “Trace” → “Move all variables to individual 
diagrams”. 

 
The multiple channels shows display as shown below. 
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4.13.4 Showing Multiple Channels 

 
To trace multiple variables, there are the single channel display and multiple channel display 
available to select from. The figure below is the signal channel display. 
 

 
 

In order to show the multiple channel display, select “Trace” → “Move all variables to individual 
diagrams”. 

 
The multiple channels shows display as shown below. 
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4.14 Watch 

 
By registering variables in the Watch window, the indicated variable values can be monitored in real 
time. 
 

1) From the top menu, select “Display” → “Watch” → “Watch 1”. 

 
 

2) The “Watch 1” tab should be added in the message window. 
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3) Select the blank “Format” box in the “Watch 1” tab and then select “...”, and the input assistant 

window should appear. 

 
 

4) From the Input Assistant window, open the tree and select a variable that you would like to 
monitor. 

 
Note  In the example of the window, “COUNTER” Variable is selected. 

  

Select a line and 
click "...". 
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3) Select the blank “Format” box in the “Watch 1” tab and then select “...”, and the input assistant 

window should appear. 

 
 

4) From the Input Assistant window, open the tree and select a variable that you would like to 
monitor. 

 
Note  In the example of the window, “COUNTER” Variable is selected. 

  

Select a line and 
click "...". 
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5) A variable subject to monitoring should be added in the “Watch 1” tab, and you will be able to 

know the details of the variables in the “Value” box in real time. 
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4.15 Write-in of Values 

 
When it is required to update the setting values in the I/O Mapping window, conduct it as shown 
below. 

 
Note Change is available even for the values not used in programs. 

 
1) Set up a value in “Prepared value”. 

 
 

2) Select either “Write Values” or “Force Values” from the debug menu. 
 

 
 

When “Compulsory of Values” is selected, overwriting should be compulsorily conducted at the start 
and finish of a program. 

 
 

Caution 
● Pay special attention to safety when conducting the compulsory of values and write-in of 

values. It may cause damage to the machinery or accident by operation mistake. 
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When it is required to update the setting values in the I/O Mapping window, conduct it as shown 
below. 

 
Note Change is available even for the values not used in programs. 

 
1) Set up a value in “Prepared value”. 

 
 

2) Select either “Write Values” or “Force Values” from the debug menu. 
 

 
 

When “Compulsory of Values” is selected, overwriting should be compulsorily conducted at the start 
and finish of a program. 

 
 

Caution 
● Pay special attention to safety when conducting the compulsory of values and write-in of 

values. It may cause damage to the machinery or accident by operation mistake. 
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5.1 Features overview 

 
The SEL interface feature is a function to perform the followings: 
● Data sending and receiving between PLC and SEL system 
● External input and output from PLC to I/O option equipped in XSEL2 

 
Between the software PLC and the SEL system, signals and data can be sent and received without 
external wiring connections. 
Also, as the XSEL2 equipped I/O options can be directly controlled from the software PLC, it can be 
used as the external input and output of PLC by adding some necessary option boards. 
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5.2 Specifications 

 
PLC and the SEL system have mirroring for: 
● Input memory 64 words in PLC and output port 2024 bits in SEL system 
● Output memory 64 words in PLC and input port 2024 bits in SEL system 

which enables sending and receiving of signals and data. 
 

 
 

  

Software PLC 
POU (Program, ,etc.) 

%IW n 

%IW n+63 

Software PLC 
Input memory 

Mirroring 

SEL Output Ports 

#5952 

#6975 

#4000 
#599 

#300 

XSEL2 System 
or  

SEL Program 

%QW n 

%QW n+63 

Software PLC 
Input memory 

Mirroring 

SEL Input Ports 

#2952 

#3975 

#1000 
#299 

#000 

Import Write 

Import Write 



5. SEL Interface Feature
 
5.2 Specifications 

5-2 ME0479-1A 
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5.2.1 Relation Between PLC Input Addresses and SEL Output Port Numbers 

 
The PLC input address n should be automatically assigned by CODESYS for XSEL2. 
As the assigned value should vary depending on the order for being added in an I/O device, it is 
recommended to have the I/O variable defined and perform PLC programming by using variables. 
 

[1] Word address 
The applicable output port numbers in SEL are shown below. 
 

 Bit No. 
Address b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0 

%IW n 5967 5966 5965 5964 5963 5962 5961 5960 5959 5958 5957 5956 5955 5954 5953 5952 
%IW n+1 5983 5982 5981 5980 5979 5978 5977 5976 5975 5974 5973 5972 5971 5970 5969 5968 
%IW n+2 5999 5998 5997 5996 5995 5994 5993 5992 5991 5990 5989 5988 5987 5986 5985 5984 
%IW n+3 6015 6014 6013 6012 6011 6010 6009 6008 6007 6006 6005 6004 6003 6002 6001 6000 
%IW n+4 6031 6030 6029 6028 6027 6026 6025 6024 6023 6022 6021 6020 6019 6018 6017 6016 
%IW n+5 6047 6046 6045 6044 6043 6042 6041 6040 6039 6038 6037 6036 6035 6034 6033 6032 
%IW n+6 6063 6062 6061 6060 6059 6058 6057 6056 6055 6054 6053 6052 6051 6050 6049 6048 
%IW n+7 6079 6078 6077 6076 6075 6074 6073 6072 6071 6070 6069 6068 6067 6066 6065 6064 
%IW n+8 6095 6094 6093 6092 6091 6090 6089 6088 6087 6086 6085 6084 6083 6082 6081 6080 
%IW n+9 6111 6110 6109 6108 6107 6106 6105 6104 6103 6102 6101 6100 6099 6098 6097 6096 
%IW n+10 6127 6126 6125 6124 6123 6122 6121 6120 6119 6118 6117 6116 6115 6114 6113 6112 
%IW n+11 6143 6142 6141 6140 6139 6138 6137 6136 6135 6134 6133 6132 6131 6130 6129 6128 
%IW n+12 6159 6158 6157 6156 6155 6154 6153 6152 6151 6150 6149 6148 6147 6146 6145 6144 
%IW n+13 6175 6174 6173 6172 6171 6170 6169 6168 6167 6166 6165 6164 6163 6162 6161 6160 
%IW n+14 6191 6190 6189 6188 6187 6186 6185 6184 6183 6182 6181 6180 6179 6178 6177 6176 
%IW n+15 6207 6206 6205 6204 6203 6202 6201 6200 6199 6198 6197 6196 6195 6194 6193 6192 
%IW n+16 6223 6222 6221 6220 6219 6218 6217 6216 6215 6214 6213 6212 6211 6210 6209 6208 
%IW n+17 6239 6238 6237 6236 6235 6234 6233 6232 6231 6230 6229 6228 6227 6226 6225 6224 
%IW n+18 6255 6254 6253 6252 6251 6250 6249 6248 6247 6246 6245 6244 6243 6242 6241 6240 
%IW n+19 6271 6270 6269 6268 6267 6266 6265 6264 6263 6262 6261 6260 6259 6258 6257 6256 
%IW n+20 6287 6286 6285 6284 6283 6282 6281 6280 6279 6278 6277 6276 6275 6274 6273 6272 
%IW n+21 6303 6302 6301 6300 6299 6298 6297 6296 6295 6294 6293 6292 6291 6290 6289 6288 
%IW n+22 6319 6318 6317 6316 6315 6314 6313 6312 6311 6310 6309 6308 6307 6306 6305 6304 
%IW n+23 6335 6334 6333 6332 6331 6330 6329 6328 6327 6326 6325 6324 6323 6322 6321 6320 
%IW n+24 6351 6350 6349 6348 6347 6346 6345 6344 6343 6342 6341 6340 6339 6338 6337 6336 
%IW n+25 6367 6366 6365 6364 6363 6362 6361 6360 6359 6358 6357 6356 6355 6354 6353 6352 
%IW n+26 6383 6382 6381 6380 6379 6378 6377 6376 6375 6374 6373 6372 6371 6370 6369 6368 
%IW n+27 6399 6398 6397 6396 6395 6394 6393 6392 6391 6390 6389 6388 6387 6386 6385 6384 
%IW n+28 6415 6414 6413 6412 6411 6410 6409 6408 6407 6406 6405 6404 6403 6402 6401 6400 
%IW n+29 6431 6430 6429 6428 6427 6426 6425 6424 6423 6422 6421 6420 6419 6418 6417 6416 
%IW n+30 6447 6446 6445 6444 6443 6442 6441 6440 6439 6438 6437 6436 6435 6434 6433 6432 
%IW n+31 6463 6462 6461 6460 6459 6458 6457 6456 6455 6454 6453 6452 6451 6450 6449 6448 
%IW n+32 6479 6478 6477 6476 6475 6474 6473 6472 6471 6470 6469 6468 6467 6466 6465 6464 
%IW n+33 6495 6494 6493 6492 6491 6490 6489 6488 6487 6486 6485 6484 6483 6482 6481 6480 
%IW n+34 6511 6510 6509 6508 6507 6506 6505 6504 6503 6502 6501 6500 6499 6498 6497 6496 
%IW n+35 6527 6526 6525 6524 6523 6522 6521 6520 6519 6518 6517 6516 6515 6514 6513 6512 
%IW n+36 6543 6542 6541 6540 6539 6538 6537 6536 6535 6534 6533 6532 6531 6530 6529 6528 
%IW n+37 6559 6558 6557 6556 6555 6554 6553 6552 6551 6550 6549 6548 6547 6546 6545 6544 



5.
 S

EL
 In

te
rfa

ce
 F

ea
tu

re
 
5.2 Specifications 

5-4 ME0479-1A 

 Bit No. 
Address b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0 

%IW n+38 6575 6574 6573 6572 6571 6570 6569 6568 6567 6566 6565 6564 6563 6562 6561 6560 
%IW n+39 6591 6590 6589 6588 6587 6586 6585 6584 6583 6582 6581 6580 6579 6578 6577 6576 
%IW n+40 6607 6606 6605 6604 6603 6602 6601 6600 6599 6598 6597 6596 6595 6594 6593 6592 
%IW n+41 6623 6622 6621 6620 6619 6618 6617 6616 6615 6614 6613 6612 6611 6610 6609 6608 
%IW n+42 6639 6638 6637 6636 6635 6634 6633 6632 6631 6630 6629 6628 6627 6626 6625 6624 
%IW n+43 6655 6654 6653 6652 6651 6650 6649 6648 6647 6646 6645 6644 6643 6642 6641 6640 
%IW n+44 6671 6670 6669 6668 6667 6666 6665 6664 6663 6662 6661 6660 6659 6658 6657 6656 
%IW n+45 6687 6686 6685 6684 6683 6682 6681 6680 6679 6678 6677 6676 6675 6674 6673 6672 
%IW n+46 6703 6702 6701 6700 6699 6698 6697 6696 6695 6694 6693 6692 6691 6690 6689 6688 
%IW n+47 6719 6718 6717 6716 6715 6714 6713 6712 6711 6710 6709 6708 6707 6706 6705 6704 
%IW n+48 6735 6734 6733 6732 6731 6730 6729 6728 6727 6726 6725 6724 6723 6722 6721 6720 
%IW n+49 6751 6750 6749 6748 6747 6746 6745 6744 6743 6742 6741 6740 6739 6738 6737 6736 
%IW n+50 6767 6766 6765 6764 6763 6762 6761 6760 6759 6758 6757 6756 6755 6754 6753 6752 
%IW n+51 6783 6782 6781 6780 6779 6778 6777 6776 6775 6774 6773 6772 6771 6770 6769 6768 
%IW n+52 6799 6798 6797 6796 6795 6794 6793 6792 6791 6790 6789 6788 6787 6786 6785 6784 
%IW n+53 6815 6814 6813 6812 6811 6810 6809 6808 6807 6806 6805 6804 6803 6802 6801 6800 
%IW n+54 6831 6830 6829 6828 6827 6826 6825 6824 6823 6822 6821 6820 6819 6818 6817 6816 
%IW n+55 6847 6846 6845 6844 6843 6842 6841 6840 6839 6838 6837 6836 6835 6834 6833 6832 
%IW n+56 6863 6862 6861 6860 6859 6858 6857 6856 6855 6854 6853 6852 6851 6850 6849 6848 
%IW n+57 6879 6878 6877 6876 6875 6874 6873 6872 6871 6870 6869 6868 6867 6866 6865 6864 
%IW n+58 6895 6894 6893 6892 6891 6890 6889 6888 6887 6886 6885 6884 6883 6882 6881 6880 
%IW n+59 6911 6910 6909 6908 6907 6906 6905 6904 6903 6902 6901 6900 6899 6898 6897 6896 
%IW n+60 6927 6926 6925 6924 6923 6922 6921 6920 6919 6918 6917 6916 6915 6914 6913 6912 
%IW n+61 6943 6942 6941 6940 6939 6938 6937 6936 6935 6934 6933 6932 6931 6930 6929 6928 
%IW n+62 6959 6958 6957 6956 6955 6954 6953 6952 6951 6950 6949 6948 6947 6946 6945 6944 
%IW n+63 6975 6974 6973 6972 6971 6970 6969 6968 6967 6966 6965 6964 6963 6962 6961 6960 

 
  



5. SEL Interface Feature
 
5.2 Specifications 

5-4 ME0479-1A 

 Bit No. 
Address b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0 

%IW n+38 6575 6574 6573 6572 6571 6570 6569 6568 6567 6566 6565 6564 6563 6562 6561 6560 
%IW n+39 6591 6590 6589 6588 6587 6586 6585 6584 6583 6582 6581 6580 6579 6578 6577 6576 
%IW n+40 6607 6606 6605 6604 6603 6602 6601 6600 6599 6598 6597 6596 6595 6594 6593 6592 
%IW n+41 6623 6622 6621 6620 6619 6618 6617 6616 6615 6614 6613 6612 6611 6610 6609 6608 
%IW n+42 6639 6638 6637 6636 6635 6634 6633 6632 6631 6630 6629 6628 6627 6626 6625 6624 
%IW n+43 6655 6654 6653 6652 6651 6650 6649 6648 6647 6646 6645 6644 6643 6642 6641 6640 
%IW n+44 6671 6670 6669 6668 6667 6666 6665 6664 6663 6662 6661 6660 6659 6658 6657 6656 
%IW n+45 6687 6686 6685 6684 6683 6682 6681 6680 6679 6678 6677 6676 6675 6674 6673 6672 
%IW n+46 6703 6702 6701 6700 6699 6698 6697 6696 6695 6694 6693 6692 6691 6690 6689 6688 
%IW n+47 6719 6718 6717 6716 6715 6714 6713 6712 6711 6710 6709 6708 6707 6706 6705 6704 
%IW n+48 6735 6734 6733 6732 6731 6730 6729 6728 6727 6726 6725 6724 6723 6722 6721 6720 
%IW n+49 6751 6750 6749 6748 6747 6746 6745 6744 6743 6742 6741 6740 6739 6738 6737 6736 
%IW n+50 6767 6766 6765 6764 6763 6762 6761 6760 6759 6758 6757 6756 6755 6754 6753 6752 
%IW n+51 6783 6782 6781 6780 6779 6778 6777 6776 6775 6774 6773 6772 6771 6770 6769 6768 
%IW n+52 6799 6798 6797 6796 6795 6794 6793 6792 6791 6790 6789 6788 6787 6786 6785 6784 
%IW n+53 6815 6814 6813 6812 6811 6810 6809 6808 6807 6806 6805 6804 6803 6802 6801 6800 
%IW n+54 6831 6830 6829 6828 6827 6826 6825 6824 6823 6822 6821 6820 6819 6818 6817 6816 
%IW n+55 6847 6846 6845 6844 6843 6842 6841 6840 6839 6838 6837 6836 6835 6834 6833 6832 
%IW n+56 6863 6862 6861 6860 6859 6858 6857 6856 6855 6854 6853 6852 6851 6850 6849 6848 
%IW n+57 6879 6878 6877 6876 6875 6874 6873 6872 6871 6870 6869 6868 6867 6866 6865 6864 
%IW n+58 6895 6894 6893 6892 6891 6890 6889 6888 6887 6886 6885 6884 6883 6882 6881 6880 
%IW n+59 6911 6910 6909 6908 6907 6906 6905 6904 6903 6902 6901 6900 6899 6898 6897 6896 
%IW n+60 6927 6926 6925 6924 6923 6922 6921 6920 6919 6918 6917 6916 6915 6914 6913 6912 
%IW n+61 6943 6942 6941 6940 6939 6938 6937 6936 6935 6934 6933 6932 6931 6930 6929 6928 
%IW n+62 6959 6958 6957 6956 6955 6954 6953 6952 6951 6950 6949 6948 6947 6946 6945 6944 
%IW n+63 6975 6974 6973 6972 6971 6970 6969 6968 6967 6966 6965 6964 6963 6962 6961 6960 

 
  

 
5.2 Specifications 

ME0479-1A 5-5 

 
[2] Bit address 

The applicable output port numbers in SEL are shown below. 
 

 Bit No. 

Address b7 b6 b5 b4 b3 b2 b1 b0 

%IX n 5959 5958 5957 5956 5955 5954 5953 5952 

%IX n+1 5967 5966 5965 5964 5963 5962 5961 5960 

%IX n+2 5975 5974 5973 5972 5971 5970 5969 5968 

%IX n+3 5983 5982 5981 5980 5979 5978 5977 5976 

%IX n+4 5991 5990 5989 5988 5987 5986 5985 5984 

%IX n+5 5999 5998 5997 5996 5995 5994 5993 5992 

%IX n+6 6007 6006 6005 6004 6003 6002 6001 6000 

%IX n+7 6015 6014 6013 6012 6011 6010 6009 6008 

%IX n+8 6023 6022 6021 6020 6019 6018 6017 6016 

%IX n+9 6031 6030 6029 6028 6027 6026 6025 6024 

%IX n+10 6039 6038 6037 6036 6035 6034 6033 6032 

%IX n+11 6047 6046 6045 6044 6043 6042 6041 6040 

%IX n+12 6055 6054 6053 6052 6051 6050 6049 6048 

%IX n+13 6063 6062 6061 6060 6059 6058 6057 6056 

%IX n+14 6071 6070 6069 6068 6067 6066 6065 6064 

%IX n+15 6079 6078 6077 6076 6075 6074 6073 6072 

%IX n+16 6087 6086 6085 6084 6083 6082 6081 6080 

%IX n+17 6095 6094 6093 6092 6091 6090 6089 6088 

%IX n+18 6103 6102 6101 6100 6099 6098 6097 6096 

%IX n+19 6111 6110 6109 6108 6107 6106 6105 6104 

%IX n+20 6119 6118 6117 6116 6115 6114 6113 6112 

%IX n+21 6127 6126 6125 6124 6123 6122 6121 6120 

%IX n+22 6135 6134 6133 6132 6131 6130 6129 6128 

%IX n+23 6143 6142 6141 6140 6139 6138 6137 6136 

%IX n+24 6151 6150 6149 6148 6147 6146 6145 6144 

%IX n+25 6159 6158 6157 6156 6155 6154 6153 6152 

%IX n+26 6167 6166 6165 6164 6163 6162 6161 6160 

%IX n+27 6175 6174 6173 6172 6171 6170 6169 6168 

%IX n+28 6183 6182 6181 6180 6179 6178 6177 6176 

%IX n+29 6191 6190 6189 6188 6187 6186 6185 6184 

%IX n+30 6199 6198 6197 6196 6195 6194 6193 6192 

%IX n+31 6207 6206 6205 6204 6203 6202 6201 6200 

%IX n+32 6215 6214 6213 6212 6211 6210 6209 6208 

%IX n+33 6223 6222 6221 6220 6219 6218 6217 6216 

%IX n+34 6231 6230 6229 6228 6227 6226 6225 6224 

%IX n+35 6239 6238 6237 6236 6235 6234 6233 6232 

%IX n+36 6247 6246 6245 6244 6243 6242 6241 6240 

%IX n+37 6255 6254 6253 6252 6251 6250 6249 6248 

%IX n+38 6263 6262 6261 6260 6259 6258 6257 6256 

%IX n+39 6271 6270 6269 6268 6267 6266 6265 6264 

%IX n+40 6279 6278 6277 6276 6275 6274 6273 6272 

%IX n+41 6287 6286 6285 6284 6283 6282 6281 6280 
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5.2 Specifications 

5-6 ME0479-1A 

 Bit No. 

Address b7 b6 b5 b4 b3 b2 b1 b0 

%IX n+42 6295 6294 6293 6292 6291 6290 6289 6288 

%IX n+43 6303 6302 6301 6300 6299 6298 6297 6296 

%IX n+44 6311 6310 6309 6308 6307 6306 6305 6304 

%IX n+45 6319 6318 6317 6316 6315 6314 6313 6312 

%IX n+46 6327 6326 6325 6324 6323 6322 6321 6320 

%IX n+47 6335 6334 6333 6332 6331 6330 6329 6328 

%IX n+48 6343 6342 6341 6340 6339 6338 6337 6336 

%IX n+49 6351 6350 6349 6348 6347 6346 6345 6344 

%IX n+50 6359 6358 6357 6356 6355 6354 6353 6352 

%IX n+51 6367 6366 6365 6364 6363 6362 6361 6360 

%IX n+52 6375 6374 6373 6372 6371 6370 6369 6368 

%IX n+53 6383 6382 6381 6380 6379 6378 6377 6376 

%IX n+54 6391 6390 6389 6388 6387 6386 6385 6384 

%IX n+55 6399 6398 6397 6396 6395 6394 6393 6392 

%IX n+56 6407 6406 6405 6404 6403 6402 6401 6400 

%IX n+57 6415 6414 6413 6412 6411 6410 6409 6408 

%IX n+58 6423 6422 6421 6420 6419 6418 6417 6416 

%IX n+59 6431 6430 6429 6428 6427 6426 6425 6424 

%IX n+60 6439 6438 6437 6436 6435 6434 6433 6432 

%IX n+61 6447 6446 6445 6444 6443 6442 6441 6440 

%IX n+62 6455 6454 6453 6452 6451 6450 6449 6448 

%IX n+63 6463 6462 6461 6460 6459 6458 6457 6456 

%IX n+64 6471 6470 6469 6468 6467 6466 6465 6464 

%IX n+65 6479 6478 6477 6476 6475 6474 6473 6472 

%IX n+66 6487 6486 6485 6484 6483 6482 6481 6480 

%IX n+67 6495 6494 6493 6492 6491 6490 6489 6488 

%IX n+68 6503 6502 6501 6500 6499 6498 6497 6496 

%IX n+69 6511 6510 6509 6508 6507 6506 6505 6504 

%IX n+70 6519 6518 6517 6516 6515 6514 6513 6512 

%IX n+71 6527 6526 6525 6524 6523 6522 6521 6520 

%IX n+72 6535 6534 6533 6532 6531 6530 6529 6528 

%IX n+73 6543 6542 6541 6540 6539 6538 6537 6536 

%IX n+74 6551 6550 6549 6548 6547 6546 6545 6544 

%IX n+75 6559 6558 6557 6556 6555 6554 6553 6552 

%IX n+76 6567 6566 6565 6564 6563 6562 6561 6560 

%IX n+77 6575 6574 6573 6572 6571 6570 6569 6568 

%IX n+78 6583 6582 6581 6580 6579 6578 6577 6576 

%IX n+79 6591 6590 6589 6588 6587 6586 6585 6584 

%IX n+80 6599 6598 6597 6596 6595 6594 6593 6592 

%IX n+81 6607 6606 6605 6604 6603 6602 6601 6600 

%IX n+82 6615 6614 6613 6612 6611 6610 6609 6608 

%IX n+83 6623 6622 6621 6620 6619 6618 6617 6616 

%IX n+84 6631 6630 6629 6628 6627 6626 6625 6624 

%IX n+85 6639 6638 6637 6636 6635 6634 6633 6632 

%IX n+86 6647 6646 6645 6644 6643 6642 6641 6640 



5. SEL Interface Feature
 
5.2 Specifications 

5-6 ME0479-1A 

 Bit No. 

Address b7 b6 b5 b4 b3 b2 b1 b0 

%IX n+42 6295 6294 6293 6292 6291 6290 6289 6288 

%IX n+43 6303 6302 6301 6300 6299 6298 6297 6296 

%IX n+44 6311 6310 6309 6308 6307 6306 6305 6304 

%IX n+45 6319 6318 6317 6316 6315 6314 6313 6312 

%IX n+46 6327 6326 6325 6324 6323 6322 6321 6320 

%IX n+47 6335 6334 6333 6332 6331 6330 6329 6328 

%IX n+48 6343 6342 6341 6340 6339 6338 6337 6336 

%IX n+49 6351 6350 6349 6348 6347 6346 6345 6344 

%IX n+50 6359 6358 6357 6356 6355 6354 6353 6352 

%IX n+51 6367 6366 6365 6364 6363 6362 6361 6360 

%IX n+52 6375 6374 6373 6372 6371 6370 6369 6368 

%IX n+53 6383 6382 6381 6380 6379 6378 6377 6376 

%IX n+54 6391 6390 6389 6388 6387 6386 6385 6384 

%IX n+55 6399 6398 6397 6396 6395 6394 6393 6392 

%IX n+56 6407 6406 6405 6404 6403 6402 6401 6400 

%IX n+57 6415 6414 6413 6412 6411 6410 6409 6408 

%IX n+58 6423 6422 6421 6420 6419 6418 6417 6416 

%IX n+59 6431 6430 6429 6428 6427 6426 6425 6424 

%IX n+60 6439 6438 6437 6436 6435 6434 6433 6432 

%IX n+61 6447 6446 6445 6444 6443 6442 6441 6440 

%IX n+62 6455 6454 6453 6452 6451 6450 6449 6448 

%IX n+63 6463 6462 6461 6460 6459 6458 6457 6456 

%IX n+64 6471 6470 6469 6468 6467 6466 6465 6464 

%IX n+65 6479 6478 6477 6476 6475 6474 6473 6472 

%IX n+66 6487 6486 6485 6484 6483 6482 6481 6480 

%IX n+67 6495 6494 6493 6492 6491 6490 6489 6488 

%IX n+68 6503 6502 6501 6500 6499 6498 6497 6496 

%IX n+69 6511 6510 6509 6508 6507 6506 6505 6504 

%IX n+70 6519 6518 6517 6516 6515 6514 6513 6512 

%IX n+71 6527 6526 6525 6524 6523 6522 6521 6520 

%IX n+72 6535 6534 6533 6532 6531 6530 6529 6528 

%IX n+73 6543 6542 6541 6540 6539 6538 6537 6536 

%IX n+74 6551 6550 6549 6548 6547 6546 6545 6544 

%IX n+75 6559 6558 6557 6556 6555 6554 6553 6552 

%IX n+76 6567 6566 6565 6564 6563 6562 6561 6560 

%IX n+77 6575 6574 6573 6572 6571 6570 6569 6568 

%IX n+78 6583 6582 6581 6580 6579 6578 6577 6576 

%IX n+79 6591 6590 6589 6588 6587 6586 6585 6584 

%IX n+80 6599 6598 6597 6596 6595 6594 6593 6592 

%IX n+81 6607 6606 6605 6604 6603 6602 6601 6600 

%IX n+82 6615 6614 6613 6612 6611 6610 6609 6608 

%IX n+83 6623 6622 6621 6620 6619 6618 6617 6616 

%IX n+84 6631 6630 6629 6628 6627 6626 6625 6624 

%IX n+85 6639 6638 6637 6636 6635 6634 6633 6632 

%IX n+86 6647 6646 6645 6644 6643 6642 6641 6640 

 
5.2 Specifications 

ME0479-1A 5-7 

 Bit No. 

Address b7 b6 b5 b4 b3 b2 b1 b0 

%IX n+87 6655 6654 6653 6652 6651 6650 6649 6648 

%IX n+88 6663 6662 6661 6660 6659 6658 6657 6656 

%IX n+89 6671 6670 6669 6668 6667 6666 6665 6664 

%IX n+90 6679 6678 6677 6676 6675 6674 6673 6672 

%IX n+91 6687 6686 6685 6684 6683 6682 6681 6680 

%IX n+92 6695 6694 6693 6692 6691 6690 6689 6688 

%IX n+93 6703 6702 6701 6700 6699 6698 6697 6696 

%IX n+94 6711 6710 6709 6708 6707 6706 6705 6704 

%IX n+95 6719 6718 6717 6716 6715 6714 6713 6712 

%IX n+96 6727 6726 6725 6724 6723 6722 6721 6720 

%IX n+97 6735 6734 6733 6732 6731 6730 6729 6728 

%IX n+98 6743 6742 6741 6740 6739 6738 6737 6736 

%IX n+99 6751 6750 6749 6748 6747 6746 6745 6744 

%IX n+100 6759 6758 6757 6756 6755 6754 6753 6752 

%IX n+101 6767 6766 6765 6764 6763 6762 6761 6760 

%IX n+102 6775 6774 6773 6772 6771 6770 6769 6768 

%IX n+103 6783 6782 6781 6780 6779 6778 6777 6776 

%IX n+104 6791 6790 6789 6788 6787 6786 6785 6784 

%IX n+105 6799 6798 6797 6796 6795 6794 6793 6792 

%IX n+106 6807 6806 6805 6804 6803 6802 6801 6800 

%IX n+107 6815 6814 6813 6812 6811 6810 6809 6808 

%IX n+108 6823 6822 6821 6820 6819 6818 6817 6816 

%IX n+109 6831 6830 6829 6828 6827 6826 6825 6824 

%IX n+110 6839 6838 6837 6836 6835 6834 6833 6832 

%IX n+111 6847 6846 6845 6844 6843 6842 6841 6840 

%IX n+112 6855 6854 6853 6852 6851 6850 6849 6848 

%IX n+113 6863 6862 6861 6860 6859 6858 6857 6856 

%IX n+114 6871 6870 6869 6868 6867 6866 6865 6864 

%IX n+115 6879 6878 6877 6876 6875 6874 6873 6872 

%IX n+116 6887 6886 6885 6884 6883 6882 6881 6880 

%IX n+117 6895 6894 6893 6892 6891 6890 6889 6888 

%IX n+118 6903 6902 6901 6900 6899 6898 6897 6896 

%IX n+119 6911 6910 6909 6908 6907 6906 6905 6904 

%IX n+120 6919 6918 6917 6916 6915 6914 6913 6912 

%IX n+121 6927 6926 6925 6924 6923 6922 6921 6920 

%IX n+122 6935 6934 6933 6932 6931 6930 6929 6928 

%IX n+123 6943 6942 6941 6940 6939 6938 6937 6936 

%IX n+124 6951 6950 6949 6948 6947 6946 6945 6944 

%IX n+125 6959 6958 6957 6956 6955 6954 6953 6952 

%IX n+126 6967 6966 6965 6964 6963 6962 6961 6960 

%IX n+127 6975 6974 6973 6972 6971 6970 6969 6968 
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5.2 Specifications 

5-8 ME0479-1A 

 
5.2.2 Relation Between PLC Input Addresses and SEL Input Port Numbers 

 
The PLC output address n should be automatically assigned by CODESYS for XSEL2. 
As the assigned value should vary depending on the order for being added in an I/O device, it is 
recommended to have the I/O variable defined and perform PLC programming by using variables. 
 

[1] Word address 
The applicable input port numbers in SEL are shown below. 
 

 Bit No. 
Address b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0 

%QW n 2967 2966 2965 2964 2963 2962 2961 2960 2959 2958 2957 2956 2955 2954 2953 2952 
%QW n+1 2983 2982 2981 2980 2979 2978 2977 2976 2975 2974 2973 2972 2971 2970 2969 2968 
%QW n+2 2999 2998 2997 2996 2995 2994 2993 2992 2991 2990 2989 2988 2987 2986 2985 2984 
%QW n+3 3015 3014 3013 3012 3011 3010 3009 3008 3007 3006 3005 3004 3003 3002 3001 3000 
%QW n+4 3031 3030 3029 3028 3027 3026 3025 3024 3023 3022 3021 3020 3019 3018 3017 3016 
%QW n+5 3047 3046 3045 3044 3043 3042 3041 3040 3039 3038 3037 3036 3035 3034 3033 3032 
%QW n+6 3063 3062 3061 3060 3059 3058 3057 3056 3055 3054 3053 3052 3051 3050 3049 3048 
%QW n+7 3079 3078 3077 3076 3075 3074 3073 3072 3071 3070 3069 3068 3067 3066 3065 3064 
%QW n+8 3095 3094 3093 3092 3091 3090 3089 3088 3087 3086 3085 3084 3083 3082 3081 3080 
%QW n+9 3111 3110 3109 3108 3107 3106 3105 3104 3103 3102 3101 3100 3099 3098 3097 3096 
%QW n+10 3127 3126 3125 3124 3123 3122 3121 3120 3119 3118 3117 3116 3115 3114 3113 3112 
%QW n+11 3143 3142 3141 3140 3139 3138 3137 3136 3135 3134 3133 3132 3131 3130 3129 3128 
%QW n+12 3159 3158 3157 3156 3155 3154 3153 3152 3151 3150 3149 3148 3147 3146 3145 3144 
%QW n+13 3175 3174 3173 3172 3171 3170 3169 3168 3167 3166 3165 3164 3163 3162 3161 3160 
%QW n+14 3191 3190 3189 3188 3187 3186 3185 3184 3183 3182 3181 3180 3179 3178 3177 3176 
%QW n+15 3207 3206 3205 3204 3203 3202 3201 3200 3199 3198 3197 3196 3195 3194 3193 3192 
%QW n+16 3223 3222 3221 3220 3219 3218 3217 3216 3215 3214 3213 3212 3211 3210 3209 3208 
%QW n+17 3239 3238 3237 3236 3235 3234 3233 3232 3231 3230 3229 3228 3227 3226 3225 3224 
%QW n+18 3255 3254 3253 3252 3251 3250 3249 3248 3247 3246 3245 3244 3243 3242 3241 3240 
%QW n+19 3271 3270 3269 3268 3267 3266 3265 3264 3263 3262 3261 3260 3259 3258 3257 3256 
%QW n+20 3287 3286 3285 3284 3283 3282 3281 3280 3279 3278 3277 3276 3275 3274 3273 3272 
%QW n+21 3303 3302 3301 3300 3299 3298 3297 3296 3295 3294 3293 3292 3291 3290 3289 3288 
%QW n+22 3319 3318 3317 3316 3315 3314 3313 3312 3311 3310 3309 3308 3307 3306 3305 3304 
%QW n+23 3335 3334 3333 3332 3331 3330 3329 3328 3327 3326 3325 3324 3323 3322 3321 3320 
%QW n+24 3351 3350 3349 3348 3347 3346 3345 3344 3343 3342 3341 3340 3339 3338 3337 3336 
%QW n+25 3367 3366 3365 3364 3363 3362 3361 3360 3359 3358 3357 3356 3355 3354 3353 3352 
%QW n+26 3383 3382 3381 3380 3379 3378 3377 3376 3375 3374 3373 3372 3371 3370 3369 3368 
%QW n+27 3399 3398 3397 3396 3395 3394 3393 3392 3391 3390 3389 3388 3387 3386 3385 3384 
%QW n+28 3415 3414 3413 3412 3411 3410 3409 3408 3407 3406 3405 3404 3403 3402 3401 3400 
%QW n+29 3431 3430 3429 3428 3427 3426 3425 3424 3423 3422 3421 3420 3419 3418 3417 3416 
%QW n+30 3447 3446 3445 3444 3443 3442 3441 3440 3439 3438 3437 3436 3435 3434 3433 3432 
%QW n+31 3463 3462 3461 3460 3459 3458 3457 3456 3455 3454 3453 3452 3451 3450 3449 3448 
%QW n+32 3479 3478 3477 3476 3475 3474 3473 3472 3471 3470 3469 3468 3467 3466 3465 3464 
%QW n+33 3495 3494 3493 3492 3491 3490 3489 3488 3487 3486 3485 3484 3483 3482 3481 3480 
%QW n+34 3511 3510 3509 3508 3507 3506 3505 3504 3503 3502 3501 3500 3499 3498 3497 3496 
%QW n+35 3527 3526 3525 3524 3523 3522 3521 3520 3519 3518 3517 3516 3515 3514 3513 3512 
%QW n+36 3543 3542 3541 3540 3539 3538 3537 3536 3535 3534 3533 3532 3531 3530 3529 3528 
%QW n+37 3559 3558 3557 3556 3555 3554 3553 3552 3551 3550 3549 3548 3547 3546 3545 3544 



5. SEL Interface Feature
 
5.2 Specifications 

5-8 ME0479-1A 

 
5.2.2 Relation Between PLC Input Addresses and SEL Input Port Numbers 

 
The PLC output address n should be automatically assigned by CODESYS for XSEL2. 
As the assigned value should vary depending on the order for being added in an I/O device, it is 
recommended to have the I/O variable defined and perform PLC programming by using variables. 
 

[1] Word address 
The applicable input port numbers in SEL are shown below. 
 

 Bit No. 
Address b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0 

%QW n 2967 2966 2965 2964 2963 2962 2961 2960 2959 2958 2957 2956 2955 2954 2953 2952 
%QW n+1 2983 2982 2981 2980 2979 2978 2977 2976 2975 2974 2973 2972 2971 2970 2969 2968 
%QW n+2 2999 2998 2997 2996 2995 2994 2993 2992 2991 2990 2989 2988 2987 2986 2985 2984 
%QW n+3 3015 3014 3013 3012 3011 3010 3009 3008 3007 3006 3005 3004 3003 3002 3001 3000 
%QW n+4 3031 3030 3029 3028 3027 3026 3025 3024 3023 3022 3021 3020 3019 3018 3017 3016 
%QW n+5 3047 3046 3045 3044 3043 3042 3041 3040 3039 3038 3037 3036 3035 3034 3033 3032 
%QW n+6 3063 3062 3061 3060 3059 3058 3057 3056 3055 3054 3053 3052 3051 3050 3049 3048 
%QW n+7 3079 3078 3077 3076 3075 3074 3073 3072 3071 3070 3069 3068 3067 3066 3065 3064 
%QW n+8 3095 3094 3093 3092 3091 3090 3089 3088 3087 3086 3085 3084 3083 3082 3081 3080 
%QW n+9 3111 3110 3109 3108 3107 3106 3105 3104 3103 3102 3101 3100 3099 3098 3097 3096 
%QW n+10 3127 3126 3125 3124 3123 3122 3121 3120 3119 3118 3117 3116 3115 3114 3113 3112 
%QW n+11 3143 3142 3141 3140 3139 3138 3137 3136 3135 3134 3133 3132 3131 3130 3129 3128 
%QW n+12 3159 3158 3157 3156 3155 3154 3153 3152 3151 3150 3149 3148 3147 3146 3145 3144 
%QW n+13 3175 3174 3173 3172 3171 3170 3169 3168 3167 3166 3165 3164 3163 3162 3161 3160 
%QW n+14 3191 3190 3189 3188 3187 3186 3185 3184 3183 3182 3181 3180 3179 3178 3177 3176 
%QW n+15 3207 3206 3205 3204 3203 3202 3201 3200 3199 3198 3197 3196 3195 3194 3193 3192 
%QW n+16 3223 3222 3221 3220 3219 3218 3217 3216 3215 3214 3213 3212 3211 3210 3209 3208 
%QW n+17 3239 3238 3237 3236 3235 3234 3233 3232 3231 3230 3229 3228 3227 3226 3225 3224 
%QW n+18 3255 3254 3253 3252 3251 3250 3249 3248 3247 3246 3245 3244 3243 3242 3241 3240 
%QW n+19 3271 3270 3269 3268 3267 3266 3265 3264 3263 3262 3261 3260 3259 3258 3257 3256 
%QW n+20 3287 3286 3285 3284 3283 3282 3281 3280 3279 3278 3277 3276 3275 3274 3273 3272 
%QW n+21 3303 3302 3301 3300 3299 3298 3297 3296 3295 3294 3293 3292 3291 3290 3289 3288 
%QW n+22 3319 3318 3317 3316 3315 3314 3313 3312 3311 3310 3309 3308 3307 3306 3305 3304 
%QW n+23 3335 3334 3333 3332 3331 3330 3329 3328 3327 3326 3325 3324 3323 3322 3321 3320 
%QW n+24 3351 3350 3349 3348 3347 3346 3345 3344 3343 3342 3341 3340 3339 3338 3337 3336 
%QW n+25 3367 3366 3365 3364 3363 3362 3361 3360 3359 3358 3357 3356 3355 3354 3353 3352 
%QW n+26 3383 3382 3381 3380 3379 3378 3377 3376 3375 3374 3373 3372 3371 3370 3369 3368 
%QW n+27 3399 3398 3397 3396 3395 3394 3393 3392 3391 3390 3389 3388 3387 3386 3385 3384 
%QW n+28 3415 3414 3413 3412 3411 3410 3409 3408 3407 3406 3405 3404 3403 3402 3401 3400 
%QW n+29 3431 3430 3429 3428 3427 3426 3425 3424 3423 3422 3421 3420 3419 3418 3417 3416 
%QW n+30 3447 3446 3445 3444 3443 3442 3441 3440 3439 3438 3437 3436 3435 3434 3433 3432 
%QW n+31 3463 3462 3461 3460 3459 3458 3457 3456 3455 3454 3453 3452 3451 3450 3449 3448 
%QW n+32 3479 3478 3477 3476 3475 3474 3473 3472 3471 3470 3469 3468 3467 3466 3465 3464 
%QW n+33 3495 3494 3493 3492 3491 3490 3489 3488 3487 3486 3485 3484 3483 3482 3481 3480 
%QW n+34 3511 3510 3509 3508 3507 3506 3505 3504 3503 3502 3501 3500 3499 3498 3497 3496 
%QW n+35 3527 3526 3525 3524 3523 3522 3521 3520 3519 3518 3517 3516 3515 3514 3513 3512 
%QW n+36 3543 3542 3541 3540 3539 3538 3537 3536 3535 3534 3533 3532 3531 3530 3529 3528 
%QW n+37 3559 3558 3557 3556 3555 3554 3553 3552 3551 3550 3549 3548 3547 3546 3545 3544 

 
5.2 Specifications 
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 Bit No. 
Address b15 b14 b13 b12 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0 

%QW n+38 3575 3574 3573 3572 3571 3570 3569 3568 3567 3566 3565 3564 3563 3562 3561 3560 
%QW n+39 3591 3590 3589 3588 3587 3586 3585 3584 3583 3582 3581 3580 3579 3578 3577 3576 
%QW n+40 3607 3606 3605 3604 3603 3602 3601 3600 3599 3598 3597 3596 3595 3594 3593 3592 
%QW n+41 3623 3622 3621 3620 3619 3618 3617 3616 3615 3614 3613 3612 3611 3610 3609 3608 
%QW n+42 3639 3638 3637 3636 3635 3634 3633 3632 3631 3630 3629 3628 3627 3626 3625 3624 
%QW n+43 3655 3654 3653 3652 3651 3650 3649 3648 3647 3646 3645 3644 3643 3642 3641 3640 
%QW n+44 3671 3670 3669 3668 3667 3666 3665 3664 3663 3662 3661 3660 3659 3658 3657 3656 
%QW n+45 3687 3686 3685 3684 3683 3682 3681 3680 3679 3678 3677 3676 3675 3674 3673 3672 
%QW n+46 3703 3702 3701 3700 3699 3698 3697 3696 3695 3694 3693 3692 3691 3690 3689 3688 
%QW n+47 3719 3718 3717 3716 3715 3714 3713 3712 3711 3710 3709 3708 3707 3706 3705 3704 
%QW n+48 3735 3734 3733 3732 3731 3730 3729 3728 3727 3726 3725 3724 3723 3722 3721 3720 
%QW n+49 3751 3750 3749 3748 3747 3746 3745 3744 3743 3742 3741 3740 3739 3738 3737 3736 
%QW n+50 3767 3766 3765 3764 3763 3762 3761 3760 3759 3758 3757 3756 3755 3754 3753 3752 
%QW n+51 3783 3782 3781 3780 3779 3778 3777 3776 3775 3774 3773 3772 3771 3770 3769 3768 
%QW n+52 3799 3798 3797 3796 3795 3794 3793 3792 3791 3790 3789 3788 3787 3786 3785 3784 
%QW n+53 3815 3814 3813 3812 3811 3810 3809 3808 3807 3806 3805 3804 3803 3802 3801 3800 
%QW n+54 3831 3830 3829 3828 3827 3826 3825 3824 3823 3822 3821 3820 3819 3818 3817 3816 
%QW n+55 3847 3846 3845 3844 3843 3842 3841 3840 3839 3838 3837 3836 3835 3834 3833 3832 
%QW n+56 3863 3862 3861 3860 3859 3858 3857 3856 3855 3854 3853 3852 3851 3850 3849 3848 
%QW n+57 3879 3878 3877 3876 3875 3874 3873 3872 3871 3870 3869 3868 3867 3866 3865 3864 
%QW n+58 3895 3894 3893 3892 3891 3890 3889 3888 3887 3886 3885 3884 3883 3882 3881 3880 
%QW n+59 3911 3910 3909 3908 3907 3906 3905 3904 3903 3902 3901 3900 3899 3898 3897 3896 
%QW n+60 3927 3926 3925 3924 3923 3922 3921 3920 3919 3918 3917 3916 3915 3914 3913 3912 
%QW n+61 3943 3942 3941 3940 3939 3938 3937 3936 3935 3934 3933 3932 3931 3930 3929 3928 
%QW n+62 3959 3958 3957 3956 3955 3954 3953 3952 3951 3950 3949 3948 3947 3946 3945 3944 
%QW n+63 3975 3974 3973 3972 3971 3970 3969 3968 3967 3966 3965 3964 3963 3962 3961 3960 
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5.2 Specifications 

5-10 ME0479-1A 

 
[2] Bit address 

The applicable input port numbers in SEL are shown below. 
 

 Bit No. 

Address b7 b6 b5 b4 b3 b2 b1 b0 

%QX n 2959 2958 2957 2956 2955 2954 2953 2952 

%QX n+1 2967 2966 2965 2964 2963 2962 2961 2960 

%QX n+2 2975 2974 2973 2972 2971 2970 2969 2968 

%QX n+3 2983 2982 2981 2980 2979 2978 2977 2976 

%QX n+4 2991 2990 2989 2988 2987 2986 2985 2984 

%QX n+5 2999 2998 2997 2996 2995 2994 2993 2992 

%QX n+6 3007 3006 3005 3004 3003 3002 3001 3000 

%QX n+7 3015 3014 3013 3012 3011 3010 3009 3008 

%QX n+8 3023 3022 3021 3020 3019 3018 3017 3016 

%QX n+9 3031 3030 3029 3028 3027 3026 3025 3024 

%QX n+10 3039 3038 3037 3036 3035 3034 3033 3032 

%QX n+11 3047 3046 3045 3044 3043 3042 3041 3040 

%QX n+12 3055 3054 3053 3052 3051 3050 3049 3048 

%QX n+13 3063 3062 3061 3060 3059 3058 3057 3056 

%QX n+14 3071 3070 3069 3068 3067 3066 3065 3064 

%QX n+15 3079 3078 3077 3076 3075 3074 3073 3072 

%QX n+16 3087 3086 3085 3084 3083 3082 3081 3080 

%QX n+17 3095 3094 3093 3092 3091 3090 3089 3088 

%QX n+18 3103 3102 3101 3100 3099 3098 3097 3096 

%QX n+19 3111 3110 3109 3108 3107 3106 3105 3104 

%QX n+20 3119 3118 3117 3116 3115 3114 3113 3112 

%QX n+21 3127 3126 3125 3124 3123 3122 3121 3120 

%QX n+22 3135 3134 3133 3132 3131 3130 3129 3128 

%QX n+23 3143 3142 3141 3140 3139 3138 3137 3136 

%QX n+24 3151 3150 3149 3148 3147 3146 3145 3144 

%QX n+25 3159 3158 3157 3156 3155 3154 3153 3152 

%QX n+26 3167 3166 3165 3164 3163 3162 3161 3160 

%QX n+27 3175 3174 3173 3172 3171 3170 3169 3168 

%QX n+28 3183 3182 3181 3180 3179 3178 3177 3176 

%QX n+29 3191 3190 3189 3188 3187 3186 3185 3184 

%QX n+30 3199 3198 3197 3196 3195 3194 3193 3192 

%QX n+31 3207 3206 3205 3204 3203 3202 3201 3200 

%QX n+32 3215 3214 3213 3212 3211 3210 3209 3208 

%QX n+33 3223 3222 3221 3220 3219 3218 3217 3216 

%QX n+34 3231 3230 3229 3228 3227 3226 3225 3224 

%QX n+35 3239 3238 3237 3236 3235 3234 3233 3232 

%QX n+36 3247 3246 3245 3244 3243 3242 3241 3240 

%QX n+37 3255 3254 3253 3252 3251 3250 3249 3248 

%QX n+38 3263 3262 3261 3260 3259 3258 3257 3256 

%QX n+39 3271 3270 3269 3268 3267 3266 3265 3264 

%QX n+40 3279 3278 3277 3276 3275 3274 3273 3272 

%QX n+41 3287 3286 3285 3284 3283 3282 3281 3280 



5. SEL Interface Feature
 
5.2 Specifications 

5-10 ME0479-1A 

 
[2] Bit address 

The applicable input port numbers in SEL are shown below. 
 

 Bit No. 

Address b7 b6 b5 b4 b3 b2 b1 b0 

%QX n 2959 2958 2957 2956 2955 2954 2953 2952 

%QX n+1 2967 2966 2965 2964 2963 2962 2961 2960 

%QX n+2 2975 2974 2973 2972 2971 2970 2969 2968 

%QX n+3 2983 2982 2981 2980 2979 2978 2977 2976 

%QX n+4 2991 2990 2989 2988 2987 2986 2985 2984 

%QX n+5 2999 2998 2997 2996 2995 2994 2993 2992 

%QX n+6 3007 3006 3005 3004 3003 3002 3001 3000 

%QX n+7 3015 3014 3013 3012 3011 3010 3009 3008 

%QX n+8 3023 3022 3021 3020 3019 3018 3017 3016 

%QX n+9 3031 3030 3029 3028 3027 3026 3025 3024 

%QX n+10 3039 3038 3037 3036 3035 3034 3033 3032 

%QX n+11 3047 3046 3045 3044 3043 3042 3041 3040 

%QX n+12 3055 3054 3053 3052 3051 3050 3049 3048 

%QX n+13 3063 3062 3061 3060 3059 3058 3057 3056 

%QX n+14 3071 3070 3069 3068 3067 3066 3065 3064 

%QX n+15 3079 3078 3077 3076 3075 3074 3073 3072 

%QX n+16 3087 3086 3085 3084 3083 3082 3081 3080 

%QX n+17 3095 3094 3093 3092 3091 3090 3089 3088 

%QX n+18 3103 3102 3101 3100 3099 3098 3097 3096 

%QX n+19 3111 3110 3109 3108 3107 3106 3105 3104 

%QX n+20 3119 3118 3117 3116 3115 3114 3113 3112 

%QX n+21 3127 3126 3125 3124 3123 3122 3121 3120 

%QX n+22 3135 3134 3133 3132 3131 3130 3129 3128 

%QX n+23 3143 3142 3141 3140 3139 3138 3137 3136 

%QX n+24 3151 3150 3149 3148 3147 3146 3145 3144 

%QX n+25 3159 3158 3157 3156 3155 3154 3153 3152 

%QX n+26 3167 3166 3165 3164 3163 3162 3161 3160 

%QX n+27 3175 3174 3173 3172 3171 3170 3169 3168 

%QX n+28 3183 3182 3181 3180 3179 3178 3177 3176 

%QX n+29 3191 3190 3189 3188 3187 3186 3185 3184 

%QX n+30 3199 3198 3197 3196 3195 3194 3193 3192 

%QX n+31 3207 3206 3205 3204 3203 3202 3201 3200 

%QX n+32 3215 3214 3213 3212 3211 3210 3209 3208 

%QX n+33 3223 3222 3221 3220 3219 3218 3217 3216 

%QX n+34 3231 3230 3229 3228 3227 3226 3225 3224 

%QX n+35 3239 3238 3237 3236 3235 3234 3233 3232 

%QX n+36 3247 3246 3245 3244 3243 3242 3241 3240 

%QX n+37 3255 3254 3253 3252 3251 3250 3249 3248 

%QX n+38 3263 3262 3261 3260 3259 3258 3257 3256 

%QX n+39 3271 3270 3269 3268 3267 3266 3265 3264 

%QX n+40 3279 3278 3277 3276 3275 3274 3273 3272 

%QX n+41 3287 3286 3285 3284 3283 3282 3281 3280 

 
5.2 Specifications 
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 Bit No. 

Address b7 b6 b5 b4 b3 b2 b1 b0 

%QX n+42 3295 3294 3293 3292 3291 3290 3289 3288 

%QX n+43 3303 3302 3301 3300 3299 3298 3297 3296 

%QX n+44 3311 3310 3309 3308 3307 3306 3305 3304 

%QX n+45 3319 3318 3317 3316 3315 3314 3313 3312 

%QX n+46 3327 3326 3325 3324 3323 3322 3321 3320 

%QX n+47 3335 3334 3333 3332 3331 3330 3329 3328 

%QX n+48 3343 3342 3341 3340 3339 3338 3337 3336 

%QX n+49 3351 3350 3349 3348 3347 3346 3345 3344 

%QX n+50 3359 3358 3357 3356 3355 3354 3353 3352 

%QX n+51 3367 3366 3365 3364 3363 3362 3361 3360 

%QX n+52 3375 3374 3373 3372 3371 3370 3369 3368 

%QX n+53 3383 3382 3381 3380 3379 3378 3377 3376 

%QX n+54 3391 3390 3389 3388 3387 3386 3385 3384 

%QX n+55 3399 3398 3397 3396 3395 3394 3393 3392 

%QX n+56 3407 3406 3405 3404 3403 3402 3401 3400 

%QX n+57 3415 3414 3413 3412 3411 3410 3409 3408 

%QX n+58 3423 3422 3421 3420 3419 3418 3417 3416 

%QX n+59 3431 3430 3429 3428 3427 3426 3425 3424 

%QX n+60 3439 3438 3437 3436 3435 3434 3433 3432 

%QX n+61 3447 3446 3445 3444 3443 3442 3441 3440 

%QX n+62 3455 3454 3453 3452 3451 3450 3449 3448 

%QX n+63 3463 3462 3461 3460 3459 3458 3457 3456 

%QX n+64 3471 3470 3469 3468 3467 3466 3465 3464 

%QX n+65 3479 3478 3477 3476 3475 3474 3473 3472 

%QX n+66 3487 3486 3485 3484 3483 3482 3481 3480 

%QX n+67 3495 3494 3493 3492 3491 3490 3489 3488 

%QX n+68 3503 3502 3501 3500 3499 3498 3497 3496 

%QX n+69 3511 3510 3509 3508 3507 3506 3505 3504 

%QX n+70 3519 3518 3517 3516 3515 3514 3513 3512 

%QX n+71 3527 3526 3525 3524 3523 3522 3521 3520 

%QX n+72 3535 3534 3533 3532 3531 3530 3529 3528 

%QX n+73 3543 3542 3541 3540 3539 3538 3537 3536 

%QX n+74 3551 3550 3549 3548 3547 3546 3545 3544 

%QX n+75 3559 3558 3557 3556 3555 3554 3553 3552 

%QX n+76 3567 3566 3565 3564 3563 3562 3561 3560 

%QX n+77 3575 3574 3573 3572 3571 3570 3569 3568 

%QX n+78 3583 3582 3581 3580 3579 3578 3577 3576 

%QX n+79 3591 3590 3589 3588 3587 3586 3585 3584 

%QX n+80 3599 3598 3597 3596 3595 3594 3593 3592 

%QX n+81 3607 3606 3605 3604 3603 3602 3601 3600 

%QX n+82 3615 3614 3613 3612 3611 3610 3609 3608 

%QX n+83 3623 3622 3621 3620 3619 3618 3617 3616 

%QX n+84 3631 3630 3629 3628 3627 3626 3625 3624 

%QX n+85 3639 3638 3637 3636 3635 3634 3633 3632 

%QX n+86 3647 3646 3645 3644 3643 3642 3641 3640 
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5.2 Specifications 
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 Bit No. 

Address b7 b6 b5 b4 b3 b2 b1 b0 

%QX n+87 3655 3654 3653 3652 3651 3650 3649 3648 

%QX n+88 3663 3662 3661 3660 3659 3658 3657 3656 

%QX n+89 3671 3670 3669 3668 3667 3666 3665 3664 

%QX n+90 3679 3678 3677 3676 3675 3674 3673 3672 

%QX n+91 3687 3686 3685 3684 3683 3682 3681 3680 

%QX n+92 3695 3694 3693 3692 3691 3690 3689 3688 

%QX n+93 3703 3702 3701 3700 3699 3698 3697 3696 

%QX n+94 3711 3710 3709 3708 3707 3706 3705 3704 

%QX n+95 3719 3718 3717 3716 3715 3714 3713 3712 

%QX n+96 3727 3726 3725 3724 3723 3722 3721 3720 

%QX n+97 3735 3734 3733 3732 3731 3730 3729 3728 

%QX n+98 3743 3742 3741 3740 3739 3738 3737 3736 

%QX n+99 3751 3750 3749 3748 3747 3746 3745 3744 

%QX n+100 3759 3758 3757 3756 3755 3754 3753 3752 

%QX n+101 3767 3766 3765 3764 3763 3762 3761 3760 

%QX n+102 3775 3774 3773 3772 3771 3770 3769 3768 

%QX n+103 3783 3782 3781 3780 3779 3778 3777 3776 

%QX n+104 3791 3790 3789 3788 3787 3786 3785 3784 

%QX n+105 3799 3798 3797 3796 3795 3794 3793 3792 

%QX n+106 3807 3806 3805 3804 3803 3802 3801 3800 

%QX n+107 3815 3814 3813 3812 3811 3810 3809 3808 

%QX n+108 3823 3822 3821 3820 3819 3818 3817 3816 

%QX n+109 3831 3830 3829 3828 3827 3826 3825 3824 

%QX n+110 3839 3838 3837 3836 3835 3834 3833 3832 

%QX n+111 3847 3846 3845 3844 3843 3842 3841 3840 

%QX n+112 3855 3854 3853 3852 3851 3850 3849 3848 

%QX n+113 3863 3862 3861 3860 3859 3858 3857 3856 

%QX n+114 3871 3870 3869 3868 3867 3866 3865 3864 

%QX n+115 3879 3878 3877 3876 3875 3874 3873 3872 

%QX n+116 3887 3886 3885 3884 3883 3882 3881 3880 

%QX n+117 3895 3894 3893 3892 3891 3890 3889 3888 

%QX n+118 3903 3902 3901 3900 3899 3898 3897 3896 

%QX n+119 3911 3910 3909 3908 3907 3906 3905 3904 

%QX n+120 3919 3918 3917 3916 3915 3914 3913 3912 

%QX n+121 3927 3926 3925 3924 3923 3922 3921 3920 

%QX n+122 3935 3934 3933 3932 3931 3930 3929 3928 

%QX n+123 3943 3942 3941 3940 3939 3938 3937 3936 

%QX n+124 3951 3950 3949 3948 3947 3946 3945 3944 

%QX n+125 3959 3958 3957 3956 3955 3954 3953 3952 

%QX n+126 3967 3966 3965 3964 3963 3962 3961 3960 

%QX n+127 3975 3974 3973 3972 3971 3970 3969 3968 
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 Bit No. 

Address b7 b6 b5 b4 b3 b2 b1 b0 

%QX n+87 3655 3654 3653 3652 3651 3650 3649 3648 

%QX n+88 3663 3662 3661 3660 3659 3658 3657 3656 

%QX n+89 3671 3670 3669 3668 3667 3666 3665 3664 

%QX n+90 3679 3678 3677 3676 3675 3674 3673 3672 

%QX n+91 3687 3686 3685 3684 3683 3682 3681 3680 

%QX n+92 3695 3694 3693 3692 3691 3690 3689 3688 

%QX n+93 3703 3702 3701 3700 3699 3698 3697 3696 

%QX n+94 3711 3710 3709 3708 3707 3706 3705 3704 

%QX n+95 3719 3718 3717 3716 3715 3714 3713 3712 

%QX n+96 3727 3726 3725 3724 3723 3722 3721 3720 

%QX n+97 3735 3734 3733 3732 3731 3730 3729 3728 

%QX n+98 3743 3742 3741 3740 3739 3738 3737 3736 

%QX n+99 3751 3750 3749 3748 3747 3746 3745 3744 

%QX n+100 3759 3758 3757 3756 3755 3754 3753 3752 

%QX n+101 3767 3766 3765 3764 3763 3762 3761 3760 

%QX n+102 3775 3774 3773 3772 3771 3770 3769 3768 

%QX n+103 3783 3782 3781 3780 3779 3778 3777 3776 

%QX n+104 3791 3790 3789 3788 3787 3786 3785 3784 

%QX n+105 3799 3798 3797 3796 3795 3794 3793 3792 

%QX n+106 3807 3806 3805 3804 3803 3802 3801 3800 

%QX n+107 3815 3814 3813 3812 3811 3810 3809 3808 

%QX n+108 3823 3822 3821 3820 3819 3818 3817 3816 

%QX n+109 3831 3830 3829 3828 3827 3826 3825 3824 

%QX n+110 3839 3838 3837 3836 3835 3834 3833 3832 

%QX n+111 3847 3846 3845 3844 3843 3842 3841 3840 

%QX n+112 3855 3854 3853 3852 3851 3850 3849 3848 

%QX n+113 3863 3862 3861 3860 3859 3858 3857 3856 

%QX n+114 3871 3870 3869 3868 3867 3866 3865 3864 

%QX n+115 3879 3878 3877 3876 3875 3874 3873 3872 

%QX n+116 3887 3886 3885 3884 3883 3882 3881 3880 

%QX n+117 3895 3894 3893 3892 3891 3890 3889 3888 

%QX n+118 3903 3902 3901 3900 3899 3898 3897 3896 

%QX n+119 3911 3910 3909 3908 3907 3906 3905 3904 

%QX n+120 3919 3918 3917 3916 3915 3914 3913 3912 

%QX n+121 3927 3926 3925 3924 3923 3922 3921 3920 

%QX n+122 3935 3934 3933 3932 3931 3930 3929 3928 

%QX n+123 3943 3942 3941 3940 3939 3938 3937 3936 

%QX n+124 3951 3950 3949 3948 3947 3946 3945 3944 

%QX n+125 3959 3958 3957 3956 3955 3954 3953 3952 

%QX n+126 3967 3966 3965 3964 3963 3962 3961 3960 

%QX n+127 3975 3974 3973 3972 3971 3970 3969 3968 

 
5.3 SEL System Feature Setup 
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5.3 SEL System Feature Setup 

 
 
5.3.1 Adding SEL Interface Device 
 
Referring to [4.4 Add I/O Device Structure], a SEL interface device should be added. 
 

 
5.3.2 Setting up SEL Parameters, etc. 
 
By connecting a teaching tool (XSEL PC teaching software or teaching pendant), it is necessary to 
set up parameters and settings. 
For details on the SEL parameter, refer to the separate volume [XSEL2 controller Instruction 
Manual]. 
 

[1] Additional Setup to Assign Dedicated Signal Features 
 
The SEL input and output port numbers for the input and output feature select signals, zones, simple 
interference check zones and XSEL I/O output setting should be assigned to the following ports that 
are in mirroring with PLC. 
 
 Input Port Numbers: #2952 to #3975 
 Output Port Numbers: #5952 to #6975 

 
But setting up this, mirroring of the software PLC input and output memories should be established to 
the SEL input and output ports. 
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Example 1) When inputting READY Signal of SEL to %IWn.0 of PLC 
 

1) Check the SEL input and output port numbers in response to the PLC input and output memory 
addresses. 
The SEL output port number equivalent to %IWn.0 should be #5952. 

 
2) Setup to input and output the applicable signals to the SEL system should be established. 

Set it up as follows so READY Signal outputs Output Feature Select 301 of the I/O parameters 
from Output Port Number 5952. 

 
 I/O parameter 

No. Parameter name 
Set 

Value Input range Unit Remarks 

47 
Output Feature 
Select 301 

1 0 to 20 - 

0: Universal output 
1: READY output 

(PIO trigger program operation available) 
2: READY output 

(PIO trigger program operation available and without 
occurrence of any error at the operation cancellation level 
or more) 

3: READY output 
(PIO trigger program operation available, and without 
occurrence of any error at the cold start level or more) 

 
Note: 

The port number assigned to this function can be changed 
using I/O Parameter No. 300 “Port number assigned to 
output feature selection 301”. 

301 

Port number 
assigned to output 
feature selection 
301 

5952 
0, 

300 to 599 
4000 to 6999 

- 

Specify the port number to be assigned to the function of I/O 
Parameter No. 47, “Output feature selection 301”. 
* If “0” is set, the function will be assigned to output port No. 

310. 
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Example 1) When inputting READY Signal of SEL to %IWn.0 of PLC 
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The SEL output port number equivalent to %IWn.0 should be #5952. 

 
2) Setup to input and output the applicable signals to the SEL system should be established. 

Set it up as follows so READY Signal outputs Output Feature Select 301 of the I/O parameters 
from Output Port Number 5952. 
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No. Parameter name 
Set 

Value Input range Unit Remarks 

47 
Output Feature 
Select 301 

1 0 to 20 - 

0: Universal output 
1: READY output 

(PIO trigger program operation available) 
2: READY output 

(PIO trigger program operation available and without 
occurrence of any error at the operation cancellation level 
or more) 

3: READY output 
(PIO trigger program operation available, and without 
occurrence of any error at the cold start level or more) 

 
Note: 

The port number assigned to this function can be changed 
using I/O Parameter No. 300 “Port number assigned to 
output feature selection 301”. 

301 

Port number 
assigned to output 
feature selection 
301 

5952 
0, 

300 to 599 
4000 to 6999 
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Specify the port number to be assigned to the function of I/O 
Parameter No. 47, “Output feature selection 301”. 
* If “0” is set, the function will be assigned to output port No. 

310. 
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Example 2) When Error Reset SEL with Rising Edge of QWn.1 in PLC 
 

1) Check the SEL input and output port numbers in response to the PLC input and output memory 
addresses. 
The SEL input port number equivalent to QWn.1 should be #2953. 
 

2) Setup to input and output the applicable signals to the SEL system should be established. 
Set it up as follows so the error reset signal inputs Input Feature Select 013 of the I/O parameters 
from Input Port Number 2977. 

 
 I/O parameter 

No. Parameter name 
Set 

Value Input range Unit Remarks 

43 
Input feature 
selection 013 

2 0 to 5 - 

0: General-purpose input 
1: Program number specified for program start 
2: Error reset (ON edge) 
 
Note:  

The assignment changes depending on the value set in 
“I/O Parameter No. 30, Input feature selection 000”. 

Reference:  
The port number assigned to this function can be 
changed using I/O Parameter No. 296, “Port number 
assigned to input feature selection 013”. 

296 

Port number 
assigned to input 
feature selection 
013 

2953 
-1, 

0 to 299 
1000 to 3999 

- 

Specify the port number to be assigned to the function of I/O 
Parameter No. 43, “Input feature selection 013”. 
* If a negative value is set, the function will be assigned to 

input port No. 13. 
* If “Program number specified for program start” has been 

specified for input feature selection 013, specify in this 
parameter an input port number whose LSB contains the 
next higher value to the LSB of the program number 
specified for program start. 
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[2] Additional Setting for External Input and Output from I/O Options 

 
1) Whether to use an I/O option board or not and to establish the input and output port number 

assignment should be performed. 
Referring to [XSEL2 Controller Instruction Manual (ME0478)], assign each I/O slot input and 
output port number. 
An I/O option board should be assigned in the port ranges below. 

 
 Input Port: 000 to 299, 1000 to2951 
 Output Port: 300 to 599, 4000 to 5951 

 
2) Setting to have the PLC use an I/O option board should be established. 
 

 Related PLC parameters 

No. Parameter name 
Set 

Value Input range Unit Remarks 

5 
I/O slot 1 
PLC Bridge Setting 

0 0 to 5 - 
0: Bridge Disabled 
1: Bridge Enabled 

6 
I/O slot 1  
PLC Bridge Top Offset 

0 0 to 63 - 
To be set up with top offset word address on software PLC side 
when bridge enabled 

7 
I/O slot 2  
PLC Bridge Setting 

0 0 to 5 - 
0: Bridge Disabled 
1: Bridge Enabled 

8 
I/O slot 2  
PLC Bridge Top Offset 

0 0 to 63 - 
To be set up with top offset word address on software PLC side 
when bridge enabled 
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[2] Additional Setting for External Input and Output from I/O Options 

 
1) Whether to use an I/O option board or not and to establish the input and output port number 

assignment should be performed. 
Referring to [XSEL2 Controller Instruction Manual (ME0478)], assign each I/O slot input and 
output port number. 
An I/O option board should be assigned in the port ranges below. 

 
 Input Port: 000 to 299, 1000 to2951 
 Output Port: 300 to 599, 4000 to 5951 

 
2) Setting to have the PLC use an I/O option board should be established. 
 

 Related PLC parameters 

No. Parameter name 
Set 

Value Input range Unit Remarks 

5 
I/O slot 1 
PLC Bridge Setting 

0 0 to 5 - 
0: Bridge Disabled 
1: Bridge Enabled 

6 
I/O slot 1  
PLC Bridge Top Offset 

0 0 to 63 - 
To be set up with top offset word address on software PLC side 
when bridge enabled 

7 
I/O slot 2  
PLC Bridge Setting 

0 0 to 5 - 
0: Bridge Disabled 
1: Bridge Enabled 

8 
I/O slot 2  
PLC Bridge Top Offset 

0 0 to 63 - 
To be set up with top offset word address on software PLC side 
when bridge enabled 
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Example 1) When PIO in I/O Slot 1 Used in PLC 

  
 PLC parameter 

No. Parameter name 
Set 

Value Input range Unit Remarks 

5 
I/O slot 1  
PLC Bridge Setting 

1 0 to 5 - 
0: Bridge Disabled 
1: Bridge Enabled 

6 
I/O slot 1  
PLC Bridge Top Offset 

2 0 to 63 - 
To be set up with top offset word address on software PLC side 
when bridge enabled 

 
When setting above is established, PIO signals should be assigned to: 
 %IW n+2 to 
 %QW n+2 to 

in PLC. 
At this time, the PLC input and output address “n” should automatically be assigned in CODESYS for 
XSEL2. The assigned value should vary depending on the order for being added in an I/O device. 
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Example 2) When CC-Link (Remote Device Station) in I/O Slot 2 Used in PLC 

  
 PLC parameter 

No. Parameter name 
Set 

Value Input range Unit Remarks 

7 
I/O slot 2  
PLC Bridge Setting 

0 0 to 5 - 
0: Bridge Disabled 
1: Bridge Enabled 

8 
I/O slot 2  
PLC Bridge Top Offset 

0 0 to 63 - 
To be set up with top offset word address on software PLC side 
when bridge enabled 

 
When setting above is established, CC-Link (Remote device station) signals should be assigned to: 
 %IW n+32 to 
 %QW n+32 to 

in PLC. 
At this time, the PLC input and output address “n” should automatically be assigned in CODESYS for 
XSEL2. The assigned value should vary depending on the order for being added in an I/O device. 
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Example 2) When CC-Link (Remote Device Station) in I/O Slot 2 Used in PLC 

  
 PLC parameter 

No. Parameter name 
Set 

Value Input range Unit Remarks 

7 
I/O slot 2  
PLC Bridge Setting 

0 0 to 5 - 
0: Bridge Disabled 
1: Bridge Enabled 

8 
I/O slot 2  
PLC Bridge Top Offset 

0 0 to 63 - 
To be set up with top offset word address on software PLC side 
when bridge enabled 

 
When setting above is established, CC-Link (Remote device station) signals should be assigned to: 
 %IW n+32 to 
 %QW n+32 to 

in PLC. 
At this time, the PLC input and output address “n” should automatically be assigned in CODESYS for 
XSEL2. The assigned value should vary depending on the order for being added in an I/O device. 
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5.3.3 PIO pin arrangement 
 
[1] 32 Input points, 16 Output points (Display of XSEL2 Mode Code: N1, P1) 

 
Pin 
No. 

Cable 
color 

Category 
Address 

Function 
Word Bit 

1 Brown-1 Power 
supply - - +24V input 

2 Red-1 

Input 

%IWm.0 %IXn.0 General purpose input 
3 Orange-1 %IWm.1 %IXn.1 General purpose input 
4 Yellow-1 %IWm.2 %IXn.2 General purpose input 
5 Green-1 %IWm.3 %IXn.3 General purpose input 
6 Blue-1 %IWm.4 %IXn.4 General purpose input 
7 Purple -1 %IWm.5 %IXn.5 General purpose input 
8 Gray-1 %IWm.6 %IXn.6 General purpose input 
9 White-1 %IWm.7 %IXn.7 General purpose input 

10 Black-1 %IWm.8 %IX(n+1).0 General purpose input 
11 Brown-2 %IWm.9 %IX(n+1).1 General purpose input 
12 Red-2 %IWm.10 %IX(n+1).2 General purpose input 
13 Orange-2 %IWm.11 %IX(n+1).3 General purpose input 
14 Yellow-2 %IWm.12 %IX(n+1).4 General purpose input 
15 Green-2 %IWm.13 %IX(n+1).5 General purpose input 
16 Blue-2 %IWm.14 %IX(n+1).6 General purpose input 
17 Purple-2 %IWm.15 %IX(n+1).7 General purpose input 
18 Gray-2 %IW(m+1).0 %IX(n+2).0 General purpose input 
19 White-2 %IW(m+1).1 %IX(n+2).1 General purpose input 
20 Black-2 %IW(m+1).2 %IX(n+2).2 General purpose input 
21 Brown-3 %IW(m+1).3 %IX(n+2).3 General purpose input 
22 Red-3 %IW(m+1).4 %IX(n+2).4 General purpose input 
23 Orange-3 %IW(m+1).5 %IX(n+2).5 General purpose input 
24 Yellow-3 %IW(m+1).6 %IX(n+2).6 General purpose input 
25 Green-3 %IW(m+1).7 %IX(n+2).7 General purpose input 
26 Blue-3 %IW(m+1).8 %IX(n+3).0 General purpose input 
27 Purple-3 %IW(m+1).9 %IX(n+3).1 General purpose input 
28 Gray-3 %IW(m+1).10 %IX(n+3).2 General purpose input 
29 White-3 %IW(m+1).11 %IX(n+3).3 General purpose input 
30 Black-3 %IW(m+1).12 %IX(n+3).4 General purpose input 
31 Brown-4 %IW(m+1).13 %IX(n+3).5 General purpose input 
32 Red-4 %IW(m+1).14 %IX(n+3).6 General purpose input 
33 Orange-4 %IW(m+1).15 %IX(n+3).7 General purpose input 
34 Yellow-4 

Output 

%QWm.0 %QXn.0 General purpose output 
35 Green-4 %QWm.1 %QXn.1 General purpose output 
36 Blue-4 %QWm.2 %QXn.2 General purpose output 
37 Purple-4 %QWm.3 %QXn.3 General purpose output 
38 Gray-4 %QWm.4 %QXn.4 General purpose output 
39 White-4 %QWm.5 %QXn.5 General purpose output 
40 Black-4 %QWm.6 %QXn.6 General purpose output 
41 Brown-5 %QWm.7 %QXn.7 General purpose output 
42 Red-5 %QWm.8 %QX(n+1).0 General purpose output 
43 Orange-5 %QWm.9 %QX(n+1).1 General purpose output 
44 Yellow-5 %QWm.10 %QX(n+1).2 General purpose output 
45 Green-5 %QWm.11 %QX(n+1).3 General purpose output 
46 Blue-5 %QWm.12 %QX(n+1).4 General purpose output 
47 Purple-5 %QWm.13 %QX(n+1).5 General purpose output 
48 Gray-5 %QWm.14 %QX(n+1).6 General purpose output 
49 White-5 %QWm.15 %QX(n+1).7 General purpose output 

50 Black-5 Power 
supply - - 0V 

Note In here, ”m” and “n” are the top addresses that input and output are to be assigned. 
They should automatically be assigned in CODESYS for XSEL2.  
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[2] 16 Input points, 32 Output points (Display of XSEL2 Mode Code: N2, P2) 

 
Pin 
No. 

Cable 
color 

Category 
Address 

Function 
Word Bit 

1 Brown-1 Power 
supply - - +24V Input 

2 Red-1 

Input 

%IWm.0 %IXn.0 General purpose input 
3 Orange-1 %IWm.1 %IXn.1 General purpose input 
4 Yellow-1 %IWm.2 %IXn.2 General purpose input 
5 Green-1 %IWm.3 %IXn.3 General purpose input 
6 Blue-1 %IWm.4 %IXn.4 General purpose input 
7 Purple-1 %IWm.5 %IXn.5 General purpose input 
8 Gray-1 %IWm.6 %IXn.6 General purpose input 
9 White-1 %IWm.7 %IXn.7 General purpose input 

10 Black-1 %IWm.8 %IX(n+1).0 General purpose input 
11 Brown-2 %IWm.9 %IX(n+1).1 General purpose input 
12 Red-2 %IWm.10 %IX(n+1).2 General purpose input 
13 Orange-2 %IWm.11 %IX(n+1).3 General purpose input 
14 Yellow-2 %IWm.12 %IX(n+1).4 General purpose input 
15 Green-2 %IWm.13 %IX(n+1).5 General purpose input 
16 Blue-2 %IWm.14 %IX(n+1).6 General purpose input 
17 Purple-2 %IWm.15 %IX(n+1).7 General purpose input 
18 Gray-2 

Output 

%QWm.0 %QXn.0 General purpose output 
19 White-2 %QWm.1 %QXn.1 General purpose output 
20 Black-2 %QWm.2 %QXn.2 General purpose output 
21 Brown-3 %QWm.3 %QXn.3 General purpose output 
22 Red-3 %QWm.4 %QXn.4 General purpose output 
23 Orange-3 %QWm.5 %QXn.5 General purpose output 
24 Yellow-3 %QWm.6 %QXn.6 General purpose output 
25 Green-3 %QWm.7 %QXn.7 General purpose output 
26 Blue-3 %QWm.8 %QX(n+1).0 General purpose output 
27 Purple-3 %QWm.9 %QX(n+1).1 General purpose output 
28 Gray-3 %QWm.10 %QX(n+1).2 General purpose output 
29 White-3 %QWm.11 %QX(n+1).3 General purpose output 
30 Black-3 %QWm.12 %QX(n+1).4 General purpose output 
31 Brown-4 %QWm.13 %QX(n+1).5 General purpose output 
32 Red-4 %QWm.14 %QX(n+1).6 General purpose output 
33 Orange-4 %QWm.15 %QX(n+1).7 General purpose output 
34 Yellow-4 %QW(m+1).0 %QX(n+2).0 General purpose output 
35 Green-4 %QW(m+1).1 %QX(n+2).1 General purpose output 
36 Blue-4 %QW(m+1).2 %QX(n+2).2 General purpose output 
37 Purple-4 %QW(m+1).3 %QX(n+2).3 General purpose output 
38 Gray-4 %QW(m+1).4 %QX(n+2).4 General purpose output 
39 White-4 %QW(m+1).5 %QX(n+2).5 General purpose output 
40 Black-4 %QW(m+1).6 %QX(n+2).6 General purpose output 
41 Brown-5 %QW(m+1).7 %QX(n+2).7 General purpose output 
42 Red-5 %QW(m+1).8 %QX(n+3).0 General purpose output 
43 Orange-5 %QW(m+1).9 %QX(n+3).1 General purpose output 
44 Yellow-5 %QW(m+1).10 %QX(n+3).2 General purpose output 
45 Green-5 %QW(m+1).11 %QX(n+3).3 General purpose output 
46 Blue-5 %QW(m+1).12 %QX(n+3).4 General purpose output 
47 Purple-5 %QW(m+1).13 %QX(n+3).5 General purpose output 
48 Gray-5 %QW(m+1).14 %QX(n+3).6 General purpose output 
49 White-5 %QW(m+1).15 %QX(n+3).7 General purpose output 

50 Black-5 Power 
supply - - 0V 

Note In here, ”m” and “n” are the top addresses that input and output are to be assigned. 
They should automatically be assigned in CODESYS for XSEL2. 
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[2] 16 Input points, 32 Output points (Display of XSEL2 Mode Code: N2, P2) 

 
Pin 
No. 

Cable 
color 

Category 
Address 

Function 
Word Bit 

1 Brown-1 Power 
supply - - +24V Input 

2 Red-1 

Input 

%IWm.0 %IXn.0 General purpose input 
3 Orange-1 %IWm.1 %IXn.1 General purpose input 
4 Yellow-1 %IWm.2 %IXn.2 General purpose input 
5 Green-1 %IWm.3 %IXn.3 General purpose input 
6 Blue-1 %IWm.4 %IXn.4 General purpose input 
7 Purple-1 %IWm.5 %IXn.5 General purpose input 
8 Gray-1 %IWm.6 %IXn.6 General purpose input 
9 White-1 %IWm.7 %IXn.7 General purpose input 

10 Black-1 %IWm.8 %IX(n+1).0 General purpose input 
11 Brown-2 %IWm.9 %IX(n+1).1 General purpose input 
12 Red-2 %IWm.10 %IX(n+1).2 General purpose input 
13 Orange-2 %IWm.11 %IX(n+1).3 General purpose input 
14 Yellow-2 %IWm.12 %IX(n+1).4 General purpose input 
15 Green-2 %IWm.13 %IX(n+1).5 General purpose input 
16 Blue-2 %IWm.14 %IX(n+1).6 General purpose input 
17 Purple-2 %IWm.15 %IX(n+1).7 General purpose input 
18 Gray-2 

Output 

%QWm.0 %QXn.0 General purpose output 
19 White-2 %QWm.1 %QXn.1 General purpose output 
20 Black-2 %QWm.2 %QXn.2 General purpose output 
21 Brown-3 %QWm.3 %QXn.3 General purpose output 
22 Red-3 %QWm.4 %QXn.4 General purpose output 
23 Orange-3 %QWm.5 %QXn.5 General purpose output 
24 Yellow-3 %QWm.6 %QXn.6 General purpose output 
25 Green-3 %QWm.7 %QXn.7 General purpose output 
26 Blue-3 %QWm.8 %QX(n+1).0 General purpose output 
27 Purple-3 %QWm.9 %QX(n+1).1 General purpose output 
28 Gray-3 %QWm.10 %QX(n+1).2 General purpose output 
29 White-3 %QWm.11 %QX(n+1).3 General purpose output 
30 Black-3 %QWm.12 %QX(n+1).4 General purpose output 
31 Brown-4 %QWm.13 %QX(n+1).5 General purpose output 
32 Red-4 %QWm.14 %QX(n+1).6 General purpose output 
33 Orange-4 %QWm.15 %QX(n+1).7 General purpose output 
34 Yellow-4 %QW(m+1).0 %QX(n+2).0 General purpose output 
35 Green-4 %QW(m+1).1 %QX(n+2).1 General purpose output 
36 Blue-4 %QW(m+1).2 %QX(n+2).2 General purpose output 
37 Purple-4 %QW(m+1).3 %QX(n+2).3 General purpose output 
38 Gray-4 %QW(m+1).4 %QX(n+2).4 General purpose output 
39 White-4 %QW(m+1).5 %QX(n+2).5 General purpose output 
40 Black-4 %QW(m+1).6 %QX(n+2).6 General purpose output 
41 Brown-5 %QW(m+1).7 %QX(n+2).7 General purpose output 
42 Red-5 %QW(m+1).8 %QX(n+3).0 General purpose output 
43 Orange-5 %QW(m+1).9 %QX(n+3).1 General purpose output 
44 Yellow-5 %QW(m+1).10 %QX(n+3).2 General purpose output 
45 Green-5 %QW(m+1).11 %QX(n+3).3 General purpose output 
46 Blue-5 %QW(m+1).12 %QX(n+3).4 General purpose output 
47 Purple-5 %QW(m+1).13 %QX(n+3).5 General purpose output 
48 Gray-5 %QW(m+1).14 %QX(n+3).6 General purpose output 
49 White-5 %QW(m+1).15 %QX(n+3).7 General purpose output 

50 Black-5 Power 
supply - - 0V 

Note In here, ”m” and “n” are the top addresses that input and output are to be assigned. 
They should automatically be assigned in CODESYS for XSEL2. 
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[3] 24 Input points, 24 Output Points (Display of XSEL2 Mode Code: N4, P4) 

 
Pin 
No. 

Cable 
color 

Category 
Address 

Function 
Word Bit 

1 Brown-1 Power 
supply - - +24V Input 

2 Red-1 

Input 

%IWm.0 %IXn.0 General purpose input 
3 Orange-1 %IWm.1 %IXn.1 General purpose input 
4 Yellow-1 %IWm.2 %IXn.2 General purpose input 
5 Green-1 %IWm.3 %IXn.3 General purpose input 
6 Blue-1 %IWm.4 %IXn.4 General purpose input 
7 Purple-1 %IWm.5 %IXn.5 General purpose input 
8 Gray-1 %IWm.6 %IXn.6 General purpose input 
9 White-1 %IWm.7 %IXn.7 General purpose input 

10 Black-1 %IWm.8 %IX(n+1).0 General purpose input 
11 Brown-2 %IWm.9 %IX(n+1).1 General purpose input 
12 Red-2 %IWm.10 %IX(n+1).2 General purpose input 
13 Orange-2 %IWm.11 %IX(n+1).3 General purpose input 
14 Yellow-2 %IWm.12 %IX(n+1).4 General purpose input 
15 Green-2 %IWm.13 %IX(n+1).5 General purpose input 
16 Blue-2 %IWm.14 %IX(n+1).6 General purpose input 
17 Purple-2 %IWm.15 %IX(n+1).7 General purpose input 
18 Gray-2 %IW(m+1).0 %IX(n+2).0 General purpose input 
19 White-2 %IW(m+1).1 %IX(n+2).1 General purpose input 
20 Black-2 %IW(m+1).2 %IX(n+2).2 General purpose input 
21 Brown-3 %IW(m+1).3 %IX(n+2).3 General purpose input 
22 Red-3 %IW(m+1).4 %IX(n+2).4 General purpose input 
23 Orange-3 %IW(m+1).5 %IX(n+2).5 General purpose input 
24 Yellow-3 %IW(m+1).6 %IX(n+2).6 General purpose input 
25 Green-3 %IW(m+1).7 %IX(n+2).7 General purpose input 
26 Blue-3 

Output 

%QWm.0 %QXn.0 General purpose output 
27 Purple-3 %QWm.1 %QXn.1 General purpose output 
28 Gray-3 %QWm.2 %QXn.2 General purpose output 
29 White-3 %QWm.3 %QXn.3 General purpose output 
30 Black-3 %QWm.4 %QXn.4 General purpose output 
31 Brown-4 %QWm.5 %QXn.5 General purpose output 
32 Red-4 %QWm.6 %QXn.6 General purpose output 
33 Orange-4 %QWm.7 %QXn.7 General purpose output 
34 Yellow-4 %QWm.8 %QX(n+1).0 General purpose output 
35 Green-4 %QWm.9 %QX(n+1).1 General purpose output 
36 Blue-4 %QWm.10 %QX(n+1).2 General purpose output 
37 Purple-4 %QWm.11 %QX(n+1).3 General purpose output 
38 Gray-4 %QWm.12 %QX(n+1).4 General purpose output 
39 White-4 %QWm.13 %QX(n+1).5 General purpose output 
40 Black-4 %QWm.14 %QX(n+1).6 General purpose output 
41 Brown-5 %QWm.15 %QX(n+1).7 General purpose output 
42 Red-5 %QW(m+1).0 %QX(n+2).0 General purpose output 
43 Orange-5 %QW(m+1).1 %QX(n+2).1 General purpose output 
44 Yellow-5 %QW(m+1).2 %QX(n+2).2 General purpose output 
45 Green-5 %QW(m+1).3 %QX(n+2).3 General purpose output 
46 Blue-5 %QW(m+1).4 %QX(n+2).4 General purpose output 
47 Purple-5 %QW(m+1).5 %QX(n+2).5 General purpose output 
48 Gray-5 %QW(m+1).6 %QX(n+2).6 General purpose output 
49 White-5 %QW(m+1).7 %QX(n+2).7 General purpose output 

50 Black-5 Power 
supply - - 0V 

Note In here, ”m” and “n” are the top addresses that input and output are to be assigned. 
They should automatically be assigned in CODESYS for XSEL2. 
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5.3 SEL System Feature Setup 

5-22 ME0479-1A 

 
[4] 16 Input points, 16 Output points (Display of XSEL2 Mode Code: NP, PN) 

 
Pin 
No. 

Cable 
color 

Category 
Address 

Function 
Word Bit 

1 Brown-1 Power 
supply 

- - +24V Input 
2 Red-1 - - +24V Input 
3 Orange-1 

NC 
- - Not connected 

4 Yellow-1 - - Not connected 
5 Green-1 

Input 

%IWm.0 %IXn.0 General purpose input 
6 Blue-1 %IWm.1 %IXn.1 General purpose input 
7 Purple-1 %IWm.2 %IXn.2 General purpose input 
8 Gray-1 %IWm.3 %IXn.3 General purpose input 
9 White-1 %IWm.4 %IXn.4 General purpose input 

10 Black-1 %IWm.5 %IXn.5 General purpose input 
11 Brown-2 %IWm.6 %IXn.6 General purpose input 
12 Red-2 %IWm.7 %IXn.7 General purpose input 
13 Orange-2 %IWm.8 %IX(n+1).0 General purpose input 
14 Yellow-2 %IWm.9 %IX(n+1).1 General purpose input 
15 Green-2 %IWm.10 %IX(n+1).2 General purpose input 
16 Blue-2 %IWm.11 %IX(n+1).3 General purpose input 
17 Purple-2 %IWm.12 %IX(n+1).4 General purpose input 
18 Gray-2 %IWm.13 %IX(n+1).5 General purpose input 
19 White-2 %IWm.14 %IX(n+1).6 General purpose input 
20 Black-2 %IWm.15 %IX(n+1).7 General purpose input 
21 Brown-3 

Output 

%QWm.0 %QXn.0 General purpose input 
22 Red-3 %QWm.1 %QXn.1 General purpose input 
23 Orange-3 %QWm.2 %QXn.2 General purpose input 
24 Yellow-3 %QWm.3 %QXn.3 General purpose input 
25 Green-3 %QWm.4 %QXn.4 General purpose input 
26 Blue-3 %QWm.5 %QXn.5 General purpose output 
27 Purple-3 %QWm.6 %QXn.6 General purpose output 
28 Gray-3 %QWm.7 %QXn.7 General purpose output 
29 White-3 %QWm.8 %QX(n+1).0 General purpose output 
30 Black-3 %QWm.9 %QX(n+1).1 General purpose output 
31 Brown-4 %QWm.10 %QX(n+1).2 General purpose output 
32 Red-4 %QWm.11 %QX(n+1).3 General purpose output 
33 Orange-4 %QWm.12 %QX(n+1).4 General purpose output 
34 Yellow-4 %QWm.13 %QX(n+1).5 General purpose output 
35 Green-4 %QWm.14 %QX(n+1).6 General purpose output 
36 Blue-4 %QWm.15 %QX(n+1).7 General purpose output 
37 Purple-4 

NC 
- - Not connected 

38 Gray-4 - - Not connected 
39 White-4 Power 

supply 
- - 0V 

40 Black-4 - - 0V 

Note In here, ”m” and “n” are the top addresses that input are to be assigned, “n” are the top 
addresses that output are to be assigned. They should automatically be assigned in 
CODESYS for XSEL2. 

  



5. SEL Interface Feature
 
5.3 SEL System Feature Setup 

5-22 ME0479-1A 

 
[4] 16 Input points, 16 Output points (Display of XSEL2 Mode Code: NP, PN) 

 
Pin 
No. 

Cable 
color 

Category 
Address 

Function 
Word Bit 

1 Brown-1 Power 
supply 

- - +24V Input 
2 Red-1 - - +24V Input 
3 Orange-1 

NC 
- - Not connected 

4 Yellow-1 - - Not connected 
5 Green-1 

Input 

%IWm.0 %IXn.0 General purpose input 
6 Blue-1 %IWm.1 %IXn.1 General purpose input 
7 Purple-1 %IWm.2 %IXn.2 General purpose input 
8 Gray-1 %IWm.3 %IXn.3 General purpose input 
9 White-1 %IWm.4 %IXn.4 General purpose input 

10 Black-1 %IWm.5 %IXn.5 General purpose input 
11 Brown-2 %IWm.6 %IXn.6 General purpose input 
12 Red-2 %IWm.7 %IXn.7 General purpose input 
13 Orange-2 %IWm.8 %IX(n+1).0 General purpose input 
14 Yellow-2 %IWm.9 %IX(n+1).1 General purpose input 
15 Green-2 %IWm.10 %IX(n+1).2 General purpose input 
16 Blue-2 %IWm.11 %IX(n+1).3 General purpose input 
17 Purple-2 %IWm.12 %IX(n+1).4 General purpose input 
18 Gray-2 %IWm.13 %IX(n+1).5 General purpose input 
19 White-2 %IWm.14 %IX(n+1).6 General purpose input 
20 Black-2 %IWm.15 %IX(n+1).7 General purpose input 
21 Brown-3 

Output 

%QWm.0 %QXn.0 General purpose input 
22 Red-3 %QWm.1 %QXn.1 General purpose input 
23 Orange-3 %QWm.2 %QXn.2 General purpose input 
24 Yellow-3 %QWm.3 %QXn.3 General purpose input 
25 Green-3 %QWm.4 %QXn.4 General purpose input 
26 Blue-3 %QWm.5 %QXn.5 General purpose output 
27 Purple-3 %QWm.6 %QXn.6 General purpose output 
28 Gray-3 %QWm.7 %QXn.7 General purpose output 
29 White-3 %QWm.8 %QX(n+1).0 General purpose output 
30 Black-3 %QWm.9 %QX(n+1).1 General purpose output 
31 Brown-4 %QWm.10 %QX(n+1).2 General purpose output 
32 Red-4 %QWm.11 %QX(n+1).3 General purpose output 
33 Orange-4 %QWm.12 %QX(n+1).4 General purpose output 
34 Yellow-4 %QWm.13 %QX(n+1).5 General purpose output 
35 Green-4 %QWm.14 %QX(n+1).6 General purpose output 
36 Blue-4 %QWm.15 %QX(n+1).7 General purpose output 
37 Purple-4 

NC 
- - Not connected 

38 Gray-4 - - Not connected 
39 White-4 Power 

supply 
- - 0V 

40 Black-4 - - 0V 

Note In here, ”m” and “n” are the top addresses that input are to be assigned, “n” are the top 
addresses that output are to be assigned. They should automatically be assigned in 
CODESYS for XSEL2. 

  

 
5.3 SEL System Feature Setup 

ME0479-1A 5-23 

 
[5] Remote I/O unit (Model: EIOU-1) 

 
 Input specifications 

 

SA Rotary 
Switch Setting Pin No. Cable 

color 
Address 

Function 
Word Bit 

0 

1A Brown-1 - - NC 
2A Red-1 - - NC 
3A Orange-1 - - NC 
4A Yellow-1 - - NC 
5A Green-1 %IWm.0 %IXn.0 General purpose input 
6A Blue-1 %IWm.1 %IXn.1 General purpose input 
7A Purple-1 %IWm.2 %IXn.2 General purpose input 
8A Gray-1 %IWm.3 %IXn.3 General purpose input 
9A White-1 %IWm.4 %IXn.4 General purpose input 

10A Black-1 %IWm.5 %IXn.5 General purpose input 
11A Brown-2 %IWm.6 %IXn.6 General purpose input 
12A Red-2 %IWm.7 %IXn.7 General purpose input 
13A Orange-2 %IWm.8 %IX(n+1).0 General purpose input 
14A Yellow-2 %IWm.9 %IX(n+1).1 General purpose input 
15A Green-2 %IWm.10 %IX(n+1).2 General purpose input 
16A Blue-2 %IWm.11 %IX(n+1).3 General purpose input 
17A Purple-2 %IWm.12 %IX(n+1).4 General purpose input 
18A Gray-2 %IWm.13 %IX(n+1).5 General purpose input 
19A White-2 %IWm.14 %IX(n+1).6 General purpose input 
20A Black-2 %IWm.15 %IX(n+1).7 General purpose input 
1B Brown-3 %IW(m+1).0 %IX(n+2).0 General purpose input 
2B Red-3 %IW(m+1).1 %IX(n+2).1 General purpose input 
3B Orange-3 %IW(m+1).2 %IX(n+2).2 General purpose input 
4B Yellow-3 %IW(m+1).3 %IX(n+2).3 General purpose input 
5B Green-3 %IW(m+1).4 %IX(n+2).4 General purpose input 
6B Blue-3 %IW(m+1).5 %IX(n+2).5 General purpose input 
7B Purple-3 %IW(m+1).6 %IX(n+2).6 General purpose input 
8B Gray-3 %IW(m+1).7 %IX(n+2).7 General purpose input 
9B White-3 %IW(m+1).8 %IX(n+3).0 General purpose input 

10B Black-3 %IW(m+1).9 %IX(n+3).1 General purpose input 
11B Brown-4 %IW(m+1).10 %IX(n+3).2 General purpose input 
12B Red-4 %IW(m+1).11 %IX(n+3).3 General purpose input 
13B Orange-4 %IW(m+1).12 %IX(n+3).4 General purpose input 
14B Yellow-4 %IW(m+1).13 %IX(n+3).5 General purpose input 
15B Green-4 %IW(m+1).14 %IX(n+3).6 General purpose input 
16B Blue-4 %IW(m+1).15 %IX(n+3).7 General purpose input 
17B Purple-4 - - NC 
18B Gray-4 - - NC 
19B White-4 - - NC 
20B Black-4 - - NC 
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5.3 SEL System Feature Setup 

5-24 ME0479-1A 

SA Rotary 
Switch Setting Pin No. Cable 

color 
Address 

Function 
Word Bit 

1 

1A Brown-1 - - NC 
2A Red-1 - - NC 
3A Orange-1 - - NC 
4A Yellow-1 - - NC 
5A Green-1 %IW(m+2).0 %IX(n+4).0 General purpose input 
6A Blue-1 %IW(m+2).1 %IX(n+4).1 General purpose input 
7A Purple-1 %IW(m+2).2 %IX(n+4).2 General purpose input 
8A Gray-1 %IW(m+2).3 %IX(n+4).3 General purpose input 
9A White-1 %IW(m+2).4 %IX(n+4).4 General purpose input 

10A Black-1 %IW(m+2).5 %IX(n+4).5 General purpose input 
11A Brown-2 %IW(m+2).6 %IX(n+3).6 General purpose input 
12A Red-2 %IW(m+2).7 %IX(n+4).7 General purpose input 
13A Orange-2 %IW(m+2).8 %IX(n+5).0 General purpose input 
14A Yellow-2 %IW(m+2).9 %IX(n+5).1 General purpose input 
15A Green-2 %IW(m+2).10 %IX(n+5).2 General purpose input 
16A Blue-2 %IW(m+2).11 %IX(n+5).3 General purpose input 
17A Purple-2 %IW(m+2).12 %IX(n+5).4 General purpose input 
18A Gray-2 %IW(m+2).13 %IX(n+5).5 General purpose input 
19A White-2 %IW(m+2).14 %IX(n+5).6 General purpose input 
20A Black-2 %IW(m+2).15 %IX(n+5).7 General purpose input 
1B Brown-3 %IW(m+3).0 %IX(n+6).0 General purpose input 
2B Red-3 %IW(m+3).1 %IX(n+6).1 General purpose input 
3B Orange-3 %IW(m+3).2 %IX(n+6).2 General purpose input 
4B Yellow-3 %IW(m+3).3 %IX(n+6).3 General purpose input 
5B Green-3 %IW(m+3).4 %IX(n+6).4 General purpose input 
6B Blue-3 %IW(m+3).5 %IX(n+6).5 General purpose input 
7B Purple-3 %IW(m+3).6 %IX(n+6).6 General purpose input 
8B Gray-3 %IW(m+3).7 %IX(n+6).7 General purpose input 
9B White-3 %IW(m+3).8 %IX(n+7).0 General purpose input 

10B Black-3 %IW(m+3).9 %IX(n+7).1 General purpose input 
11B Brown-4 %IW(m+3).10 %IX(n+7).2 General purpose input 
12B Red-4 %IW(m+3).11 %IX(n+7).3 General purpose input 
13B Orange-4 %IW(m+3).12 %IX(n+7).4 General purpose input 
14B Yellow-4 %IW(m+3).13 %IX(n+7).5 General purpose input 
15B Green-4 %IW(m+3).14 %IX(n+7).6 General purpose input 
16B Blue-4 %IW(m+3).15 %IX(n+7).7 General purpose input 
17B Purple-4 - - NC 
18B Gray-4 - - NC 
19B White-4 - - NC 
20B Black-4 - - NC 

: : : : :  

: : : : :  



5. SEL Interface Feature
 
5.3 SEL System Feature Setup 

5-24 ME0479-1A 

SA Rotary 
Switch Setting Pin No. Cable 

color 
Address 

Function 
Word Bit 

1 

1A Brown-1 - - NC 
2A Red-1 - - NC 
3A Orange-1 - - NC 
4A Yellow-1 - - NC 
5A Green-1 %IW(m+2).0 %IX(n+4).0 General purpose input 
6A Blue-1 %IW(m+2).1 %IX(n+4).1 General purpose input 
7A Purple-1 %IW(m+2).2 %IX(n+4).2 General purpose input 
8A Gray-1 %IW(m+2).3 %IX(n+4).3 General purpose input 
9A White-1 %IW(m+2).4 %IX(n+4).4 General purpose input 

10A Black-1 %IW(m+2).5 %IX(n+4).5 General purpose input 
11A Brown-2 %IW(m+2).6 %IX(n+3).6 General purpose input 
12A Red-2 %IW(m+2).7 %IX(n+4).7 General purpose input 
13A Orange-2 %IW(m+2).8 %IX(n+5).0 General purpose input 
14A Yellow-2 %IW(m+2).9 %IX(n+5).1 General purpose input 
15A Green-2 %IW(m+2).10 %IX(n+5).2 General purpose input 
16A Blue-2 %IW(m+2).11 %IX(n+5).3 General purpose input 
17A Purple-2 %IW(m+2).12 %IX(n+5).4 General purpose input 
18A Gray-2 %IW(m+2).13 %IX(n+5).5 General purpose input 
19A White-2 %IW(m+2).14 %IX(n+5).6 General purpose input 
20A Black-2 %IW(m+2).15 %IX(n+5).7 General purpose input 
1B Brown-3 %IW(m+3).0 %IX(n+6).0 General purpose input 
2B Red-3 %IW(m+3).1 %IX(n+6).1 General purpose input 
3B Orange-3 %IW(m+3).2 %IX(n+6).2 General purpose input 
4B Yellow-3 %IW(m+3).3 %IX(n+6).3 General purpose input 
5B Green-3 %IW(m+3).4 %IX(n+6).4 General purpose input 
6B Blue-3 %IW(m+3).5 %IX(n+6).5 General purpose input 
7B Purple-3 %IW(m+3).6 %IX(n+6).6 General purpose input 
8B Gray-3 %IW(m+3).7 %IX(n+6).7 General purpose input 
9B White-3 %IW(m+3).8 %IX(n+7).0 General purpose input 

10B Black-3 %IW(m+3).9 %IX(n+7).1 General purpose input 
11B Brown-4 %IW(m+3).10 %IX(n+7).2 General purpose input 
12B Red-4 %IW(m+3).11 %IX(n+7).3 General purpose input 
13B Orange-4 %IW(m+3).12 %IX(n+7).4 General purpose input 
14B Yellow-4 %IW(m+3).13 %IX(n+7).5 General purpose input 
15B Green-4 %IW(m+3).14 %IX(n+7).6 General purpose input 
16B Blue-4 %IW(m+3).15 %IX(n+7).7 General purpose input 
17B Purple-4 - - NC 
18B Gray-4 - - NC 
19B White-4 - - NC 
20B Black-4 - - NC 

: : : : :  

: : : : :  

 
5.3 SEL System Feature Setup 

ME0479-1A 5-25 

SA Rotary 
Switch Setting Pin No. Cable 

color 
Address 

Function 
Word Bit 

7 

1A Brown-1 - - NC 
2A Red-1 - - NC 
3A Orange-1 - - NC 
4A Yellow-1 - - NC 
5A Green-1 %IW(m+14).0 %IX(n+28).0 General purpose input 
6A Blue-1 %IW(m+14).1 %IX(n+28).1 General purpose input 
7A Purple-1 %IW(m+14).2 %IX(n+28).2 General purpose input 
8A Gray-1 %IW(m+14).3 %IX(n+28).3 General purpose input 
9A White-1 %IW(m+14).4 %IX(n+28).4 General purpose input 

10A Black-1 %IW(m+14).5 %IX(n+28).5 General purpose input 
11A Brown-2 %IW(m+14).6 %IX(n+28).6 General purpose input 
12A Red-2 %IW(m+14).7 %IX(n+28).7 General purpose input 
13A Orange-2 %IW(m+14).8 %IX(n+29).0 General purpose input 
14A Yellow-2 %IW(m+14).9 %IX(n+29).1 General purpose input 
15A Green-2 %IW(m+14).10 %IX(n+29).2 General purpose input 
16A Blue-2 %IW(m+14).11 %IX(n+29).3 General purpose input 
17A Purple-2 %IW(m+14).12 %IX(n+29).4 General purpose input 
18A Gray-2 %IW(m+14).13 %IX(n+29).5 General purpose input 
19A White-2 %IW(m+14).14 %IX(n+29).6 General purpose input 
20A Black-2 %IW(m+14).15 %IX(n+29).7 General purpose input 
1B Brown-3 %IW(m+15).0 %IX(n+30).0 General purpose input 
2B Red-3 %IW(m+15).1 %IX(n+30).1 General purpose input 
3B Orange-3 %IW(m+15).2 %IX(n+30).2 General purpose input 
4B Yellow-3 %IW(m+15).3 %IX(n+30).3 General purpose input 
5B Green-3 %IW(m+15).4 %IX(n+30).4 General purpose input 
6B Blue-3 %IW(m+15).5 %IX(n+30).5 General purpose input 
7B Purple-3 %IW(m+15).6 %IX(n+30).6 General purpose input 
8B Gray-3 %IW(m+15).7 %IX(n+30).7 General purpose input 
9B White-3 %IW(m+15).8 %IX(n+31).0 General purpose input 

10B Black-3 %IW(m+15).9 %IX(n+31).1 General purpose input 
11B Brown-4 %IW(m+15).10 %IX(n+31).2 General purpose input 
12B Red-4 %IW(m+15).11 %IX(n+31).3 General purpose input 
13B Orange-4 %IW(m+15).12 %IX(n+31).4 General purpose input 
14B Yellow-4 %IW(m+15).13 %IX(n+31).5 General purpose input 
15B Green-4 %IW(m+15).14 %IX(n+31).6 General purpose input 
16B Blue-4 %IW(m+15).15 %IX(n+31).7 General purpose input 
17B Purple-4 - - NC 
18B Gray-4 - - NC 
19B White-4 - - NC 
20B Black-4 - - NC 

Note In here, “m” and “n” are the top addresses that input are to be assigned. 
They should automatically be assigned in CODESYS for XSEL2. 
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5.3 SEL System Feature Setup 

5-26 ME0479-1A 

 
 Output specifications 

 

SA Rotary 
Switch Setting Pin No. Cable 

color 
Address 

Function 
Word Bit 

0 

1A Brown-1 - - NC 
2A Red-1 - - NC 
3A Orange-1 - - NC 
4A Yellow-1 - - NC 
5A Green-1 %QWm.0 %QXn.0 General purpose output 
6A Blue-1 %QWm.1 %QXn.1 General purpose output 
7A Purple-1 %QWm.2 %QXn.2 General purpose output 
8A Gray-1 %QWm.3 %QXn.3 General purpose output 
9A White-1 %QWm.4 %QXn.4 General purpose output 

10A Black-1 %QWm.5 %QXn.5 General purpose output 
11A Brown-2 %QWm.6 %QXn.6 General purpose output 
12A Red-2 %QWm.7 %QXn.7 General purpose output 
13A Orange-2 %QWm.8 %QX(n+1).0 General purpose output 
14A Yellow-2 %QWm.9 %QX(n+1).1 General purpose output 
15A Green-2 %QWm.10 %QX(n+1).2 General purpose output 
16A Blue-2 %QWm.11 %QX(n+1).3 General purpose output 
17A Purple-2 %QWm.12 %QX(n+1).4 General purpose output 
18A Gray-2 %QWm.13 %QX(n+1).5 General purpose output 
19A White-2 %QWm.14 %QX(n+1).6 General purpose output 
20A Black-2 %QWm.15 %QX(n+1).7 General purpose output 
1B Brown-3 %QW(m+1).0 %QX(n+2).0 General purpose output 
2B Red-3 %QW(m+1).1 %QX(n+2).1 General purpose output 
3B Orange-3 %QW(m+1).2 %QX(n+2).2 General purpose output 
4B Yellow-3 %QW(m+1).3 %QX(n+2).3 General purpose output 
5B Green-3 %QW(m+1).4 %QX(n+2).4 General purpose output 
6B Blue-3 %QW(m+1).5 %QX(n+2).5 General purpose output 
7B Purple-3 %QW(m+1).6 %QX(n+2).6 General purpose output 
8B Gray-3 %QW(m+1).7 %QX(n+2).7 General purpose output 
9B White-3 %QW(m+1).8 %QX(n+3).0 General purpose output 

10B Black-3 %QW(m+1).9 %QX(n+3).1 General purpose output 
11B Brown-4 %QW(m+1).10 %QX(n+3).2 General purpose output 
12B Red-4 %QW(m+1).11 %QX(n+3).3 General purpose output 
13B Orange-4 %QW(m+1).12 %QX(n+3).4 General purpose output 
14B Yellow-4 %QW(m+1).13 %QX(n+3).5 General purpose output 
15B Green-4 %QW(m+1).14 %QX(n+3).6 General purpose output 
16B Blue-4 %QW(m+1).15 %QX(n+3).7 General purpose output 
17B Purple-4 - - NC 
18B Gray-4 - - NC 
19B White-4 - - NC 
20B Black-4 - - NC 



5. SEL Interface Feature
 
5.3 SEL System Feature Setup 

5-26 ME0479-1A 

 
 Output specifications 

 

SA Rotary 
Switch Setting Pin No. Cable 

color 
Address 

Function 
Word Bit 

0 

1A Brown-1 - - NC 
2A Red-1 - - NC 
3A Orange-1 - - NC 
4A Yellow-1 - - NC 
5A Green-1 %QWm.0 %QXn.0 General purpose output 
6A Blue-1 %QWm.1 %QXn.1 General purpose output 
7A Purple-1 %QWm.2 %QXn.2 General purpose output 
8A Gray-1 %QWm.3 %QXn.3 General purpose output 
9A White-1 %QWm.4 %QXn.4 General purpose output 

10A Black-1 %QWm.5 %QXn.5 General purpose output 
11A Brown-2 %QWm.6 %QXn.6 General purpose output 
12A Red-2 %QWm.7 %QXn.7 General purpose output 
13A Orange-2 %QWm.8 %QX(n+1).0 General purpose output 
14A Yellow-2 %QWm.9 %QX(n+1).1 General purpose output 
15A Green-2 %QWm.10 %QX(n+1).2 General purpose output 
16A Blue-2 %QWm.11 %QX(n+1).3 General purpose output 
17A Purple-2 %QWm.12 %QX(n+1).4 General purpose output 
18A Gray-2 %QWm.13 %QX(n+1).5 General purpose output 
19A White-2 %QWm.14 %QX(n+1).6 General purpose output 
20A Black-2 %QWm.15 %QX(n+1).7 General purpose output 
1B Brown-3 %QW(m+1).0 %QX(n+2).0 General purpose output 
2B Red-3 %QW(m+1).1 %QX(n+2).1 General purpose output 
3B Orange-3 %QW(m+1).2 %QX(n+2).2 General purpose output 
4B Yellow-3 %QW(m+1).3 %QX(n+2).3 General purpose output 
5B Green-3 %QW(m+1).4 %QX(n+2).4 General purpose output 
6B Blue-3 %QW(m+1).5 %QX(n+2).5 General purpose output 
7B Purple-3 %QW(m+1).6 %QX(n+2).6 General purpose output 
8B Gray-3 %QW(m+1).7 %QX(n+2).7 General purpose output 
9B White-3 %QW(m+1).8 %QX(n+3).0 General purpose output 

10B Black-3 %QW(m+1).9 %QX(n+3).1 General purpose output 
11B Brown-4 %QW(m+1).10 %QX(n+3).2 General purpose output 
12B Red-4 %QW(m+1).11 %QX(n+3).3 General purpose output 
13B Orange-4 %QW(m+1).12 %QX(n+3).4 General purpose output 
14B Yellow-4 %QW(m+1).13 %QX(n+3).5 General purpose output 
15B Green-4 %QW(m+1).14 %QX(n+3).6 General purpose output 
16B Blue-4 %QW(m+1).15 %QX(n+3).7 General purpose output 
17B Purple-4 - - NC 
18B Gray-4 - - NC 
19B White-4 - - NC 
20B Black-4 - - NC 
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SA Rotary 
Switch Setting Pin No. Cable 

color 
Address 

Function 
Word Bit 

1 

1A Brown-1 - - NC 
2A Red-1 - - NC 
3A Orange-1 - - NC 
4A Yellow-1 - - NC 
5A Green-1 %QW(m+2).0 %QX(n+4).0 General purpose output 
6A Blue-1 %QW(m+2).1 %QX(n+4).1 General purpose output 
7A Purple-1 %QW(m+2).2 %QX(n+4).2 General purpose output 
8A Gray-1 %QW(m+2).3 %QX(n+4).3 General purpose output 
9A White-1 %QW(m+2).4 %QX(n+4).4 General purpose output 

10A Black-1 %QW(m+2).5 %QX(n+4).5 General purpose output 
11A Brown-2 %QW(m+2).6 %QX(n+4).6 General purpose output 
12A Red-2 %QW(m+2).7 %QX(n+4).7 General purpose output 
13A Orange-2 %QW(m+2).8 %QX(n+5).0 General purpose output 
14A Yellow-2 %QW(m+2).9 %QX(n+5).1 General purpose output 
15A Green-2 %QW(m+2).10 %QX(n+5).2 General purpose output 
16A Blue-2 %QW(m+2).11 %QX(n+5).3 General purpose output 
17A Purple-2 %QW(m+2).12 %QX(n+5).4 General purpose output 
18A Gray-2 %QW(m+2).13 %QX(n+5).5 General purpose output 
19A White-2 %QW(m+2).14 %QX(n+5).6 General purpose output 
20A Black-2 %QW(m+2).15 %QX(n+5).7 General purpose output 
1B Brown-3 %QW(m+3).0 %QX(n+6).0 General purpose output 
2B Red-3 %QW(m+3).1 %QX(n+6).1 General purpose output 
3B Orange-3 %QW(m+3).2 %QX(n+6).2 General purpose output 
4B Yellow-3 %QW(m+3).3 %QX(n+6).3 General purpose output 
5B Green-3 %QW(m+3).4 %QX(n+6).4 General purpose output 
6B Blue-3 %QW(m+3).5 %QX(n+6).5 General purpose output 
7B Purple-3 %QW(m+3).6 %QX(n+6).6 General purpose output 
8B Gray-3 %QW(m+3).7 %QX(n+6).7 General purpose output 
9B White-3 %QW(m+3).8 %QX(n+7).0 General purpose output 

10B Black-3 %QW(m+3).9 %QX(n+7).1 General purpose output 
11B Brown-4 %QW(m+3).10 %QX(n+7).2 General purpose output 
12B Red-4 %QW(m+3).11 %QX(n+7).3 General purpose output 
13B Orange-4 %QW(m+3).12 %QX(n+7).4 General purpose output 
14B Yellow-4 %QW(m+3).13 %QX(n+7).5 General purpose output 
15B Green-4 %QW(m+3).14 %QX(n+7).6 General purpose output 
16B Blue-4 %QW(m+3).15 %QX(n+7).7 General purpose output 
17B Purple-4 - - NC 
18B Gray-4 - - NC 
19B White-4 - - NC 
20B Black-4 - - NC 

: : : : :  
: : : : :  
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SA Rotary 
Switch Setting Pin No. Cable 

color 
Address 

Function 
Word Bit 

7 

1A Brown-1 - - NC 
2A Red-1 - - NC 
3A Orange-1 - - NC 
4A Yellow-1 - - NC 
5A Green-1 %QW(m+14).0 %QX(n+28).0 General purpose output 
6A Blue-1 %QW(m+14).1 %QX(n+28).1 General purpose output 
7A Purple-1 %QW(m+14).2 %QX(n+28).2 General purpose output 
8A Gray-1 %QW(m+14).3 %QX(n+28).3 General purpose output 
9A White-1 %QW(m+14).4 %QX(n+28).4 General purpose output 

10A Black-1 %QW(m+14).5 %QX(n+28).5 General purpose output 
11A Brown-2 %QW(m+14).6 %QX(n+28).6 General purpose output 
12A Red-2 %QW(m+14).7 %QX(n+28).7 General purpose output 
13A Orange-2 %QW(m+14).8 %QX(n+29).0 General purpose output 
14A Yellow-2 %QW(m+14).9 %QX(n+29).1 General purpose output 
15A Green-2 %QW(m+14).10 %QX(n+29).2 General purpose output 
16A Blue-2 %QW(m+14).11 %QX(n+29).3 General purpose output 
17A Purple-2 %QW(m+14).12 %QX(n+29).4 General purpose output 
18A Gray-2 %QW(m+14).13 %QX(n+29).5 General purpose output 
19A White-2 %QW(m+14).14 %QX(n+29).6 General purpose output 
20A Black-2 %QW(m+14).15 %QX(n+29).7 General purpose output 
1B Brown-3 %QW(m+15).0 %QX(n+30).0 General purpose output 
2B Red-3 %QW(m+15).1 %QX(n+30).1 General purpose output 
3B Orange-3 %QW(m+15).2 %QX(n+30).2 General purpose output 
4B Yellow-3 %QW(m+15).3 %QX(n+30).3 General purpose output 
5B Green-3 %QW(m+15).4 %QX(n+30).4 General purpose output 
6B Blue-3 %QW(m+15).5 %QX(n+30).5 General purpose output 
7B Purple-3 %QW(m+15).6 %QX(n+30).6 General purpose output 
8B Gray-3 %QW(m+15).7 %QX(n+30).7 General purpose output 
9B White-3 %QW(m+15).8 %QX(n+31).0 General purpose output 

10B Black-3 %QW(m+15).9 %QX(n+31).1 General purpose output 
11B Brown-4 %QW(m+15).10 %QX(n+31).2 General purpose output 
12B Red-4 %QW(m+15).11 %QX(n+31).3 General purpose output 
13B Orange-4 %QW(m+15).12 %QX(n+31).4 General purpose output 
14B Yellow-4 %QW(m+15).13 %QX(n+31).5 General purpose output 
15B Green-4 %QW(m+15).14 %QX(n+31).6 General purpose output 
16B Blue-4 %QW(m+15).15 %QX(n+31).7 General purpose output 
17B Purple-4 - - NC 
18B Gray-4 - - NC 
19B White-4 - - NC 
20B Black-4 - - NC 

Note In here, “m” and “n” are the top addresses that output are to be assigned. 
They should automatically be assigned in CODESYS for XSEL2. 
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SA Rotary 
Switch Setting Pin No. Cable 

color 
Address 

Function 
Word Bit 

7 

1A Brown-1 - - NC 
2A Red-1 - - NC 
3A Orange-1 - - NC 
4A Yellow-1 - - NC 
5A Green-1 %QW(m+14).0 %QX(n+28).0 General purpose output 
6A Blue-1 %QW(m+14).1 %QX(n+28).1 General purpose output 
7A Purple-1 %QW(m+14).2 %QX(n+28).2 General purpose output 
8A Gray-1 %QW(m+14).3 %QX(n+28).3 General purpose output 
9A White-1 %QW(m+14).4 %QX(n+28).4 General purpose output 

10A Black-1 %QW(m+14).5 %QX(n+28).5 General purpose output 
11A Brown-2 %QW(m+14).6 %QX(n+28).6 General purpose output 
12A Red-2 %QW(m+14).7 %QX(n+28).7 General purpose output 
13A Orange-2 %QW(m+14).8 %QX(n+29).0 General purpose output 
14A Yellow-2 %QW(m+14).9 %QX(n+29).1 General purpose output 
15A Green-2 %QW(m+14).10 %QX(n+29).2 General purpose output 
16A Blue-2 %QW(m+14).11 %QX(n+29).3 General purpose output 
17A Purple-2 %QW(m+14).12 %QX(n+29).4 General purpose output 
18A Gray-2 %QW(m+14).13 %QX(n+29).5 General purpose output 
19A White-2 %QW(m+14).14 %QX(n+29).6 General purpose output 
20A Black-2 %QW(m+14).15 %QX(n+29).7 General purpose output 
1B Brown-3 %QW(m+15).0 %QX(n+30).0 General purpose output 
2B Red-3 %QW(m+15).1 %QX(n+30).1 General purpose output 
3B Orange-3 %QW(m+15).2 %QX(n+30).2 General purpose output 
4B Yellow-3 %QW(m+15).3 %QX(n+30).3 General purpose output 
5B Green-3 %QW(m+15).4 %QX(n+30).4 General purpose output 
6B Blue-3 %QW(m+15).5 %QX(n+30).5 General purpose output 
7B Purple-3 %QW(m+15).6 %QX(n+30).6 General purpose output 
8B Gray-3 %QW(m+15).7 %QX(n+30).7 General purpose output 
9B White-3 %QW(m+15).8 %QX(n+31).0 General purpose output 

10B Black-3 %QW(m+15).9 %QX(n+31).1 General purpose output 
11B Brown-4 %QW(m+15).10 %QX(n+31).2 General purpose output 
12B Red-4 %QW(m+15).11 %QX(n+31).3 General purpose output 
13B Orange-4 %QW(m+15).12 %QX(n+31).4 General purpose output 
14B Yellow-4 %QW(m+15).13 %QX(n+31).5 General purpose output 
15B Green-4 %QW(m+15).14 %QX(n+31).6 General purpose output 
16B Blue-4 %QW(m+15).15 %QX(n+31).7 General purpose output 
17B Purple-4 - - NC 
18B Gray-4 - - NC 
19B White-4 - - NC 
20B Black-4 - - NC 

Note In here, “m” and “n” are the top addresses that output are to be assigned. 
They should automatically be assigned in CODESYS for XSEL2. 
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6.1 EtherNet/IP Scanner Feature 

ME0479-1A 6-1 

6.1 EtherNet/IP Scanner Feature 

 
EtherNet/IP (Ethernet Industrial Protocol) is an open and global industrial ethernet which executes 
the communication protocol for CIP (Common Industrial Protocol) Control in the application layer in 
the standard ethernet. 
As the standard ethernet is adopted, it can be used in mix with general-purposed ethernet devices. 
Also, its specifications are maintained and managed by ODVA (Open DeviceNet Vendors Association, 
Inc.). 
In EtherNet/IP, the side to demand connection start is called an originator, the one to be demanded 
is called a target, a device equipped with the originator feature is called a scanner, and a device with 
no originator feature is called an adopter. XSEL2 is applicable to the scanner feature. 
 

 
 

  

CODESYS for XSEL2 

Ethernet hub 

Standard Ethernet port 

XSEL2 

EtherNet/IP Adapter 

Remote I/O, Various sensors, etc. 

USB connection also available 

EtherNet/IP Scanner 
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6.1 EtherNet/IP Scanner Feature 

6-2 ME0479-1A 

 
6.1.1 Feature Specification 

 
Shown below are the specifications of the EtherNet/IP scanner features. 
 

Item Details 

Cyclic 
communication 

Number of connections 16 

Connection type Point-to-Point Multicast 

Send Trigger Cyclic 

Max. Data Size for 1 Connection 1444 Byte 

RPI (*1) Min. 10ms 

Cyclic Communication Allowable 
Communication Band (*2) 1600pps 

Message 
communication 

Class3 Number of connections 16 

UCMM Number of connections 16 

EtherNet/IP Conformance Test CT19.1 

 
● The EtherNet/IP scanner features should use the standard ethernet port. 

● Communication status can be checked at the network monitoring LED. 

* Refer to [1.5 Names and Features of Each Part Related to PLC] for details of display. 
 

*1 The cyclic communication cycle should be shown. 
Even though a cycle not satisfy the specification can also be set, shorter the cycle is more load 
should be applied for the process of the system, which may cause a controller to have an error 
stop (watchdog). 
Also, RPI must be a cycle in an integer multiple to the cycle of the scanner IO task 
(ENIPScannerIOTask), and it is recommended to set the same value. 

*2 It should show the transmitted packet count capable of process in one second. 
Confirm that the transmitted packet count in one second that can be calculated from RPI and 
the connection count is in the specification range. 
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6.1.1 Feature Specification 

 
Shown below are the specifications of the EtherNet/IP scanner features. 
 

Item Details 

Cyclic 
communication 

Number of connections 16 

Connection type Point-to-Point Multicast 

Send Trigger Cyclic 

Max. Data Size for 1 Connection 1444 Byte 

RPI (*1) Min. 10ms 

Cyclic Communication Allowable 
Communication Band (*2) 1600pps 

Message 
communication 

Class3 Number of connections 16 

UCMM Number of connections 16 

EtherNet/IP Conformance Test CT19.1 

 
● The EtherNet/IP scanner features should use the standard ethernet port. 

● Communication status can be checked at the network monitoring LED. 

* Refer to [1.5 Names and Features of Each Part Related to PLC] for details of display. 
 

*1 The cyclic communication cycle should be shown. 
Even though a cycle not satisfy the specification can also be set, shorter the cycle is more load 
should be applied for the process of the system, which may cause a controller to have an error 
stop (watchdog). 
Also, RPI must be a cycle in an integer multiple to the cycle of the scanner IO task 
(ENIPScannerIOTask), and it is recommended to set the same value. 

*2 It should show the transmitted packet count capable of process in one second. 
Confirm that the transmitted packet count in one second that can be calculated from RPI and 
the connection count is in the specification range. 
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6.1.2 Cyclic Communication Feature 

 
The cyclic communication is a feature to have a scanner conducting a connection start demand to 
an adapter, and once connection is established (opened), to send and receive data mutually in a 
specified constant frequency (RPI (Requested Packet Interval)). 
 
There are types available for sending and receiving (Exclusive Owner) and available only for 
sending (Input Only) in connection, and point-to-point connection in 1:1 and multicast connection in 
1:N are available. Different RPI for different destination for communication can be set up. 
It is suitable for purpose of transiting real time data, and it can be used to monitor the condition of a 
sensor all the time for an instance. 
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6.1 EtherNet/IP Scanner Feature 

6-4 ME0479-1A 

 
6.1.3 Message Communication Feature 

 
The message communication is a feature to have data sent or received in point-to-point of 1:1 in 
any timing to a designated destination for communication. 
 
As connection types in the message communication, there are "Class3 (Connection Type)" that 
conducts the message communication by establishing connection (open) and "UCMM (Non-
Connection Type)" that conducts the message communication without establishing connection. 
It should be used in a purpose where data sending and receiving is required only at startup of a 
device that has low necessity of continuous data update or monitoring such as readout/write-in of 
setting values for an instance. 
XSEL2 can be used as a message communication server and a client. 
 
When XSEL2 is to be used as the message communication server, it is applicable for the objects 
and services described in [6.1.5 [3] CIP Support Objects]. 
When XSEL2 is to be used as a client, the dedicated function block commands should be used.  
For details, refer to EtherNet/IP commands in the separate volume [PLC Feature Programming 
Manual (ME0480)]. 
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6.1.3 Message Communication Feature 

 
The message communication is a feature to have data sent or received in point-to-point of 1:1 in 
any timing to a designated destination for communication. 
 
As connection types in the message communication, there are "Class3 (Connection Type)" that 
conducts the message communication by establishing connection (open) and "UCMM (Non-
Connection Type)" that conducts the message communication without establishing connection. 
It should be used in a purpose where data sending and receiving is required only at startup of a 
device that has low necessity of continuous data update or monitoring such as readout/write-in of 
setting values for an instance. 
XSEL2 can be used as a message communication server and a client. 
 
When XSEL2 is to be used as the message communication server, it is applicable for the objects 
and services described in [6.1.5 [3] CIP Support Objects]. 
When XSEL2 is to be used as a client, the dedicated function block commands should be used.  
For details, refer to EtherNet/IP commands in the separate volume [PLC Feature Programming 
Manual (ME0480)]. 
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6.1.4 Setup of EtherNet/IP Scanner 

 
Here, explains the flow to operate the EtherNet/IP scanner feature. 
 

 

 

 

 

 

 

 
 

  

Step1. Install EDS File 
Install the EDS file of the EtherNet/IP adapter subject to connection. 
It is not necessary to conduct this process if it is already installed. 
Refer to [6.1.4 [1] Install EDS File]. 

Step2. Adding Scanner and Adapter Device 
Add the device to a project. 
Refer to [6.1.4 [2] Adding Scanner and Adapter Device]. 

Step3. Defining I/O Variables 
Conduct the variable definition for the EtherNet/IP input and output. 
Refer to [6.1.4 [3] I/O Variable Setting]. 

Step4. Option Setup for I/O Refresh 
Set up the output at stop as necessary. 
Refer to [4.4.3 I/O Refresh]. 
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6.1 EtherNet/IP Scanner Feature 

6-6 ME0479-1A 

 
[1] Install EDS File 

Install the EDS file of the connected EtherNet/IP adapter device. It is not necessary to conduct 
this process if it is already installed. 
* Consult with each manufacturer for how to obtain the EDS file. 

 
1) Click  from “Tools” in the menu bar.  

 
2) The device repository window should open. 
Click  to install the EDS file. Once the installation is complete, the device added to 
“EtherNet/IP Remote Adapter” should be displayed. 
(Hereinafter, shows a case of IAI EtherNet/IP adapter “IANP3802-EP0”) 
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[1] Install EDS File 

Install the EDS file of the connected EtherNet/IP adapter device. It is not necessary to conduct 
this process if it is already installed. 
* Consult with each manufacturer for how to obtain the EDS file. 

 
1) Click  from “Tools” in the menu bar.  

 
2) The device repository window should open. 
Click  to install the EDS file. Once the installation is complete, the device added to 
“EtherNet/IP Remote Adapter” should be displayed. 
(Hereinafter, shows a case of IAI EtherNet/IP adapter “IANP3802-EP0”) 
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Caution 
● As the EDS file for IAI product is enclosed in the XSEL2-T CODESYS package, it is not 

necessary to install it additionally. Pay attention when use as there are some controllers 
that the vendor’s name is not IAI Corporation. 

Controller name Applicable Device Name Vendor 
PCON-C/CG/CF 
ACON-C/CG 
SCON-CA 
MSEP-C 
PCON-CA/CFA 
MSCON 
XSEL-R/S/RX/SX/RXD/SXD 
ERC3 
Gateway 

Anybus CC EtherNet /IP HMS Networks 

XSEL-P/Q/PCT/QCT 
XSEL-PX/QX 

Anybus S EtherNet/IP HMS Networks 

Other than above IANP3802-EP0 IAI Corporation 

 

 
 

 
 

  



6.
 C

om
m

un
ic

at
io

n 
Fe

at
ur

e
 
6.1 EtherNet/IP Scanner Feature 
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[2] Adding Scanner and Adapter Device 

Add the ethernet interface, EtherNet/IP scanner and remote adapter under the device tree 
“Device (XSEL2-T)”. 

 
 Adding Ethernet Interface 

Right-click “Device (XSEL2-T)” and select “Add Device…”. 
Select Ethernet from “Fieldbus” → “Ethernet Adapter” in the device list, and click 

. 

 
* Once the Ethernet adapter is added, the following display should be shown. 
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[2] Adding Scanner and Adapter Device 

Add the ethernet interface, EtherNet/IP scanner and remote adapter under the device tree 
“Device (XSEL2-T)”. 

 
 Adding Ethernet Interface 

Right-click “Device (XSEL2-T)” and select “Add Device…”. 
Select Ethernet from “Fieldbus” → “Ethernet Adapter” in the device list, and click 

. 

 
* Once the Ethernet adapter is added, the following display should be shown. 
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Caution 
● The following work cannot be conducted in a condition not available to connect to 

XSEL2. 
Conduct it in a condition that connection is available. 
 

 
1) Double-click  in the device tree. 
 
2) Select “General” in the Ethernet tab, and click  in the network interface. 

 
 
3） Select an Ethernet adapter to establish the EtherNet/IP connection with the XSEL2 subject to 

connection, and click . 

 
 In case the XSEL2 subject to connection could not be detected, check in [4.1 PLC Feature 

Parameter Setting] and [4.8.2 Setup for Connection to XSEL2]. 
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 Adding EtherNet/IP Scanner 

Right click “Ethernet (Ethernet)” and select “Add Device…”. 
Select “EtherNet/IP Scanner” for the EtherNet/IP scanner from the device list, and click 

. 

 
* Once the EtherNet/IP scanner is added, the following display should be shown. 

 
 

 
Caution 
● Once a device is added, the tasks should automatically be generated, but they should 

be used for I/O refresh. Do not attempt to delete the tasks and POU that are 
automatically generated. 
 

  

 

 

 

EtherNet/IP Scanner I/O Task 
EtherNet/IP Scanner Service Task 

EtherNet/IP Scanner Device 
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 Adding EtherNet/IP Scanner 

Right click “Ethernet (Ethernet)” and select “Add Device…”. 
Select “EtherNet/IP Scanner” for the EtherNet/IP scanner from the device list, and click 

. 

 
* Once the EtherNet/IP scanner is added, the following display should be shown. 

 
 

 
Caution 
● Once a device is added, the tasks should automatically be generated, but they should 

be used for I/O refresh. Do not attempt to delete the tasks and POU that are 
automatically generated. 
 

  

 

 

 

EtherNet/IP Scanner I/O Task 
EtherNet/IP Scanner Service Task 

EtherNet/IP Scanner Device 
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Establish the option setting for the EtherNet/IP scanner as necessary. 
 
1) Double-click "XSEL2_T_EtherNet_IP_Scanner (XSEL2-T EtherNet/Ip Scanner)" from Ethernet 

(Ethernet) in the device tree. 

 
2) Select “General” in the “EtherNet_IP_Scanner” tab, and set up “Auto-reestablish connection” in 

the option. 
☑ (With Checkmark): The device should establish connection again automatically when a 

communication error is occurred. 
 (With No Checkmark): The device should stop and not establish connection again when a 

communication error is occurred. 

 
 

 
Caution 
● In case that "Do not establish connection again automatically" is to be set, consider to 

have connection established again by the user. 
Execute a reset with RemoteAdapter Command from a PLC program, and connection 
again to the applicable adapter should be attempted. 
For the details of RemoteAdapter Command, refer to the separate volume [PLC Feature 
Programming Manual (ME0480)]. 
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 Adding EtherNet/IP Remote Adapter 

Right click “EtherNet_IP_Scanner (EtherNet/IP Scanner)” and select “Add Device...”. 
Select the EtherNet/IP remote adapter subject to connection from the device list and click "Add 
Device". (Below, describes the case of EtherNet/IP Adapter IANP3802_EP0) 

 
 
* Once the EtherNet/IP Remote Adapter is added, the following display should be shown. 

 
 
Have the EtherNet/IP remote adapter set up. 
 
The setting contents for the EtherNet/IP remote adapter may differ depending on the EDS file. 
Below, explains an example for EtherNet/IP Adapter IANP3802_EP0 manufactured by IAI. 
 

  

 

EtherNet/IP Scanner Dvice 
EtherNet/IP Remote Adapter  
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 Adding EtherNet/IP Remote Adapter 

Right click “EtherNet_IP_Scanner (EtherNet/IP Scanner)” and select “Add Device...”. 
Select the EtherNet/IP remote adapter subject to connection from the device list and click "Add 
Device". (Below, describes the case of EtherNet/IP Adapter IANP3802_EP0) 

 
 
* Once the EtherNet/IP Remote Adapter is added, the following display should be shown. 

 
 
Have the EtherNet/IP remote adapter set up. 
 
The setting contents for the EtherNet/IP remote adapter may differ depending on the EDS file. 
Below, explains an example for EtherNet/IP Adapter IANP3802_EP0 manufactured by IAI. 
 

  

 

EtherNet/IP Scanner Dvice 
EtherNet/IP Remote Adapter  
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1) Double-click the EtherNet/IP remote adapter device in the device tree to open the Edit Object 

window (hereinafter, adapter setting window) in the remote adapter. 
 

2) Select “General” in the adapter setting window and set up the check items at connection to the 
IP address. 

 
 Address settings 

The IP address of the EtherNet/IP adapter device should be set up. 
 Electronic keying 

The items to be checked at connection should be set up. 
(Normally, there should be no problem with the default setting.) 
 
Compatibility Check 
☑ (With Checkmark): Compatibility check unique to the adapter device should be conducted. 
 (With No Checkmark): Compatibility check unique to the adapter device should not be 

conducted, and set up the items necessary to have matching check 
individually. 
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3) Select “Connection” from the adapter setting window and set up the connection parameters. 
(1) Select “Exclusive Owner”, and click  Edit Connection . 

 
(2) Set up the parameters necessary for connection, and click . 

 
 RPI (ms) 

Data update frequency (packet interval) between the scanner and remote adapter should be set 
up. 

 O→T size (bytes) 

The output size from XSEL2 to the remote adapter should be set up in the byte unit. 
 T→O size (bytes) 

The Input size from the remote adapter to XSEL2 should be set up in the byte unit. 
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3) Select “Connection” from the adapter setting window and set up the connection parameters. 
(1) Select “Exclusive Owner”, and click  Edit Connection . 

 
(2) Set up the parameters necessary for connection, and click . 

 
 RPI (ms) 

Data update frequency (packet interval) between the scanner and remote adapter should be set 
up. 

 O→T size (bytes) 

The output size from XSEL2 to the remote adapter should be set up in the byte unit. 
 T→O size (bytes) 

The Input size from the remote adapter to XSEL2 should be set up in the byte unit. 
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Caution 
● When connected to an EtherNet/IP adapter device manufactured by IAI, set RPI to 2ms 

or more. 
● Pay attention to the number of connected units of EtherNet/IP adapter devices and RPI 

(communication cycles) otherwise load to the CPU may exceed the allowable range and 
may cause an exception error. 
In such a case, it is necessary to either change the RPI setting to a larger value or 
reduce the number of connected units of adapter devices. 

● For the RPI (communication cycles) value, it is necessary to set up the value that is 
applicable for an EtherNet/IP device. Refer to the manual of the EtherNet/IP device to 
set RPI to the value applicable for the device. 
 

 
4) Select “Assembly” from the adapter setting window to set up the data configuration. 

Set the sizes of O→T / T→O to 16 (bytes), and each of them comes to the data configuration 
with 16 byte-types as shown below in the default. 
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To change the data configuration, click a data type subject to change to select it. 

 
To add or delete data, click “+ Add” or “x Delete”. It is also available to right-click individual data 
to select it. 

 
 

The figure below shows an example of changing the data configuration of 16 byte-types of input 
and output data to the input and output data configuration with 4 WORD types and 2 DWORD 
types. 
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To change the data configuration, click a data type subject to change to select it. 

 
To add or delete data, click “+ Add” or “x Delete”. It is also available to right-click individual data 
to select it. 

 
 

The figure below shows an example of changing the data configuration of 16 byte-types of input 
and output data to the input and output data configuration with 4 WORD types and 2 DWORD 
types. 
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[3] I/O Variable Setting 

The assembly data with data types set should be defined as the variables to be used in a PLC 
program, and it should be mapped to the input and output data of an EtherNet/IP remote adapter. 

 
1) Double-click “PLC_PRG (PRG)” in the device tree to open the POU editor. 
 
2) Create variables to be used in a PLC program in the POU variable definition area. 

 
3) Select “EtherNet/IP I/O Mapping” in the “IANP3802_EP0” tab, and input variables names 

applicable in the I/O mapping table. 
 
To confirm that the I/O mapping is conducted correctly, select “Build” → “Generate Code” in the 
menu while there is no description in the PLC program main body to confirm the build completes 
in normal condition. 
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6.1.5 Accessaries in EtherNet/IP Scanner Features 
 
[1] Remote Adapter Connection Confirm 

Here, explains how to confirm connection of XSEL2 and a EtherNet/IP remote adapter. 
 
1) Double-click the remote adapter device in the device tree, select “Status” in the Edit Object 

window of the opened remote adapter, and confirm that it transmits to execution in process 
(Adapter running). (e.g., for “IANP3802_EP0”) 
In case it would not transmit to execution in process, check if there is any discrepancy to the IP 
address, input and output point counts and so on in the remote adapter compared to the 
setting values in this device. 

 
 For Operation Mode 

Execution in Process: “Adapter running” 
(When adapter connected: “Configure encapsulation layer...”) 

 

 
 
 For Stop Mode 

While Operation Stopped: “Adapter in IDLE state” 
(When adapter not detected: “Adapter not configured yet...”) 
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 For Operation Mode 

Execution in Process: “Adapter running” 
(When adapter connected: “Configure encapsulation layer...”) 

 

 
 
 For Stop Mode 

While Operation Stopped: “Adapter in IDLE state” 
(When adapter not detected: “Adapter not configured yet...”) 
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[2] Cyclic Communication Latency 
 Latency in Sending 

 
 

No. Item Content 

(1) Latency till I/O Refresh It is the time after output with a command till the I/O 
refresh is conducted. 

(2) Time till EtherNet/IP Sent 

It is the time till communication cycles determined by 
RPI (Requested Packet Interval). 
In case a communication retry occurs, add for count 
of retries and it makes delay. 

(3) EtherNet/IP Sending Process 
Latency 

The following latency should occur when 
communication data is sent to each device. 
0.026 × Connection Count [ms] 

(4) Internal Process of EtherNet/IP 
Device 

It is the internal process time for a connected 
EtherNet/IP device. 
Refer to manuals related to each network device. 

 
  

XSEL2 CPU 
(1) 

RPI 

XSEL2 EtherNet 
Interface 

(2) 
(3) 

EtherNet/IP device 
(4) 

Confirmation 

I/O Refresh Frequency 

Output 
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 Latency in Receiving 

 
 

No. Item Content 

(1) Internal Process Time for EtherNet/IP 
Device 

It is the internal process time for a connected 
EtherNet/IP device. 
Refer to manuals related to each network 
device. 

(2) Time till EtherNet/IP Sent 

It is the time till communication cycles 
determined by RPI (Requested Packet Interval). 
In case a communication retry occurs, add for 
count of retries and it makes delay. 

(3) EtherNet/IP Sending Process Latency 
It is the latency in data sending process of a 
connected EtherNet/IP. Refer to manuals related 
to each network device. 

(4) EtherNet/IP Receiving Process 
Latency 

The following latency should occur when 
receiving communication data from each device. 
0.008 × Connection Count+0.000004 × Total 
Data Size [byte] [ms] 

(5) Latency till I/O Refresh It is the time till I/O refresh is conducted. 

(6) Latency till Confirmation It is the time till confirmed in a command from 
PLC. 

 
  

XSEL2 CPU 
((55)) 

RPI 

XSEL2 EtherNet 
Interface 

((22)) 
((33)) 

EtherNet/IP device 

((44)) 

Confirmation 

I/O Refresh Frequency 

((11)) 

(6) 

Input 
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 Latency in Receiving 

 
 

No. Item Content 

(1) Internal Process Time for EtherNet/IP 
Device 

It is the internal process time for a connected 
EtherNet/IP device. 
Refer to manuals related to each network 
device. 

(2) Time till EtherNet/IP Sent 

It is the time till communication cycles 
determined by RPI (Requested Packet Interval). 
In case a communication retry occurs, add for 
count of retries and it makes delay. 

(3) EtherNet/IP Sending Process Latency 
It is the latency in data sending process of a 
connected EtherNet/IP. Refer to manuals related 
to each network device. 

(4) EtherNet/IP Receiving Process 
Latency 

The following latency should occur when 
receiving communication data from each device. 
0.008 × Connection Count+0.000004 × Total 
Data Size [byte] [ms] 

(5) Latency till I/O Refresh It is the time till I/O refresh is conducted. 

(6) Latency till Confirmation It is the time till confirmed in a command from 
PLC. 

 
  

XSEL2 CPU 
((55)) 

RPI 

XSEL2 EtherNet 
Interface 

((22)) 
((33)) 

EtherNet/IP device 

((44)) 

Confirmation 

I/O Refresh Frequency 

((11)) 

(6) 

Input 
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[3] CIP Support Object 

(1) Identity Object（Class ID: 01H） 

 
 Class 
● Class Service 

It is applicable for Get_Attribute_Single (0EH) and Get_Attributes_All (01H). 
● Class Attribute (Instance ID: 0) 

 
ID Name Attributes Data type Explanation Value 

1 Revison Get UINT Revision of Object 2 

2 Max Instance Get UINT Max. Instance Number 1 

6 Maximum ID Number 
Class Attributes Get UINT Max. Attribute ID in Class 

Attribute 7 

7 Maximum ID Number 
Instance Attributes Get UINT Max. Attribute ID in Instance 

Attributes 7 

 
 Instance 
● Instance Service 

It is applicable for Get_Attribute_Single (0EH), Get_Attributes_All (01H).  
● Instance Attribute (Instance ID: 1) 

 
ID Name Attributes Data type Explanation Value 

1 Vendor ID Get UINT 
Vendor 
Identification 
Number 

699 
(IAI Corporation) 

2 Device Type Get UINT Device type 12 
(Communications Adapter) 

3 Product Code Get UINT Product 
Identification Code 109 

4 

Revision Get Structure Revision --- 

Major Revision Get USINT Major Revision 1 

Minor Revision Get USINT Minor Revision 1 

5 Status Get WORD Status Current value 

6 Serial Number Get UINT Serial number Serial number 

7 Product Name Get SHORT_STRING Product name XSEL2-T 
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(2) Connection Manager Object (Class ID: 06H) 
 
 Class 
● Class Service / Class Attribute 

…There is no Class Service / Class Attribute. 

 
 Instance 
● Instance service 

It is applicable for Forward_Open (54H), Large_Forward_Open (5BH), Forward_Close (4EH).  
 

● Instance Attribute 
…There is no Instance Attributes. 
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(2) Connection Manager Object (Class ID: 06H) 
 
 Class 
● Class Service / Class Attribute 

…There is no Class Service / Class Attribute. 

 
 Instance 
● Instance service 

It is applicable for Forward_Open (54H), Large_Forward_Open (5BH), Forward_Close (4EH).  
 

● Instance Attribute 
…There is no Instance Attributes. 
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(3) TCP/IP Interface Object (Class ID: F5H) 
 
 Class 
● Class Service 

It is applicable for Get_Attribute_Single (0EH).  
● Class Attribute (Instance ID: 0) 

 
ID Name Attributes Data type Explanation Value 

1 Revision Get UINT Revision of Object 4 

2 Max Instance Get UINT Max. Instance Number 1 

3 Number of Instances Get UINT Object Instance Count 1 

 
 Instance 
● Instance Service 

It is applicable for Get_Attribute_Single (0EH). 
● Instance Attribute (Instance ID: 1) 

 
ID Name Attributes Data type Explanation Value 
1 Status Get DWORD Status 00000002H 

2 Configuration 
Capability Get DWORD  00000020H 

3 Configuration 
Control Get DWORD  00000000H 

4 

Physical Link Object 

Get 

Structure Path to Physical Link 
Object --- 

Path size UINT Path Size 2 

Path Padded 
EPATH 

Segment to Specify 
Physical Link Object 20F62401H 

5 

Interface Configuration 

Get 

Structure Interface Configuration --- 
IP Address UDINT IP Address Set value 
Network Mask UDINT Subnet mask Set value 
Gateway Address UDINT Default gateway Set value 

Name Server UDINT Primary name server 0 
(Not supported) 

Name Server 2 UDINT Secondary Name Server 0 
(Not supported) 

Domain Name STRING Domain name NULL 
(Not supported) 
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(4) Ethernet Link Object (Class ID: F6H) 
 
 Class 
● Class Service 

It is applicable for Get_Attribute_Single (0EH), Get_Attributes_All (01H). 
●Class Attribute (Instance ID：0) 

 
ID Name Attributes Data type Explanation Value 

1 Revision Get UINT Revision of Object 4 

2 Max Instance Get UINT Max. Instance Number 1 

3 Number of Instances Get UINT Object Instance Count 1 

 
 Instance 
● Instance Service 

Get_Attribute_Single (0EH) 
●Instance Attribute (Instance ID: 1) 

 
ID Name Attributes Data type Explanation Value 

1 Interface Speed Get UDINT Interface communication 
speed (Mbps) 

Current 
value 

2 Interface Flags Get DWORD Interface Status Flag 

Current 
value 

(Refer to table 
below) 

3 Physical Address Get USINT array MAC Address (6 octet) Current 
value 

11 

Interface Capability 

Get 

Structure Interface Support Information --- 

Capability Bits DWORD Support Information ６ 
Speed/Duplex 
Options Structure Baud Rate / Duplicated Mode 

Option --- 

Speed/Duplex Array 
Count USINT Option Count ０ 
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(4) Ethernet Link Object (Class ID: F6H) 
 
 Class 
● Class Service 

It is applicable for Get_Attribute_Single (0EH), Get_Attributes_All (01H). 
●Class Attribute (Instance ID：0) 

 
ID Name Attributes Data type Explanation Value 

1 Revision Get UINT Revision of Object 4 

2 Max Instance Get UINT Max. Instance Number 1 

3 Number of Instances Get UINT Object Instance Count 1 

 
 Instance 
● Instance Service 

Get_Attribute_Single (0EH) 
●Instance Attribute (Instance ID: 1) 

 
ID Name Attributes Data type Explanation Value 

1 Interface Speed Get UDINT Interface communication 
speed (Mbps) 

Current 
value 

2 Interface Flags Get DWORD Interface Status Flag 

Current 
value 

(Refer to table 
below) 

3 Physical Address Get USINT array MAC Address (6 octet) Current 
value 

11 

Interface Capability 

Get 

Structure Interface Support Information --- 

Capability Bits DWORD Support Information ６ 
Speed/Duplex 
Options Structure Baud Rate / Duplicated Mode 

Option --- 

Speed/Duplex Array 
Count USINT Option Count ０ 
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 Interface Flags details 
 

Bit Name Attributes Explanation Value 

0 Link Status Get 
Network Link Status 
0: Non-Active 
1: Active 

Current 
value 

1 Half/Full 
Duplex Get 

Duplicated Mode Status 
0: Half Duplex 
1: Full Duplex 

Current 
value 

2 to 4 Negotiation 
Status Get 

Automatic Negotiation Status 
0: Negotiation in Process 
1: Negotiation Failed (both baud rate and duplicated 

mode) 
2: Negotiation Failed (Only baud rate succeeded) 
3: Negotiation Succeeded 
4: Negotiation Not Executed 

Current 
value 

5 Manual Setting 
Requires Reset Get 

Reset Operation at Negotiation Setup Change 
0: Unnecessary (Automatic Negotiation Setting fixed) 
1: Necessary 

0 

6 Local 
Hardware Fault Get 

Hardware Error Status 
0: Normal 
1: Error 

Current 
value 

7 to 31 Reserved Get Reserve 0 
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6.1.6 Caution for EDS File 

 
If there is a problem in the definition in the EDS file to use, the contents of the EDS file would not 
be recognized by CODESYS for XSEL2, and input and output data may not get mapped. 
There are the following two types for those that input and output data are not mapped. 
 

(1) When data is not assigned to the input / output assembly 

 
 

(2) Relation between data type in input / output assembly and bit length is not appropriate. 
(e.g. Data type is Byte Type but bit length is not Byte Type, etc.) 

 
 
In such a case as above, conduct the operation described in the following pages. 
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If there is a problem in the definition in the EDS file to use, the contents of the EDS file would not 
be recognized by CODESYS for XSEL2, and input and output data may not get mapped. 
There are the following two types for those that input and output data are not mapped. 
 

(1) When data is not assigned to the input / output assembly 

 
 

(2) Relation between data type in input / output assembly and bit length is not appropriate. 
(e.g. Data type is Byte Type but bit length is not Byte Type, etc.) 

 
 
In such a case as above, conduct the operation described in the following pages. 
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1) Open Assembly in the EtherNet/IP adapter. 
 

 
 
2) If the instance in the input / output assembly is not appropriate, select “Delete” from the right-

click menu. 

 
 
3) Click “+ Add” in the input / output assembly. 
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4) Click the name same as the previous instance, and confirm that the same name is input in the 

“Name” box. (e.g.: Output Data) 
 
5) Input the data type to be used in the I/O mapping in the “Data Types” box. (e.g.: BYTE) 
 
6) Input the data count to be conducted I/O mapping in the “Count” box. (e.g.: 15) 

 
 
7) Confirm that the instance added in Step 4) to 6) in the EtherNet/IP I/O mapping is displayed. 

 
 

 

 

 

 

4) 

5) 

6) 
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4) Click the name same as the previous instance, and confirm that the same name is input in the 

“Name” box. (e.g.: Output Data) 
 
5) Input the data type to be used in the I/O mapping in the “Data Types” box. (e.g.: BYTE) 
 
6) Input the data count to be conducted I/O mapping in the “Count” box. (e.g.: 15) 

 
 
7) Confirm that the instance added in Step 4) to 6) in the EtherNet/IP I/O mapping is displayed. 

 
 

 

 

 

 

4) 

5) 

6) 
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6.2 OPC UA server feature 

 
OPC UA Server Feature actuates XSEL2 as OPC UA Server and use the OPC UA communication 
to enable reading and writing of variables disclosed in CODESYS from the OPC UA client side. 
In OPC UA, certification and encryption of communication are defined in the standard, which enables 
secured communication. 
 

 
 

  

CODESYS for XSEL2 

XSEL2 

Ethernet 

OPC UA Server 

OPC UA communication 

OPC UA Client 
SCADA software, MES, Displays, etc. 
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6.2.1 Feature Specification 

 
Below shows the feature specifications of OPC UA Server. 

 
Item Detail 

Used Connection Port CPU Unit Built-in Ethernet Port 
* Use in parallel with other Ethernet communications 

Profile Embedded UA Server Profile 1.04 

Information Model PLCopen Information Model for IEC 61131-3 

Transport UA TCP 

URL (End Point URL) Indication System opc.tcp://[IP Adress]:[Port No.] 
e.g.) opc.tcp://192.168.0.10:4840 

Session (Client) Max. Count 2 

Monitoring Item Count 200 

Variable Types not Available to Disclose 

● Character String Type (STRING available, WSTRING not 
available) 

● Clock Type (Only LDATE_AND_TIME (LDT) available, 
other types not available) 

● Constant Type (const), Interface, Properties 
● Common Body, Pointer 

Limitation in Variable Names 
● Max. Number of Characters 255 Characters 
● Half-width characters (alphanumeric characters and 

symbols) 

OPC UA Security Mode 
● None: Sign-in or Encrypt Unnecessary 
● Sign:  Only Sign-in Necessary 
● Sing&Encrypt: Sign-in and Encrypt Necessary 

OPC UA Security Policy 
● Basic256Sha256 
● Aes128_Sha256_RsaOaep 
● Aes256_Sha256_RsaPss 

Application  
authentication* 

Certificate 

● Own Certificates: Own Certificates 
● Trusted Certificates: Trusted Certificates 
● UnTrusted Certificates: Untrusted Certificates 
● Quarantined Certificates: Quarantined Certificates 
*Available to register 8 for each 

Certificate 
Specification X.509 compliant 

User certification ● Username&Password (Username and Password) 
*Anonymous users should not use it in security viewpoint 

* The sampling frequency should be set in the OPC UA client. In OPC UA Server for XSEL2, 
100ms, 300ms, 500ms, 1000ms, 2500ms and 5000ms should be selected from the sampling 
frequency set in the client for operation. 
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6.2.1 Feature Specification 
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Item Detail 

Used Connection Port CPU Unit Built-in Ethernet Port 
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Profile Embedded UA Server Profile 1.04 
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● Own Certificates: Own Certificates 
● Trusted Certificates: Trusted Certificates 
● UnTrusted Certificates: Untrusted Certificates 
● Quarantined Certificates: Quarantined Certificates 
*Available to register 8 for each 

Certificate 
Specification X.509 compliant 

User certification ● Username&Password (Username and Password) 
*Anonymous users should not use it in security viewpoint 

* The sampling frequency should be set in the OPC UA client. In OPC UA Server for XSEL2, 
100ms, 300ms, 500ms, 1000ms, 2500ms and 5000ms should be selected from the sampling 
frequency set in the client for operation. 
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6.2.2 Flow from Setup to Connection 

 
As the setup to disclose variables used in a program in CODESYS, set up the OPC UA Server 
Feature after the program is created in CODESYS. 

 
Setup on OPC UA Server Side  Setup on OPC UA Client 

The operation to set up on the OPC UA 
Server side should be conducted in 
CODESYS for XSEL2. 

 For the setup on the OPC UA client side, 
refer to the instruction manual of the client. 

1) OPC UA Server Feature Setup 
● Activation of the OPC UA feature and 

setup of variables to be disclosed should 
be conducted. 
Refer to [6.2.3 OPC UA Server Setup] 

● Set up the user certification. 
Refer to [6.2.4 [3] User Certificate Setting] 

 
 
 

 

2) Server Certificate Setup 
Create a server certification. (*1) 
Refer to [6.2.4 [4] Server Certificate』 

 
 
 

 

 
Access 

 
 

3) Setting up Destination for Connection 
Indicate the end point URL, and connect 
to OPC UA Server. 
It is necessary to select a security policy 
applicable for OPC UA Server. 

 

Certificate 

 
 

4) Registration of Server Certificate 
Register the server certificate provided 
by the server to the OPC UA client 
software. 

6) Registration of Client Certificate 
A client certificate provided by the OPC UA 
client should be registered. *1 
Refer to [7.2.4 [5] Client Certificate] 
 
 

Certificate 

 
 

5) Client Certificate Setup 
Create a client certification. 
A client certificate should be sent at the 
time of connection request. 

 
 
 

 

 

Reading 
and Writing 

 
 

7) Reading and Writing of Variables 
Reading and writing of CODESYS 
variables in accordance with the 
address space in the OPC UA client 
should be conducted. 

*1 If the security mode is set to “None”, communication can be established even without 
exchanging the server certificate and client certificate. 
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6.2.3 OPC UA Server Setup 

 
In order to use the OPC UA server feature, it is necessary to activate the OPC UA feature and to 
register variables to be disclosed to a client. Shown below is how to set it up. 
 
1) Right-click “Application” displayed in the device view, and select “Add Object” → “Symbol 

Configuration...”. 

 
 
2) In the “Add Symbol Configuration” dialog, put a checkmark at “Support OPC UA Features” and 

click  Add . 
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register variables to be disclosed to a client. Shown below is how to set it up. 
 
1) Right-click “Application” displayed in the device view, and select “Add Object” → “Symbol 

Configuration...”. 

 
 
2) In the “Add Symbol Configuration” dialog, put a checkmark at “Support OPC UA Features” and 

click  Add . 
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3) As symbol configuration window opens, select a “variable to disclose from the list”. 

 

 
 

The right to access to disclose can be changed. The right to access can be changed every time it 
is clicked. 

・ : Read only 

・ : Wright only 

・ : Read Wright 

 
4) Build a program and check that there is no error occurred, and log in to the controller to have 

the operation started. 
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6.2.4 Security Feature 

 
[1] Guideline of Security Feature 

In the OPC UA Server feature, security is secured by two steps of certificate, application 
certificate and user certificate, to connection from the OPC UA client. 

 
 User certification 

It is a system that the OPC UA server certifies the OPC UA client that tries to access OPC UA 
Server by a username and password. 
A user to permit connection should register its username and password to the OPC UA server. 
The username and password should be required at connection from the OPC UA client for 
certification. 

 
 Application certification 

The application certificate is a system to certify the identification of each other by having the 
OPC UA server and the OPC UA client exchange the electric certificate with each other. 
The application certificate for XSEL2 supports the certificate in X.509 specification. 
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6.2 OPC UA server feature 

ME0479-1A 6-35 

 
[2] Security Policy 

The security policy is an agreement that settings necessary to secure security such as existence 
of signing and encrypt to messages exchanged in a communication and encryption algorithm are 
combined. The security policy to messages should be set up to have safe communication. 

 
By setting the same security policy to the OPC UA client connected to the OPC UA server, 
communication can be established. 

 
Security Policy Available for Setting 

The security policies available for setting are as follows. 
 

Security Policy Authority Encrypt Explanation 

Basic256Sha256-Sign Basic256Sha256 

None 

By signing in, 
completeness of data 
(countermeasures to such 
as falsification) can be 
secured. 

Aes128_Sha256_RsaOaep-
Sign Aes128_Sha256_RsaOaep 

Aes256_Sha256_RsaPss-
Sign Aes256_Sha256_RsaPss 

Basic256Sha256- 
SignAndEncrypt Basic256Sha256 Basic256Sha256 

By signing in and 
encrypting, completeness 
of data (countermeasures 
to such as falsification) 
and reliability 
(countermeasures to such 
as eavesdropping) can be 
secured. 

Aes128_Sha256_RsaOaep- 
SignAndEncrypt Aes128_Sha256_RsaOaep Aes128_Sha256_RsaOaep 

Aes256_Sha256_RsaPss- 
SignAndEncrypt Aes256_Sha256_RsaPss Aes256_Sha256_RsaPss 
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[3] User Certificate Setting 

OPC UA Server Feature is applicable for user authentication by a password. The username and 
password used for user certificate should be added as the device user for CODESYS. For how to 
add a user, refer to [7.2.1 Device User Feature]. 

 
 

 
Caution 
● When OPC UA communication cannot be established properly, check also that the 

communication permitted users for XSEL2 and the OPC UA client are matched with 
each other. 
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[4] Server Certificate 

The server certificate is to certify the identification of the OPC UA server. When using the security 
policy, connection can be established by registering the server certificate to the OPC UA client. 
To connect from the OPC UA client, it is necessary that the generated server certificate is 
registered to the OPC UA client. The server certificate should be provided at a connection 
request from the OPC UA client, and connection to the client should be established by registering 
it on the client side. 
Below shows how to create a server certificate. 

 
1) Click  Display  →  Security Screen  from the menu. 

 
 

2) Select the “Devices” tab and click . 
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3) The status of the certificate in the device should be shown. 

Indicate “Own Certificates” and select “OPC UA Server”. 

 
 

4) Create a certificate. Click the  icon, and the “Certificate Settings” dialog should open. 
 

5) Once the “Certificate Settings” dialog opens, set up the length and the expiry date for the 
certificate key, and click  and the certificate should be created. 

 
* It may take a five minute to issue a certificate. 

 
6) Indicate [Own Certificates] to confirm that “OPC UA Server” Certificate has been issued, and 

turn off the power to the XSEL2 controller and reboot it. 
 
* The issued certificate should get valid after the reboot. 
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[5] Client Certificate 

The client certificate is to certify the identification of the OPC UA client. When using the security 
policy, connection can be established by registering the client certificate to the OPC UA server. 
Compare the client certificate sent at a connection start request from the OPC UA client with the 
client certificate in Trusted Certificated, and connection should be permitted when it is the 
registered client certificate. 
Below shows how to register the client certificate of own signed. 

 
1) Click  Display  →  Security Screen  from the menu. 

 
 

2) Select the "Devices" tab and click . 
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3) Select “Quarantined Certificates” and the certificate of the client should get displayed. 

 
 

4) Drag & drop the trustable client certificate to “Untrusted Certificates”.  

 
 

5) The client certificate should be added to Trusted Certificates. 

  
 

Caution 
● Do not attempt to move the certificate to Own Certificates. 

Movement should be made only among the following folders. 
●Trusted Certificates 
●Untrusted Certificates 
●Quarantined Certificates 
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3) Select “Quarantined Certificates” and the certificate of the client should get displayed. 

 
 

4) Drag & drop the trustable client certificate to “Untrusted Certificates”.  

 
 

5) The client certificate should be added to Trusted Certificates. 

  
 

Caution 
● Do not attempt to move the certificate to Own Certificates. 

Movement should be made only among the following folders. 
●Trusted Certificates 
●Untrusted Certificates 
●Quarantined Certificates 
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6.2.5 Connection from OPC UA Client and Reading and Writing of Variables 
 
[1] How to Connect to OPC UA Server 

[URL for Connection Destination] 
Indicate the end point URL of the OPC UA server as the destination of connection for the OPC 
UA client. 
Format: opc.tcp://[XSEL2 IP address]:4840 
e.g.) opc.tcp://192.168.0.10:4840 

 
 

 
Caution 
● For the IP address indicate the IP address of the Ethernet built in XSEL2. 
● For some OPC UA client applications, indication of a port number may not be 

necessary. 
 opc.tcp://<XSEL2 IP address> 
 e.g.) opc.tcp://192.168.0.10 

● Some OPC UA client describes URI (Uniform Resource Identifier), not URL, but there is 
no problem to set up the same as URL. 
 

 
[User certification] 
In case user certification is conducted at connection to the OPC UA server, it is necessary to set 
up the username and password. 
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[2] Reading and Writing of Variables from OPC UA Client 
 OPC UA Address Space and Application of Variables 

From the OPC UA client, indication should be made in the address space of OPC UA. 
The address space of XSEL2 should be disclosed as follows. 

 Mapping of Variables and Attributes 
Settings of names, data types and values of variables should be mapped to the data types of 
each node in the address space. 
 

 
 
 Mapping of Variables and Attributes 

Settings of names, data types and values of variables should be mapped to the data types of 
each node in the address space. 

 
Variable Attribute 

of CODESYS Attribute of OPC UA Explanation 

Variable name 
BrowseName 

or  
DisplayName 

There is no identification of capital and small 
letters. 

Data type DataType 
For mapping of the datatype of CODESYS and 
datatype of OPC UA, refer to [the table in the 
next page]. 

Value Value Values corresponding to the datatype should 
be set. 
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 CODESYS Datatypes and OPC UA Datatypes 
 

CODESYS data type OPC UA data type Explanation of OPC UA Datatypes 

BOOL Boolean Values expressed with 8-bit values to show 
status of two 

SINT SByte Integers with 8-bit symbols 

BYTE, USINT Byte Integers without 8-bit symbols 

INT Int16 Integers with 16-bit symbols 

UINT, WORD UInt16 Integers without 16-bit symbols 

DINT Int32 Integers with 32-bit symbols 

UDINT, DWORD UInt32 Integers without 32-bit symbols 

LINT Int64 Integers with 64-bit symbols 

ULINT, LWORD UInt64 Integers without 64-bit symbols 

REAL Float IEEE754 Single-Precision Floating-Point 
Numbers 

LREAL Double IEEE754 Double-Precision Floating-Point 
Numbers 

LDATE_AND_TIME DateTime Date Clock 
64 bits, 100ns time from 1601/1/1 

LTIME UtcTime Time 
64-bit 

STRING String UTF-8 Character String Ending with Null 

* Members of structured variables and each element in the array type should be deployed as 
the child nodes of variables. 
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6.2.6 Precautions 
 
 Having a warm reset during monitoring of XSEL2 data from the OPC UA client device, and 

monitoring of the OPC UA client could stop and get necessary for registration on the OPC UA 
client side again. 

 
 Security on the system should be established by the user. 
 Shown below is an example of network security measures. 
(1) Use this product in a network using such as Firewall. 
(2) Confirm that check to infection to computer viruses and malware programs is conducted 

regularly and exterminated if the product is connected to a PC. 
(3) It is not installed to a place where anonymous people can touch, or lock the place where the 

device is installed. 
(4) Use it in an environment with VPN (Virtual Private Network) or dedicated online network 

being established. 
(5) Limit accessible users by using the user certificate feature. 
(6) Certify identification of each other between devices by using the application certificate. 

 
 There is an expiry date to the electric certificate. 

If the certificate set to the OPC UA server and client is expired in the OPC UA communication, 
the communication should stop. 
In order to avoid expiry of a certificate, it is necessary to regularly check the expiry date of the 
certificate and update it. 
There may be a concern that the clock data inside the XSEL2 controller gets lost and the 
certificate expires. If necessary, it is required to set up the current time to XSEL2 with using a 
teaching tool. 

 
 In order to change the IP address of XSEL2, it is necessary to connect a teaching tool (XSEL PC 

software or teaching pendant (TB02/TB03)). 
Make a change referring to how to set up IP address described in [4.1 PLC Feature Parameter 
Setting]. 
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7.1 Feature of POU for implicit checks 

 
The POU for implicit checks are feature to check the array range, range of subrange type variables, 
division by zero and pointer address. 
By adding this object to a project, the function should be implicitly called out in the program and 
have checking. 

 
7.1.1 Setup for Automatic Confirmation POU 
 
Shown below is how to Setup for Automatic Confirmation POU. 
 
1) Right-click “Application” shown in the device view, and select “Add Object” → “POU for Implicit 

Checks...”. 
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2) In the “Add POU for Implicit Checks” dialog, put a checkmark to a function that you would like to 

add and click  Add . 

 
The following functions (objects) should be added in accordance with selected items. 
As a standard check process is quipped in the added objects, edit it as necessary. 
However, a standard check process is not equipped to “Pointer Check”, equip it referring to the 
online help. 

 
Check Type Check Contents Function (Object) name 

Bound checks Check index of array CheckBounds 

Division checks Check if divided by 0 

CheckDivDInt 

CheckDivLInt 

CheckDivLReal 

CheckDivReal 

Range checks Check range of DINT and UDINT type 
variables 

CheckRangeSigned 

CheckRangeUnsigned 

LRange checks Check range of LINT and ULINT type 
variables  

CheckLRangeSigned 

CheckLRangeUnsigned 

Pointer checks Check if pointer type variables refer to 
effective addresses CheckPointer 
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7.2 Security Protection Support Feature 

 
 
7.2.1 Device User Feature 
 
It is a function to limit users capable to log in to XSEL2. By registering a name and password, only 
the registered users can log in. 
After device users are registered, the following dialog should get displayed after login. Input the 
registered name and password. 

 

  
 

 
Caution 
● If you forget the user name and password, you will not be able to log in. 

Be careful not to forget. 
 

 
A user should belong to one of the four types of groups (Administrator / Developer / Service / 
Watch), and the authority for each user group should be shown as follows. 

 
No. Administrator  Developer Service Watch Remarks 

Connection to XSEL2 ◯ ◯    

Program Transfer ◯ ◯ × ×  

Device User 
Administration ◯ × × ×  

File Transfer ◯ ◯ ◯ Only Display 
Available 

Not available with 
XSEL2 

Security settings ◯ Only Display 
Available 

Only Display 
Available 

Only Display 
Available 

Not available with 
XSEL2 

Certificate Administrator ◯ × × ×  

OPC UA Variable 
Display ◯ ◯ ◯ ◯  

OPC UA Variable 
Overwrite ◯ × × ×  
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Here, shows how to add a device user. 
1) Double-click “Device” shown in the device view. 

 
2) Click  User and Groups  in the Device Setup window and click . 

 
3) If the user administration is not set, the following window should show up. Click  Yes . 
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Here, shows how to add a device user. 
1) Double-click “Device” shown in the device view. 

 
2) Click  User and Groups  in the Device Setup window and click . 

 
3) If the user administration is not set, the following window should show up. Click  Yes . 
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4) If the user administration is not set, you will be requested to add a user with administrator rights. 

Input necessary items and click . 

 
* After a new user is added, login with the username and password kept blank will become 

unavailable. Make sure that you keep a copy of the set password. 
 

5) The “Device User Login” window should appear. Input the username and password for user with 
administrator rights and click . 

 
6) It gets to the login status of the user with administrator rights. 
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7) To add a user to access the device, click  Add... . 

 
8）The Add User window should open. Set necessary information such as a username and 

password, and click . 

 
9) The user should be added. 
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7.2.2 Encrypting CODESYS Project File 
 

The CODESYS project files can be encrypted using a password. 
Setting a password, and the password will be required when opening the project file. 

 
 

Open the dialog from “Project Settings” → “Security”. Check at “Encrypt” and select “Password”. 
Input Current Password, New Password, Confirm New Password and click . 
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This is the end of password setup. 
A window to request to input the password when opening a project file. Input the password you 
have set. 

 
 

Caution 
● If you forget the password for encrypt, you will not be able to open the project. 

Be careful not to forget. 
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Be careful not to forget. 
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7.2.3 Ethernet Communication / Control System 

 
Using the electronic certificate, communication between CODESYS for XSEL2 and XSEL2 can be 
encrypted.  
Here, explains how to encrypt communication using the own certificate of XSEL2. 
 

1) Double-click the [Device] object in the device tree. 

 
 

2) Activate “Encrypted Communication” in the device menu. 

 
 

3) Once “Encrypted Communication” is activated, the link line among the CODESYS for XSEL2, 
gateway and controller will be displayed in yellow. 
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4) Click Scan Network menu. 

 
 

5) The Select Device window should appear. Select a connected controller and click .  

 
 

6) A message stating the certificate of the controller is not signed by a trusted organization.  
Click  and the certificate shown in the message should get identified as a trusted 
certificate and it will be installed to the local "controller certificate" store on a PC, and then 
communication can get encrypted. 
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7) The registered controller certificate can be confirmed with “certmgr.msc” in 

“C:¥Windows¥System32 Folder”. 

 
 

 
Caution 
● If the validated date is expired for the electronic certificate, there should be a message 

stating validated date expired for certificate should be displayed. Click  and 
the validated date for the certificate should be extended. 

● There may be a concern that the clock data inside the XSEL2 controller gets lost and 
the certificate expires. If necessary, it is required to set up the current time to XSEL2 
with using a teaching tool. 
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7.3 Interface Object 

 
The interface object can define methods and properties in common used in the same system 
among different function blocks with a mounting measure of object oriented programing. The 
interface object includes only the declaration of methods and properties, but does not include 
mounting. 
 

7.3.1 Setting up Interface Object 
 

Here, explains how to add an object for the interface. 
 

1) Right-click the “Application” object in the device view, and select “Add Object” → “Interface...” 
from the displayed menu. 
The “Add Interface” dialog should be displayed. 
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2) Input a name and click  Add . An interface object should be added. 

Also, by enabling the inheritance, an interface input in the input field should be inherited and 
expanded. 

 
 

3) Right-click the “ITF” object added in the device view, and select “Add Object” → “Interface 
Property...” or “Interface Method...” from the menu displayed. 
 

 
 The “Add Interface Property” dialog box or the "Add Interface Method" dialog box should be 

displayed. 
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4) Input a name and click  Add . 

The interface property always requires input of the return type. 
The ”Prop” object or “METH” object should be added under the “ITF” object. 

 

 
 

* The property requires the return value. 

 
 

5) Define the method in the added METH object and property in the Prop object. 
It is the end of creating an interface. 
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7.3.2 Mounting to New Function Block 

 
Here, explains how to mount an interface to a function block newly created. 
 
1) Right-click the “Application” object in the device view, and select “Add Object” → “POU...” from 

the displayed menu. 
The “Add POU” dialog should be displayed. 

 
 

2) Input a name, change the type to the function block, enable “Mount”, in put the interface and 
click  Add . 
A function block mounting an interface should be added under the “Application” object. 
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3) Open the editor of the added “METH” object and “Prop” object, and mount the internal process 
for the method and property. 
 

  



7. O
ther Features of C

O
D

ESYS
 
7.3 Interface Object 

7-16 ME0479-1A 

 

 
 

3) Open the editor of the added “METH” object and “Prop” object, and mount the internal process 
for the method and property. 
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7.3.3 Mounting to Existing Function Block 

 
Here, explains how to mount an interface to an existing function block. 
 

1) Open the editor of an existing function block from the device view. 

 
 

2) Right-click an existing function block from the device view, and select “Implement interfaces...” 
from the displayed menu. The “Select Implementation Language” dialog box should be 
displayed. 
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3) Select a describing language, click , and then a method and property should be 

added under the function block.  
 

 
 

4) Open the editor of the added “METH” object and “Prop” object, and mount the internal process 
for the method and property. 
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3) Select a describing language, click , and then a method and property should be 

added under the function block.  
 

 
 

4) Open the editor of the added “METH” object and “Prop” object, and mount the internal process 
for the method and property. 
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7.3.4 Extension of Interface 

 
An existing interface can be inherited and extended. 
Extend the existing interface “ITF” and create the interface “ITF_extend”. 
With the interface “ITF” being existed, an interface should be created. 
 

1) Right-click the “Application” object in the device view, and select “Add Object” → “Interface...” 
from the displayed menu. 
The “Add Interface” dialog should be displayed. 

 

 
 

2) Put a checkmark at “Extend” in the “Add Interface” dialog, and input an interface to be inherited. 
The interface “ITF_extend” should be created. 
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3) Right-click the “ITF_extend” object that was added in the device view, select “Add Object” → 

“Interface Property” or “Interface Method...” in the displayed menu, and add the “ITF_extend” 
object property and a method. 

 
 

4) Right-click the “Application” object in the device view, and select “Add Object” → “POU...” from 
the displayed menu. 
The “Add POU” dialog should be displayed. 
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3) Right-click the “ITF_extend” object that was added in the device view, select “Add Object” → 

“Interface Property” or “Interface Method...” in the displayed menu, and add the “ITF_extend” 
object property and a method. 

 
 

4) Right-click the “Application” object in the device view, and select “Add Object” → “POU...” from 
the displayed menu. 
The “Add POU” dialog should be displayed. 
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5）Input a name, change the type to a function block, activate “Implement”, input “ITF_extend”. And 

click  Add . 
A function block with properties and methods of the both interfaces “ITF_extend” and “ITF” 
should be added under the “Application” object. 
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7.4 Changing Displayed Language 

 
The language to display in CODESYS for XSEL2 can be changed. The languages available to 
select are Germany / English / Chinese (Simplified Characters) / Japanese. 
Here, explains how to change the displayed language. 
 

1) Select “Tool” → “Options...” in the menu. 

 
 

2) Select  in the left box in the option window, and change “User Interface 
Language” and “Help Language” to a requested language.  
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1) Select “Tool” → “Options...” in the menu. 

 
 

2) Select  in the left box in the option window, and change “User Interface 
Language” and “Help Language” to a requested language.  
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7.5 Project archive 

 
In the archive file (*.projectarchive), all the referred data included in the project currently open can 
be saved. All files related to a project such as library and devices can be provided to other users. 

 
7.5.1 Saving archive 
 
1) Select “File” → “Project Archive” → “Save Archive...”. 

 
2) Select an object to save to the archive in the project archive dialog, and click  Save… . 
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3) Input a storage location and file name, and click  Save . 

 
 

 
Caution 
● Even though a message describing that it is not “a library already compiled” in the library 

(CmplAlMotion) of IAI, saving can be done. Disregard this warning. 
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3) Input a storage location and file name, and click  Save . 

 
 

 
Caution 
● Even though a message describing that it is not “a library already compiled” in the library 

(CmplAlMotion) of IAI, saving can be done. Disregard this warning. 
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7.5.2 Unzipping Archives 
 
1) Select “File” → “Project Archive” → “Extract Archive...”. 

 
 

2) Select a storage location and file name, and click  Open . 

 
 

3) Select an storage location and item, and click  Extract . 
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8.1 Error 

 
 
8.1.1 Confirming Error During PLC Operation 
 
[1] How to Confirm Error Online 

When the PLC is stopped during operation due to an error or exception error, the details can be 
confirmed by connecting to CODESYS for XSEL2 and referring to “Device Log”. 

 
 Double-click the area blinking in red below, and the Device Log window should open. 

 
 Refer to the “Log” tab in the Device Setting window, and the Device Log window should open. 

 
 in the figure below shows that an exception error is being occurred. 
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“EXCEPTION” [DivisionByZero] shows that an exception error due to division by zero is 
occurred. 
“SOURCEPOSITION” shows a location of occurrence. Double-click this line and the screen 
transits to the program that the exception error has been occurred. 

 
 
Resolve the cause of the exception error. 

 
 

 
Caution 
● As the device log should be saved in the volatile memory, the recorded data will not be 

saved if the power is shut. 
Confirm errors in operation while the power is on to XSEL2. 
 

 
  

 Exception error occurs because in2 is 0. 
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Confirm errors in operation while the power is on to XSEL2. 
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[2] Export / Import of Device Log 

The device log data is available for export (write into file) and import (read in from file). 
 
 Export Process 
1) Click the  icon in the device log window.  

 

 
 
2) Input a file name, and click  Save . 
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 Import Process 
1) Click the  icon in the device log window.  

 
2) Select a file, and click  Open . 
 

 
 
3) A log should be displayed. 
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 Import Process 
1) Click the  icon in the device log window.  

 
2) Select a file, and click  Open . 
 

 
 
3) A log should be displayed. 
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Caution
● Hidden behind the ToolBox window, the icons for import / export may not be displayed.

If it is not displayed, click either “Auto Hide” or “Close” in the ToolBox window.

● There may be a case that the icons for import / export cannot be shown even if the 
notification window is unhidden.

If it is not displayed, click either “Auto Hide” or “Close” in the device view.
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8.1.2 PLC Exception Error List 

 
Name Explanation Countermeasure 

UNKNOWN Unknown 
Reboot the power. 
Consult with IAI if it frequently occurs. 

WATCHDOG Software Watchdog Timeout 
1) Revise the priority of tasks and program process. 
2) Revise the time and sensitive of the watchdog timer. 

HARDWAREWATCHDOG 
Hardware Watchdog 
Timeout 

Reboot the power.  
Consult with IAI if it frequently occurs. 

IO_CONFIG_ERROR IO Configuration Error Download the project again. 

PROGRAMCHECKSUM Program Checksum Error Download the program again. 

FIELDBUS_ERROR Fieldbus Error 
Reboot the power.  
Consult with IAI if it frequently occurs. 

IOUPDATE_ERROR IO Update Error 
Reboot the power. 
Consult with IAI if it frequently occurs. 

CYCLE_TIME_EXCEED Cycle Time Exceeded Revise the details of PLC program process. 

ONLCHANGE_PROGRAM_ 
EXCEEDED 

Online Change Program 
Excessive 

Online change cannot be made as it exceeds the 
program size available for change online. Download the 
program. 

UNRESOLVED_EXTREFS 
Unsolved External 
Reference 

Reboot the power. 
Consult with IAI if it frequently occurs. 

DOWNLOAD_REJECTED Download Denied 

Check if download is prohibited by the user 
administration feature or access right administration 
feature. 
Consult with IAI if it frequently occurs in a condition that 
download is not prohibited. 

BOOTPROJECT_REJECTED_ 
DUE_RETAIN_ERROR 

Boot Project Cannot be 
Loaded as RETAIN 
Variables Cannot be 
Reallocated 

Download the program again. 

LOADBOOTPROJECT_FAILED Loading Boot Project Failed 

1) Reboot the power. 
2) Redownload the program if it frequently occurs even 

after rebooting the power. 
3) Consult with IAI if it frequently occurs even after 

redownloading. 

OUT_OF_MEMORY Out of Heap Memory 
Reboot the power. 
Consult with IAI if it frequently occurs. 

RETAIN_MEMORY_ERROR 
RETAIN Memory is 
Destroyed or Not Available 
for Mapping 

Download the program again. 

BOOTPROJECT_CRASH 
Boot Project Cannot be 
Loaded as Crashed 

Redownload the program and generate the boot 
application. 

BOOTPROJECTTARGETMISMATCH Boot Project is Unmatched 
Redownload the program and generate the boot 
application. 

SCHEDULEERROR Error in Scheduling Task 
Reboot the power.  
Consult with IAI if it frequently occurs. 
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Name Explanation Countermeasure 

FILE_CHECKSUM_ERR 
Checksum of Download File 
is Unmatched 

Download again. 

RETAIN_IDENTITY_MISMATCH 
RETAIN ID Unmatched with 
Boot Project Program ID 

Download again. 

IEC_TASK_CONFIG_ERROR 
IEC Task Configuration 
Failed 

Reboot the power.  
Consult with IAI if it frequently occurs. 

APP_TARGET_MISMATCH 
Application is operated in a 
wrong target. It can be used 
for library protection. 

Reboot the power.  
Consult with IAI if it frequently occurs. 

ILLEGAL_INSTRUCTION Inappropriate Command 
Reboot the power. 
Consult with IAI if it frequently occurs. 

ACCESS_VIOLATION Access Violation 

It can be considered that the pointer type variables are 
indirectly referred (address contents indicated by pointer 
variables are used for arithmetic) while substitution of an 
address to the pointer type variable is forgotten or an 
inappropriate address is substituted. 
Correct the program. 

PRIV_INSTRUCTION Privileged Command 
Reboot the power. 
Consult with IAI if it frequently occurs. 

IN_PAGE_ERROR Page Violation 
Reboot the power.  
Consult with IAI if it frequently occurs. 

STACK_OVERFLOW Stack Overflow 

Correct the program to reduce the usage of stacks. 
As a factor that the stack overflow gets occurred, there 
are: 
● Recursive call of function or function block 
● Array factors too large 

INVALID_DISPOSITION Ineffective Process 
Reboot the power. 
Consult with IAI if it frequently occurs. 

INVALID_HANDLE Ineffective Operation 
Reboot the power. 
Consult with IAI if it frequently occurs. 

GUARD_PAGE Guard Page 
Reboot the power. 
Consult with IAI if it frequently occurs. 

DOUBLE_FAULT Double Fault 
Reboot the power.  
Consult with IAI if it frequently occurs. 

INVALID_OPCODE Ineffective Operation Code 
Reboot the power.  
Consult with IAI if it frequently occurs. 

MISALIGNMENT Misalignment of Data Type 
Reboot the power.  
Consult with IAI if it frequently occurs. 

ARRAYBOUNDS Array Boundary Exceeded 
Correct the program to use it in the array index declared 
in the variable definition. 

DIVIDEBYZERO Division by Zero 
Correct the program so the denominator of division 
calculation would not be zero. 

OVERFLOW Overflow 
Correct the program so an overflow would not be 
occurred. 

NONCONTINUABLE Not Available to Continue 
Reboot the power.  
Consult with IAI if it frequently occurs. 
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Name Explanation Countermeasure 

PROCESSORLOAD_WATCHDOG 
Processor Load Watchdog 
Detected in All IEC Tasks 

It has exceeded the processor load allowed in the 
software PLC system. Revise the process of the PLC 
program. 
Effective ways to reduce process time are: 
● to delete infinite loop 
● reduce loop process count 
● to delete unnecessary process 

FPU_ERROR FPU: Unknown Error 
Reboot the power. 
Consult with IAI if it frequently occurs. 

FPU_DENORMAL_OPERAND FPU: Denormalized Operant 
Reboot the power.  
Consult with IAI if it frequently occurs. 

FPU_DIVIDEBYZERO FPU: Division by Zero 
Make correction to the program to have the denominator 
of devision in calculation of real numbers not to become 
zero. 

FPU_INEXACT_RESULT FPU: Inappropriate Result 
Reboot the power.  
Consult with IAI if it frequently occurs. 

FPU_INVALID_OPERATION FPU: Invalid Operation 
Reboot the power. 
Consult with IAI if it frequently occurs. 

FPU_OVERFLOW FPU: Overflow 
Reboot the power. 
Consult with IAI if it frequently occurs. 

FPU_STACK_CHECK FPU: Stack check 
Reboot the power. 
Consult with IAI if it frequently occurs. 

FPU_UNDERFLOW FPU: Underflow 
Reboot the power.  
Consult with IAI if it frequently occurs. 
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It has exceeded the processor load allowed in the 
software PLC system. Revise the process of the PLC 
program. 
Effective ways to reduce process time are: 
● to delete infinite loop 
● reduce loop process count 
● to delete unnecessary process 

FPU_ERROR FPU: Unknown Error 
Reboot the power. 
Consult with IAI if it frequently occurs. 

FPU_DENORMAL_OPERAND FPU: Denormalized Operant 
Reboot the power.  
Consult with IAI if it frequently occurs. 

FPU_DIVIDEBYZERO FPU: Division by Zero 
Make correction to the program to have the denominator 
of devision in calculation of real numbers not to become 
zero. 

FPU_INEXACT_RESULT FPU: Inappropriate Result 
Reboot the power.  
Consult with IAI if it frequently occurs. 

FPU_INVALID_OPERATION FPU: Invalid Operation 
Reboot the power. 
Consult with IAI if it frequently occurs. 

FPU_OVERFLOW FPU: Overflow 
Reboot the power. 
Consult with IAI if it frequently occurs. 

FPU_STACK_CHECK FPU: Stack check 
Reboot the power. 
Consult with IAI if it frequently occurs. 

FPU_UNDERFLOW FPU: Underflow 
Reboot the power.  
Consult with IAI if it frequently occurs. 
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8.1.3 List of PLC Related Errors Occurred in SEL System (XSEL2) 

 
No. Level Name Contents and Causes / Countermeasures 

252 Message 
Software PLC 
Exception Error  

[Contents and Causes] 
An exception error has occurred in the software PLC and the software PLC has 
stopped. 
[Countermeasures] 
Connect to CODESYS for XSEL2 and solve a cause of the exception error. 

253 Message 
Software PLC Data 
Error  

[Contents and Causes] 
The software PLC data (program, variable domain) that the flash ROM or backup 
memory is saved has been damaged. 
The followings can be considered as a cause. 
1) The power was cut off during download of the software PLC. 
2) Data corrupted due to noise applied 
[Countermeasures] 
1) Download the application from CODESYS for XSEL2 again or initialize the 

software PLC data from a teaching tool. 
2) Have a countermeasure for noise to the controller (if frequently occurs) 

255 Message 
Software PLC User 
Account Error 

[Contents and Causes] 
The software PLC data stored in the flash ROM or the backup memory (user 
account, certificate or key) has been damaged. 
The followings can be concerned. 
1）Power supply was cut off during write-in of the software PLC user account. 
2) Data corrupted due to noise applied 
[Countermeasures] 
1）Deactivate the PLC feature, initialize the PLC data in a teaching tool, and 

then reboot the controller. 
2) Have a countermeasure for noise to the controller (if frequently occurs) 

4C4 
Operation 
Cancel 

Software PLC 
Out of resources 
error 

[Contents and Causes] 
Memory is not enough in the software PLC. 
[Countermeasures] 
Consider the following three countermeasures. 
• Simplify programs 
• Delete unnecessary programs 
• Communize similar processes with FB (function blocks) 
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No. Level Name Contents and Causes / Countermeasures 

632 Cold Start 
I/O Assignment 
Parameter Error 

[Contents and Causes] 
1) The input (output) port start number and the input (output) used port count at 

the fixed assignment were set as follows: 
● Other than Port No. 0-299, 300-599, 1000-3999 or 4000-6999 
● Not a multiple of 8 

2) Assignment duplication due to parameter setting error 
3) Assignment count exceeded due to parameter setting error 
4) Assignment error in signals or input and output port domains related to 

software PLC due to parameter setting error 
[Countermeasures] 
1) Set the input (output) port start number and the input (output) used port count 

at the fixed assignment to appropriate values 
2) Check the input and output used port count and input and output port start 

number set in the following parameters and confirm that there is no 
duplication in assignment. 
● I/O parameter No.14 to 15 

“I/O1 Fieldbus Remote Input (Output) Used Port Count” 
● I/O parameter No.16 to 17 

“I/O1 Input (Output) Port Start Number at Fixed Assignment” 
● I/O parameter No.687 to 688 

“Remote I/O Unit (IN (OUT) Specification) Connected Unit Count” 
● I/O parameter No.689 to 690 

“Remote I/O Unit Input (Output) Port Start Number at Fixed Assignment” 
3) Check the input and output used port count and input and output port start 

number set in the following parameters to confirm that there is no excess of 
assignment count to the specification. 
● I/O parameter No.14 to 15 

“I/O1 Fieldbus Remote Input (Output) Used Port Count” 
● I/O parameter No.16 to 17 

“I/O1 Input (Output) Port Start Number at Fixed Assignment” 
● I/O parameter No.687 to 688 

“Remote I/O Unit (IN (OUT) Specification) Connected Unit Count” 
● I/O parameter No.689 to 690 

“Remote I/O Unit Input (Output) Port Start Number at Fixed Assignment” 
4) Check the input and output used port count and input and output port start 

number set in the following parameters to confirm that assignment is 
performed following the specification. 
● PLC parameter No.2 “RUN signal Output Port No.” 
● PLC parameter No.3 “ERR signal Output Port No.” 

 
  



8. Troubleshooting
 
8.1 Error 

8-10 ME0479-1A 

No. Level Name Contents and Causes / Countermeasures 
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8.1.4 Operation at PLC Error Occurred 

 
If an error is occurred in PLC, the operation of PLC should stop. For the output signal at stop, follow 
“Output Setting at Stop” at the “PLC Setting” tab in the Device Setting window.  
For details, refer to [4.4.3 I/O Refresh]. 
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8.1.5 Outputting PLC Operation Error Status 

 
The operation / error status of PLC can be externally output. Connect the XSEL PC software or a 
teaching pendant and set up the following parameters. 
 
PLC Parameter 

No. Parameter name Setting at 
Delivery 

Input 
range Unit Explanation 

2 
RUN signal Output Port 
No. 

0 
0 

300 to 599, 
4000 to 5951 

- 

It should be “invalid” when it is set to “0” or a port 
number is used duplicated to other output features. 
 
When 300 to 599 and 4000 to 5951 are set, 
● PLC in Operation: ON 
● PLC in Stop: OFF 
should be output. 

3 
ERR signal Output Port 
No. 

0 
0 

300 to 599, 
4000 to 5951 

- 

It should be “invalid” when it is set to “0” or a port 
number is used duplicated to other output features. 
 
When 300 to 599 and 4000 to 5951 are set, 
● PLC in Error Occurred: ON 
● PLC in Error Not Occurred: OFF 
should be output. 
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8.2 Power Cutoff Operation 

 
When the control power voltage is dropped to 60V or less, the software PLC should stop operation 
and the output should turn off. 
 
 Even if instantaneous power failure less than 20ms (for power frequency 50Hz) / 17ms (for less 

than 60Hz) occurs, there should be no response and the operation should continue. 
 When instantaneous power failure for 20ms (for power frequency 50Hz) / 17ms (for less than 

60Hz) or more occurs, operation should stop and the output should turn OFF. 
 

When operation stops by instantaneous power failure, turn the power on again for recovery. 
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8.3 Restrictions 

 
 The operation commands of an actuator / robot is first come first processed, and the next 

operation command should not be received until the first one is terminated. 
Be aware that, while operating an actuator / robot in a SEL program or with the XSEL PC 
teaching software / teaching pendant, the actuator or robot cannot be operated from the software 
PLC. 

 
 If the software reset is executed from the XSEL PC teaching software, TB-02/03, IAI Protocol 

Format B or input feature select signal, CODESYS should also be rebooted. Confirm that there is 
a measure against the equipment to run out of control during CODESYS system reboot, and pay 
attention for execution. 

 
 In CODESYS Runtime V3.5.18.20, while an exception error is being occurred, 

1) Execute “Debug” → “Single Cycle” 

 
2) Even though the application gets to the single cycle status, a program should not be executed 

and the single cycle status should be kept. 
 

 
 

3) Press the stop button while in the condition of 2), the application cannot be stopped, 
communication to the CODESYS for XSEL2 should be cut, and the software PLC will not 
operate in normal condition after that. In case such a phenomenon has occurred, reboot the 
power. 

 
 Even if the emergency stop input, enable input or driver stop input is made to XSEL2, PLC 

should not stop. 
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8.4 Precautions 

 
 Set up a safety circuit that does not pass through this product so the whole system should work 

to the safety side even when there is any error occurred to this product. 
 
 There is a concern that the product may not control and operate properly due to malfunction of 

output circuit or internal circuit. Make sure to have a safety circuit for controls that may cause fire 
or serious accident. 

 
 Conduct a risk assessment for the whole equipment to make sure that appropriate risk reduction 

measures are taken when this product is installed. Take appropriate protection measures without 
passing through this product so the whole equipment works safely even when an error is 
occurred. 

 
 In order to prevent inappropriate access from an external device via internet or information leak, 

have sufficient network security measures by the user. 
Below shows some examples of network security measures. 

(1) Use this product in a network using such as Firewall. 

(2) Confirm that check to infection to computer viruses and malware programs is conducted 
regularly and exterminated if the product is connected to a PC. 

(3) It is not installed to a place where anonymous people can touch, or lock the place where the 
device is installed. 

(4) Use it in an environment with VPN (Virtual Private Network) or dedicated online network 
being established. 

(5) Limit accessible users by setting up a username and password. 

(6) Certify identification of each other between devices by exchanging the electronic certificate. 
 
 Pay special attention to safety for operation such as program change or compulsory output while 

the system is running.  
It may cause damage to the machinery or accident by operation mistake. 

 
 Refer to manuals related to each network device for the operational conditions when there is a 

communication error in a network including Fieldbus. There is a concern of an accident due to 
error output or error operation. 

  



8.
 T

ro
ub

le
sh

oo
tin

g
 
8.4 Precautions 

8-16 ME0479-1A 

 
 The screen display of CODESYS for XSEL2 described in this manual may differ in some parts 

depending on versions. Confirm the actual screen display in the used CODESYS for XSEL2. 
 
 Never attempt to use this product in a purpose of protecting a human body or a part of human 

body. 
 
 Confirm that there is a measure against the equipment to run out of control during reboot of 

machinery or equipment, and pay attention for execution. 
 
 Make a backup of the CODESYS project file as a preparation to malfunction. 

Data such as PLC programs should be written in the flash ROM. Usually, this data should not be 
lost even if the power is cut. However, the latest data should be saved so that recovery process 
can be quickly taken in case when this controller must be replaced with an alternative due to 
such as malfunction. 
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9.1 Time Setting 

 
9.1.1 XSEL2 Parameter settings 

 
In order to adjust the clock display of the software PLC, it is necessary to conduct the parameter 
setting of offset from the coordinated universal time. 
 
 Other Parameters 

No. Parameter Name 
Setting at 
Delivery 

Input 
range 

Unit Explanation 

13 
Offset (Hours) from Coordinated Universal 
Time (UTC) 

9 -23 to 23 Hour  

14 
Offset (Minutes) from Coordinated 
Universal Time (UTC) 

0 0 to 59 Minute  

 
For the offset hour and minute, refer to the offset table from UTC for each timezone to set the 
timezone values in the XSEL PC software and TB-02/03. 
 
 Offset from UTC for Each Timezone 

ISO 
3166 Timezone 

Offset from 
UTC Timezone description 

Hours Minutes 
AF Afghanistan Standard Time +4 30 Kabul 

AX FLE Standard Time +2 0 Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius 

AL Central Europe Standard Time +1 0 Belgrade, Bratislava, Budapest, Ljubljana, Prague 

DZ W. Central Africa Standard Time +1 0 West Central Africa 

AS UTC-11 -11 0 Coordinated Universal Time-11 

AD W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

AO W. Central Africa Standard Time +1 0 West Central Africa 

AI SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

AQ Pacific SA Standard Time -3 0 Santiago 

AG SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

AR Argentina Standard Time -3 0 City of Buenos Aires 

AM Caucasus Standard Time +4 0 Yerevan 

AW SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

AU AUS Eastern Standard Time +10 0 Canberra, Melbourne, Sydney 

AT W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

AZ Azerbaijan Standard Time +4 0 Baku 

BS Eastern Standard Time -5 0 Eastern Time (US & Canada) 

BH Arab Standard Time +3 0 Kuwait, Riyadh 

BD Bangladesh Standard Time +6 0 Dhaka 

BB SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 
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ISO 
3166 Timezone 

Offset from 
UTC Timezone description 

Hours Minutes 
BY Belarus Standard Time +3 0 Minsk 

BE Romance Standard Time +1 0 Brussels, Copenhagen, Madrid, Paris 

BZ Central America Standard Time -6 0 Central America 

BJ W. Central Africa Standard 
Time 

+1 0 West Central Africa 

BM Atlantic Standard Time -4 0 Atlantic Time (Canada) 

BT Bangladesh Standard Time +6 0 Dhaka 

VE Venezuela Standard Time -4 30 Caracas 

BO SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

BQ SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

BA Central European Standard 
Time 

+1 0 Sarajevo, Skopje, Warsaw, Zagreb 

BW South Africa Standard Time +2 0 Harare, Pretoria 

BV UTC 0 0 Coordinated Universal Time 

BR E. South America Standard 
Time 

-3 0 Brasilia 

IO Central Asia Standard Time +6 0 Astana 

BN Singapore Standard Time +8 0 Kuala Lumpur, Singapore 

BG FLE Standard Time +2 0 Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius 

BF Greenwich Standard Time 0 0 Monrovia, Reykjavik 

BI South Africa Standard Time +2 0 Harare, Pretoria 

CV Cape Verde Standard Time -1 0 Cabo Verde Is. 

KH SE Asia Standard Time +7 0 Bangkok, Hanoi, Jakarta 

CM W. Central Africa Standard 
Time 

+1 0 West Central Africa 

CA Eastern Standard Time -5 0 Eastern Time (US & Canada) 

KY SA Pacific Standard Time -5 0 Bogota, Lima, Quito, Rio Branco 

CF W. Central Africa Standard 
Time 

+1 0 West Central Africa 

TD W. Central Africa Standard 
Time 

+1 0 West Central Africa 

CL Pacific SA Standard Time -3 0 Santiago 

CN China Standard Time +8 0 Beijing, Chongqing, Hong Kong SAR, Urumqi 

CX SE Asia Standard Time +7 0 Bangkok, Hanoi, Jakarta 

CC Myanmar Standard Time +6 30 Yangon (Rangoon) 

CO SA Pacific Standard Time -5 0 Bogota, Lima, Quito, Rio Branco 

KM E. Africa Standard Time +3 0 Nairobi 

CG W. Central Africa Standard 
Time 

+1 0 West Central Africa 

CD W. Central Africa Standard 
Time 

+1 0 West Central Africa 

CK Hawaiian Standard Time -10 0 Hawaii 
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ISO 
3166 Timezone 

Offset from 
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ISO 
3166 Timezone 

Offset from 
UTC Timezone description 

Hours Minutes 
CR Central America Standard Time -6 0 Central America 

CI Greenwich Standard Time 0 0 Monrovia, Reykjavik 

HR Central European Standard 
Time 

+1 0 Sarajevo, Skopje, Warsaw, Zagreb 

CU Eastern Standard Time -5 0 Eastern Time (US & Canada) 

CW SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

CY E. Europe Standard Time +2 0 E. Europe 

CZ Central Europe Standard Time +1 0 Belgrade, Bratislava, Budapest, Ljubljana, Prague 

TL Tokyo Standard Time +9 0 Osaka, Sapporo, Tokyo 

DK Romance Standard Time +1 0 Brussels, Copenhagen, Madrid, Paris 

DJ E. Africa Standard Time +3 0 Nairobi 

DM SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

DO SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

EC SA Pacific Standard Time -5 0 Bogota, Lima, Quito, Rio Branco 

EG Egypt Standard Time +2 0 Cairo 

SV Central America Standard Time -6 0 Central America 

GQ W. Central Africa Standard 
Time 

+1 0 West Central Africa 

ER E. Africa Standard Time +3 0 Nairobi 

EE FLE Standard Time +2 0 Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius 

ET E. Africa Standard Time +3 0 Nairobi 

FK 
(FK) SA Eastern Standard Time -3 0 Cayenne, Fortaleza 

FO GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

FJ Fiji Standard Time +12 0 Fiji 

FI FLE Standard Time +2 0 Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius 

FR Romance Standard Time +1 0 Brussels, Copenhagen, Madrid, Paris 

GF SA Eastern Standard Time -3 0 Cayenne, Fortaleza 

PF Hawaiian Standard Time -10 0 Hawaii 

TF West Asia Standard Time +5 0 Ashgabat, Tashkent 

GA W. Central Africa Standard 
Time 

+1 0 West Central Africa 

GM Greenwich Standard Time 0 0 Monrovia, Reykjavik 

GE Georgian Standard Time +4 0 Tbilisi 

DE W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

GH Greenwich Standard Time 0 0 Monrovia, Reykjavik 

GI W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

GR GTB Standard Time +2 0 Athens, Bucharest 

GL Greenland Standard Time -3 0 Greenland 

GD SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 
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ISO 
3166 Timezone 

Offset from 
UTC Timezone description 

Hours Minutes 
GP SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

GU West Pacific Standard Time +10 0 Guam, Port Moresby 

GT Central America Standard Time -6 0 Central America 

GG GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

GN Greenwich Standard Time 0 0 Monrovia, Reykjavik 

GW Greenwich Standard Time 0 0 Monrovia, Reykjavik 

GY SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

HT Eastern Standard Time -5 0 Eastern Time (US & Canada) 

HM Mauritius Standard Time +4 0 Port Louis 

HN Central America Standard Time -6 0 Central America 

HK China Standard Time +8 0 Beijing, Chongqing, Hong Kong SAR, Urumqi 

HU Central Europe Standard Time +1 0 Belgrade, Bratislava, Budapest, Ljubljana, Prague 

IS Greenwich Standard Time 0 0 Monrovia, Reykjavik 

IN India Standard Time +5 30 Chennai, Kolkata, Mumbai, New Delhi 

id SE Asia Standard Time +7 0 Bangkok, Hanoi, Jakarta 

IR Iran Standard Time +3 30 Tehran 

IQ Arabic Standard Time +3 0 Baghdad 

IE GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

IL Israel Standard Time +2 0 Middle East 

IT W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

JM SA Pacific Standard Time -5 0 Bogota, Lima, Quito, Rio Branco 

SJ W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

JP Tokyo Standard Time +9 0 Osaka, Sapporo, Tokyo 

JE GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

JO Jordan Standard Time +2 0 Amman 

KZ Central Asia Standard Time +6 0 Astana 

KE E. Africa Standard Time +3 0 Nairobi 

KI UTC+12 +12 0 Coordinated Universal Time+12 

KR Korea Standard Time +9 0 Seoul 

XK Central European Standard 
Time 

+1 0 Sarajevo, Skopje, Warsaw, Zagreb 

KW Arab Standard Time +3 0 Kuwait, Riyadh 

KG Central Asia Standard Time +6 0 Astana 

LA SE Asia Standard Time +7 0 Bangkok, Hanoi, Jakarta 

LV FLE Standard Time +2 0 Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius 

LB Middle East Standard Time +2 0 Beirut 

LS South Africa Standard Time +2 0 Harare, Pretoria 
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ISO 
3166 Timezone 

Offset from 
UTC Timezone description 

Hours Minutes 
GP SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

GU West Pacific Standard Time +10 0 Guam, Port Moresby 

GT Central America Standard Time -6 0 Central America 

GG GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

GN Greenwich Standard Time 0 0 Monrovia, Reykjavik 

GW Greenwich Standard Time 0 0 Monrovia, Reykjavik 

GY SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

HT Eastern Standard Time -5 0 Eastern Time (US & Canada) 

HM Mauritius Standard Time +4 0 Port Louis 

HN Central America Standard Time -6 0 Central America 

HK China Standard Time +8 0 Beijing, Chongqing, Hong Kong SAR, Urumqi 

HU Central Europe Standard Time +1 0 Belgrade, Bratislava, Budapest, Ljubljana, Prague 

IS Greenwich Standard Time 0 0 Monrovia, Reykjavik 

IN India Standard Time +5 30 Chennai, Kolkata, Mumbai, New Delhi 

id SE Asia Standard Time +7 0 Bangkok, Hanoi, Jakarta 

IR Iran Standard Time +3 30 Tehran 

IQ Arabic Standard Time +3 0 Baghdad 

IE GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

IL Israel Standard Time +2 0 Middle East 

IT W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

JM SA Pacific Standard Time -5 0 Bogota, Lima, Quito, Rio Branco 

SJ W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

JP Tokyo Standard Time +9 0 Osaka, Sapporo, Tokyo 

JE GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

JO Jordan Standard Time +2 0 Amman 

KZ Central Asia Standard Time +6 0 Astana 

KE E. Africa Standard Time +3 0 Nairobi 

KI UTC+12 +12 0 Coordinated Universal Time+12 

KR Korea Standard Time +9 0 Seoul 

XK Central European Standard 
Time 

+1 0 Sarajevo, Skopje, Warsaw, Zagreb 

KW Arab Standard Time +3 0 Kuwait, Riyadh 

KG Central Asia Standard Time +6 0 Astana 

LA SE Asia Standard Time +7 0 Bangkok, Hanoi, Jakarta 

LV FLE Standard Time +2 0 Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius 

LB Middle East Standard Time +2 0 Beirut 

LS South Africa Standard Time +2 0 Harare, Pretoria 
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ISO 
3166 Timezone 

Offset from 
UTC Timezone description 

Hours Minutes 
LR Greenwich Standard Time 0 0 Monrovia, Reykjavik 

LY E. Europe Standard Time +2 0 E. Europe 

LI W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

LT FLE Standard Time +2 0 Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius 

LU W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

MO China Standard Time +8 0 Beijing, Chongqing, Hong Kong SAR, Urumqi 

MK Central European Standard 
Time 

+1 0 Sarajevo, Skopje, Warsaw, Zagreb 

MG E. Africa Standard Time +3 0 Nairobi 

MW South Africa Standard Time +2 0 Harare, Pretoria 

MY Singapore Standard Time +8 0 Kuala Lumpur, Singapore 

MV West Asia Standard Time +5 0 Ashgabat, Tashkent 

ML Greenwich Standard Time 0 0 Monrovia, Reykjavik 

MT W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

IM GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

MH UTC+12 +12 0 Coordinated Universal Time+12 

MQ SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

MR Greenwich Standard Time 0 0 Monrovia, Reykjavik 

MU Mauritius Standard Time +4 0 Port Louis 

YT E. Africa Standard Time +3 0 Nairobi 

MX Central Standard Time (Mexico) -6 0 Guadalajara, Mexico City, Monterrey 

FM West Pacific Standard Time +10 0 Guam, Port Moresby 

MD GTB Standard Time +2 0 Athens, Bucharest 

MC W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

MN Ulaanbaatar Standard Time +8 0 Ulaanbaatar 

ME Central European Standard 
Time 

+1 0 Sarajevo, Skopje, Warsaw, Zagreb 

MS SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

MA Morocco Standard Time 0 0 Casablanca 

MZ South Africa Standard Time +2 0 Harare, Pretoria 

MM Myanmar Standard Time +6 30 Yangon (Rangoon) 

NA Namibia Standard Time +1 0 Windhoek 

NR UTC+12 +12 0 Coordinated Universal Time+12 

NP Nepal Standard Time +5 45 Kathmandu 

NL W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

NC Central Pacific Standard Time +11 0 Solomon Is., New Caledonia 

NZ New Zealand Standard Time +12 0 Auckland, Wellington 

NI Central America Standard Time -6 0 Central America 
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ISO 
3166 Timezone 

Offset from 
UTC Timezone description 

Hours Minutes 

NE W. Central Africa Standard 
Time 

+1 0 West Central Africa 

NG W. Central Africa Standard 
Time 

+1 0 West Central Africa 

NU UTC-11 -11 0 Coordinated Universal Time-11 

NF Central Pacific Standard Time +11 0 Solomon Is., New Caledonia 

KP Korea Standard Time +9 0 Seoul 

MP West Pacific Standard Time +10 0 Guam, Port Moresby 

NO W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

OM Arabian Standard Time +4 0 Abu Dhabi, Muscat 

PK Pakistan Standard Time +5 0 Islamabad, Karachi 

PW Tokyo Standard Time +9 0 Osaka, Sapporo, Tokyo 

PS Egypt Standard Time +2 0 Cairo 

PA SA Pacific Standard Time -5 0 Bogota, Lima, Quito, Rio Branco 

PG West Pacific Standard Time +10 0 Guam, Port Moresby 

PY Paraguay Standard Time -4 0 Asuncion 

PE SA Pacific Standard Time -5 0 Bogota, Lima, Quito, Rio Branco 

PH Singapore Standard Time +8 0 Kuala Lumpur, Singapore 

PN Pacific Standard Time -8 0 Pacific Time (US & Canada) 

PL Central European Standard 
Time 

+1 0 Sarajevo, Skopje, Warsaw, Zagreb 

PT GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

PR SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

QA Arab Standard Time +3 0 Kuwait, Riyadh 

RE Mauritius Standard Time +4 0 Port Louis 

RO GTB Standard Time +2 0 Athens, Bucharest 

RU Russian Standard Time +3 0 Moscow, St. Petersburg, Volgograd (RTZ 2) 

RW South Africa Standard Time +2 0 Harare, Pretoria 

BL SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

SH Greenwich Standard Time 0 0 Monrovia, Reykjavik 

KN SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

LC SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

MF SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

PM Greenland Standard Time -3 0 Greenland 

VC SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

WS Samoa Standard Time +13 0 Samoa 

SM W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

ST Greenwich Standard Time 0 0 Monrovia, Reykjavik 

SA Arab Standard Time +3 0 Kuwait, Riyadh 
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ISO 
3166 Timezone 

Offset from 
UTC Timezone description 

Hours Minutes 
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PY Paraguay Standard Time -4 0 Asuncion 

PE SA Pacific Standard Time -5 0 Bogota, Lima, Quito, Rio Branco 

PH Singapore Standard Time +8 0 Kuala Lumpur, Singapore 

PN Pacific Standard Time -8 0 Pacific Time (US & Canada) 

PL Central European Standard 
Time 

+1 0 Sarajevo, Skopje, Warsaw, Zagreb 

PT GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

PR SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

QA Arab Standard Time +3 0 Kuwait, Riyadh 

RE Mauritius Standard Time +4 0 Port Louis 

RO GTB Standard Time +2 0 Athens, Bucharest 

RU Russian Standard Time +3 0 Moscow, St. Petersburg, Volgograd (RTZ 2) 

RW South Africa Standard Time +2 0 Harare, Pretoria 

BL SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

SH Greenwich Standard Time 0 0 Monrovia, Reykjavik 

KN SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

LC SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

MF SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

PM Greenland Standard Time -3 0 Greenland 

VC SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

WS Samoa Standard Time +13 0 Samoa 

SM W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

ST Greenwich Standard Time 0 0 Monrovia, Reykjavik 

SA Arab Standard Time +3 0 Kuwait, Riyadh 
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ISO 
3166 Timezone 

Offset from 
UTC Timezone description 

Hours Minutes 
SN Greenwich Standard Time 0 0 Monrovia, Reykjavik 

RS Central Europe Standard Time +1 0 Belgrade, Bratislava, Budapest, Ljubljana, Prague 

SC Mauritius Standard Time +4 0 Port Louis 

SL Greenwich Standard Time 0 0 Monrovia, Reykjavik 

SG Singapore Standard Time +8 0 Kuala Lumpur, Singapore 

SX SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

SK Central Europe Standard Time +1 0 Belgrade, Bratislava, Budapest, Ljubljana, Prague 

SI Central Europe Standard Time +1 0 Belgrade, Bratislava, Budapest, Ljubljana, Prague 

SB Central Pacific Standard Time +11 0 Solomon Is., New Caledonia 

SO E. Africa Standard Time +3 0 Nairobi 

ZA South Africa Standard Time +2 0 Harare, Pretoria 

GS UTC-02 -2 0 Coordinated Universal Time-02 

SS E. Africa Standard Time +3 0 Nairobi 

ES Romance Standard Time +1 0 Brussels, Copenhagen, Madrid, Paris 

LK Sri Lanka Standard Time +5 30 Sri Jayawardenepura 

SD E. Africa Standard Time +3 0 Nairobi 

SR SA Eastern Standard Time -3 0 Cayenne, Fortaleza 

SJ W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

SZ South Africa Standard Time +2 0 Harare, Pretoria 

SE W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

CH W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

SY Syria Standard Time +2 0 Damascus 

TW Taipei Standard Time +8 0 Taipei 

TJ West Asia Standard Time +5 0 Ashgabat, Tashkent 

TZ E. Africa Standard Time +3 0 Nairobi 

TH SE Asia Standard Time +7 0 Bangkok, Hanoi, Jakarta 

TG Greenwich Standard Time 0 0 Monrovia, Reykjavik 

TK Tonga Standard Time +13 0 Nuku'alofa 

TO Tonga Standard Time +13 0 Nuku'alofa 

TT SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

TN W. Central Africa Standard 
Time 

+1 0 West Central Africa 

TR Türkiye Standard Time +2 0 Istanbul 

TM West Asia Standard Time +5 0 Ashgabat, Tashkent 

TC Eastern Standard Time -5 0 Eastern Time (US & Canada) 

TV UTC+12 +12 0 Coordinated Universal Time+12 

UM UTC-11 -11 0 Coordinated Universal Time-11 
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ISO 
3166 Timezone 

Offset from 
UTC Timezone description 

Hours Minutes 
UG E. Africa Standard Time +3 0 Nairobi 

UA FLE Standard Time +2 0 Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius 

AE Arabian Standard Time +4 0 Abu Dhabi, Muscat 

GB GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

US Mountain Standard Time -7 0 Mountain Time (US & Canada) 

US Pacific Standard Time -8 0 Pacific Time (US & Canada) 

UY Montevideo Standard Time -3 0 Montevideo 

UZ West Asia Standard Time +5 0 Ashgabat, Tashkent 

VU Central Pacific Standard Time +11 0 Solomon Is., New Caledonia 

VA W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

VN SE Asia Standard Time +7 0 Bangkok, Hanoi, Jakarta 

VI SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

VG SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

WF UTC+12 +12 0 Coordinated Universal Time+12 

YE Arab Standard Time +3 0 Kuwait, Riyadh 

ZM South Africa Standard Time +2 0 Harare, Pretoria 

ZW South Africa Standard Time +2 0 Harare, Pretoria 

 
 

Example) Example of Parameter Setting for West Europe Standard Time 
 

ISO 
3166 

Timezone 
Offset from UTC 

Time Minutes 

DE W. Europe Standard Time +1 0 
 
 Other Parameters 

No. Parameter Name Setting at 
Delivery 

Input 
range Unit 

13 Offset (Time) from Coordinated 
Universal Time (UTC) 1 -23 to 23 Time 

14 Offset (Minutes) from Coordinated 
Universal Time (UTC) 0 0 to 59 Minutes 
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ISO 
3166 Timezone 

Offset from 
UTC Timezone description 

Hours Minutes 
UG E. Africa Standard Time +3 0 Nairobi 

UA FLE Standard Time +2 0 Helsinki, Kyiv, Riga, Sofia, Tallinn, Vilnius 

AE Arabian Standard Time +4 0 Abu Dhabi, Muscat 

GB GMT Standard Time 0 0 Dublin, Edinburgh, Lisbon, London 

US Mountain Standard Time -7 0 Mountain Time (US & Canada) 

US Pacific Standard Time -8 0 Pacific Time (US & Canada) 

UY Montevideo Standard Time -3 0 Montevideo 

UZ West Asia Standard Time +5 0 Ashgabat, Tashkent 

VU Central Pacific Standard Time +11 0 Solomon Is., New Caledonia 

VA W. Europe Standard Time +1 0 Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna 

VN SE Asia Standard Time +7 0 Bangkok, Hanoi, Jakarta 

VI SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

VG SA Western Standard Time -4 0 Georgetown, La Paz, Manaus, San Juan 

WF UTC+12 +12 0 Coordinated Universal Time+12 

YE Arab Standard Time +3 0 Kuwait, Riyadh 

ZM South Africa Standard Time +2 0 Harare, Pretoria 

ZW South Africa Standard Time +2 0 Harare, Pretoria 

 
 

Example) Example of Parameter Setting for West Europe Standard Time 
 

ISO 
3166 

Timezone 
Offset from UTC 

Time Minutes 

DE W. Europe Standard Time +1 0 
 
 Other Parameters 

No. Parameter Name Setting at 
Delivery 

Input 
range Unit 

13 Offset (Time) from Coordinated 
Universal Time (UTC) 1 -23 to 23 Time 

14 Offset (Minutes) from Coordinated 
Universal Time (UTC) 0 0 to 59 Minutes 
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9.1.2 Operation Process of Teaching Tool 

 
[1] For XSEL PC Teaching Software 

Select “Controller (C)” → “Time Setting (T)” in the menu, and the Time Setting window should be 
displayed. Select either “Manual Input” or “Display PC Time”, input necessary values and click  
 Set . 

 
 
When set to “Display PC Time”, and the current time in the timezone set in the PC should be set. 
The timezone setting in the PC can be checked in “Timezone” in the window of “Start” → 
“Setting” → “Time and Language” → “Date and Time” in Windows. 
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[2] For TB-02/03 

For TB-02/TB-03, touch  Time Setting  in the controller menu window. 

 
 
The controller time should be displayed. Touch  Time Edit  and the screen transits to the edit 
window. 

 
 
Input time using a keyboard and touch  Set . 
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[2] For TB-02/03 

For TB-02/TB-03, touch  Time Setting  in the controller menu window. 

 
 
The controller time should be displayed. Touch  Time Edit  and the screen transits to the edit 
window. 

 
 
Input time using a keyboard and touch  Set . 
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9.1.3 Time Retain Period While Power is OFF 

 
Even though an XSEL2 controller memorizes the current time, the time retain period while the 
power is off should be about ten days. 
If the retain period is exceeded and the clock data is lost, Error Code: 202 “Calendar Feature Error” 
could occur and that may make the certificate look the valid date expired. 
If Error Code: 202 is occurred, follow [9.1.2 Operation Process of Teaching Tool] to set the current 
time again. 
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9.2 Keyboard shortcuts 

 
It is a list of the effective keyboard shortcut in CODESYS for XSEL2. 
 
 File 

Feature Shortcut keys 

New Project Ctrl + N 

Open Project Ctrl + O 

Save Project Ctrl + S 

End Alt + F4 

 
 Edit 

Feature Shortcut keys 

Restore Ctrl + Z 

Redo Ctrl + Y 

Cut Ctrl + X 

Copy Ctrl + Insert 

Paste Ctrl + V 

Delete Delete 

Select all Ctrl + A 

Open typing assistant F2 

Automatic Declaration Shift + F2 

Next message F4 

Previous message Shift + F4 

Switch over Bookmark Ctrl + F12 

Next bookmark F12 

Previous bookmark Shift + F12 

 
 Display 

Feature Shortcut keys 

Device display Alt + 0 

POU display Alt + 1 

Full screen Ctrl + Shift + F12 

Close editor Ctrl + F4 
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9.2 Keyboard shortcuts 

 
It is a list of the effective keyboard shortcut in CODESYS for XSEL2. 
 
 File 

Feature Shortcut keys 

New Project Ctrl + N 

Open Project Ctrl + O 

Save Project Ctrl + S 

End Alt + F4 

 
 Edit 

Feature Shortcut keys 

Restore Ctrl + Z 

Redo Ctrl + Y 

Cut Ctrl + X 

Copy Ctrl + Insert 

Paste Ctrl + V 

Delete Delete 

Select all Ctrl + A 

Open typing assistant F2 

Automatic Declaration Shift + F2 

Next message F4 

Previous message Shift + F4 

Switch over Bookmark Ctrl + F12 

Next bookmark F12 

Previous bookmark Shift + F12 

 
 Display 

Feature Shortcut keys 

Device display Alt + 0 

POU display Alt + 1 

Full screen Ctrl + Shift + F12 

Close editor Ctrl + F4 
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●FBD/LD/IL Editor 

Feature Shortcut keys 

Insert Network Ctrl + I 

Insert Network (Below) Ctrl + T 

Switch Network Comment Status Ctrl + O 

Insert Assignment Ctrl + A 

Insert Coil Ctrl + A 

Insert Contacts Ctrl + K 

Insert Contacts (Right) Ctrl + D 

Insert Parallel Contacts Above Ctrl + P 

Insert Parallel Contacts Below Ctrl + R 

Insert Box Ctrl + B 

Insert Empty Box Ctrl + Shift + B 

Insert Box with EN/ENO Ctrl + Shift + E 

Insert Jump Ctrl + L 

Insert Input Ctrl + Q 

Insert Deny Ctrl + N 

Insert Edge Detection Ctrl + E 

Insert SET/RESET Ctrl + M 

Set Output Connection Ctrl + W 

Insert Branch Ctrl + Shift + V 

Update Parameter Ctrl + U 

Delete IL Line Ctrl + Delete 

Show as FBD Ctrl + 1 

Show as LD Ctrl + 2 

Show as IL Ctrl + 3 

 
 Build 

Feature Shortcut keys 

Generate code F11 

 
 Online 

Feature Shortcut keys 

Login Alt + F8 

Logout Ctrl + F8 
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 Debug 

Feature Shortcut keys 

Operation F5 

Stop Shift + F8 

Single Cycle Ctrl + F5 

Switch Break Point F9 

Step Over F10 

Step In F8 

Step Out Shift + F10 

Cancel Compulsion of Value Alt + F7 

Compulsory of Values F7 

Write-in of Values Ctrl + F7 

 
 Window 

Feature Shortcut keys 

Show Next Editor Ctrl + F6 

Show Previous Editor Ctrl + Shift + F6 

Show Next Frame F6 

Show Previous Frame Shift + F6 

Switch 1st Frame Alt + F6 

 
 Help 

Feature Shortcut keys 

Open table of contents Ctrl + Shift + F1 

Open index Ctrl + Shift + F2 
 
In CODESYS for XSEL2, it is available to customize keyboard shortcuts previously defined and 
extend them. Click “Tool” → “Customize” to open the customize dialog, and then select the 
“Keyboard” tab to establish settings. 
For details, refer to [CODESYS online help (https://www.helpme-codesys.com/)] to set it up. 
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9.3 License of Software Used in CODESYS for XSEL2 

 
 
This product contains the following program for the open source software (OSS) as well as the 
software that IAI has the rights. 
• OpenSSL 3.0.11 (Apache License 2.0) 
 
Below shows the original text of the license terms of the applicable software. 

 
 
 

Apache License 
Version 2.0, January 2004 

http://www.apache.org/licenses/ 

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION 

1. Definitions. 

"License" shall mean the terms and conditions for use, reproduction, and distribution as 
defined by Sections 1 through 9 of this document. 

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner 
that is granting the License. 

"Legal Entity" shall mean the union of the acting entity and all other entities that control, 
are controlled by, or are under common control with that entity. For the purposes of this 
definition, "control" means (i) the power, direct or indirect, to cause the direction or 
management of such entity, whether by contract or otherwise, or (ii) ownership of fifty 
percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such 
entity. 

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted 
by this License. 

"Source" form shall mean the preferred form for making modifications, including but not 
limited to software source code, documentation source, and configuration files. 

"Object" form shall mean any form resulting from mechanical transformation or 
translation of a Source form, including but not limited to compiled object code, generated 
documentation, and conversions to other media types. 

"Work" shall mean the work of authorship, whether in Source or Object form, made 
available under the License, as indicated by a copyright notice that is included in or 
attached to the work (an example is provided in the Appendix below). 
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"Derivative Works" shall mean any work, whether in Source or Object form, that is based 
on (or derived from) the Work and for which the editorial revisions, annotations, 
elaborations, or other modifications represent, as a whole, an original work of authorship. 
For the purposes of this License, Derivative Works shall not include works that remain 
separable from, or merely link (or bind by name) to the interfaces of, the Work and 
Derivative Works thereof. 

"Contribution" shall mean any work of authorship, including the original version of the 
Work and any modifications or additions to that Work or Derivative Works thereof, that is 
intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by 
an individual or Legal Entity authorized to submit on behalf of the copyright owner. For 
the purposes of this definition, "submitted" means any form of electronic, verbal, or 
written communication sent to the Licensor or its representatives, including but not limited 
to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of 
discussing and improving the Work, but excluding communication that is conspicuously 
marked or otherwise designated in writing by the copyright owner as "Not a 
Contribution." 

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom 
a Contribution has been received by Licensor and subsequently incorporated within the 
Work. 

2. Grant of Copyright License. Subject to the terms and conditions of this License, each 
Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, 
royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, 
publicly display, publicly perform, sublicense, and distribute the Work and such Derivative 
Works in Source or Object form. 

3. Grant of Patent License. Subject to the terms and conditions of this License, each 
Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, 
royalty-free, irrevocable (except as stated in this section) patent license to make, have 
made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license 
applies only to those patent claims licensable by such Contributor that are necessarily 
infringed by their Contribution(s) alone or by combination of their Contribution(s) with the 
Work to which such Contribution(s) was submitted. If You institute patent litigation against 
any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or 
a Contribution incorporated within the Work constitutes direct or contributory patent 
infringement, then any patent licenses granted to You under this License for that Work 
shall terminate as of the date such litigation is filed. 

  



9. Appendix
 
9.3 License of Software Used in CODESYS for XSEL2 

9-16 ME0479-1A 

 

"Derivative Works" shall mean any work, whether in Source or Object form, that is based 
on (or derived from) the Work and for which the editorial revisions, annotations, 
elaborations, or other modifications represent, as a whole, an original work of authorship. 
For the purposes of this License, Derivative Works shall not include works that remain 
separable from, or merely link (or bind by name) to the interfaces of, the Work and 
Derivative Works thereof. 

"Contribution" shall mean any work of authorship, including the original version of the 
Work and any modifications or additions to that Work or Derivative Works thereof, that is 
intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by 
an individual or Legal Entity authorized to submit on behalf of the copyright owner. For 
the purposes of this definition, "submitted" means any form of electronic, verbal, or 
written communication sent to the Licensor or its representatives, including but not limited 
to communication on electronic mailing lists, source code control systems, and issue 
tracking systems that are managed by, or on behalf of, the Licensor for the purpose of 
discussing and improving the Work, but excluding communication that is conspicuously 
marked or otherwise designated in writing by the copyright owner as "Not a 
Contribution." 

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom 
a Contribution has been received by Licensor and subsequently incorporated within the 
Work. 

2. Grant of Copyright License. Subject to the terms and conditions of this License, each 
Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, 
royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, 
publicly display, publicly perform, sublicense, and distribute the Work and such Derivative 
Works in Source or Object form. 

3. Grant of Patent License. Subject to the terms and conditions of this License, each 
Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, 
royalty-free, irrevocable (except as stated in this section) patent license to make, have 
made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license 
applies only to those patent claims licensable by such Contributor that are necessarily 
infringed by their Contribution(s) alone or by combination of their Contribution(s) with the 
Work to which such Contribution(s) was submitted. If You institute patent litigation against 
any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or 
a Contribution incorporated within the Work constitutes direct or contributory patent 
infringement, then any patent licenses granted to You under this License for that Work 
shall terminate as of the date such litigation is filed. 
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4. Redistribution. You may reproduce and distribute copies of the Work or Derivative 
Works thereof in any medium, with or without modifications, and in Source or Object form, 
provided that You meet the following conditions: 

a. You must give any other recipients of the Work or Derivative Works a copy of this 
License; and 

b. You must cause any modified files to carry prominent notices stating that You 
changed the files; and 

c. You must retain, in the Source form of any Derivative Works that You distribute, 
all copyright, patent, trademark, and attribution notices from the Source form of 
the Work, excluding those notices that do not pertain to any part of the Derivative 
Works; and 

d. If the Work includes a "NOTICE" text file as part of its distribution, then any 
Derivative Works that You distribute must include a readable copy of the attribution 
notices contained within such NOTICE file, excluding those notices that do not 
pertain to any part of the Derivative Works, in at least one of the following places: 
within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, 
within a display generated by the Derivative Works, if and wherever such third-
party notices normally appear. The contents of the NOTICE file are for 
informational purposes only and do not modify the License. You may add Your 
own attribution notices within Derivative Works that You distribute, alongside or as 
an addendum to the NOTICE text from the Work, provided that such additional 
attribution notices cannot be construed as modifying the License. 

You may add Your own copyright statement to Your modifications and may provide 
additional or different license terms and conditions for use, reproduction, or distribution of 
Your modifications, or for any such Derivative Works as a whole, provided Your use, 
reproduction, and distribution of the Work otherwise complies with the conditions stated 
in this License. 

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution 
intentionally submitted for inclusion in the Work by You to the Licensor shall be under the 
terms and conditions of this License, without any additional terms or conditions. 
Notwithstanding the above, nothing herein shall supersede or modify the terms of any 
separate license agreement you may have executed with Licensor regarding such 
Contributions. 

6. Trademarks. This License does not grant permission to use the trade names, 
trademarks, service marks, or product names of the Licensor, except as required for 
reasonable and customary use in describing the origin of the Work and reproducing the 
content of the NOTICE file. 
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7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, 
Licensor provides the Work (and each Contributor provides its Contributions) on an "AS 
IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express 
or implied, including, without limitation, any warranties or conditions of TITLE, NON-
INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. 
You are solely responsible for determining the appropriateness of using or redistributing 
the Work and assume any risks associated with Your exercise of permissions under this 
License. 

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including 
negligence), contract, or otherwise, unless required by applicable law (such as deliberate 
and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You 
for damages, including any direct, indirect, special, incidental, or consequential damages 
of any character arising as a result of this License or out of the use or inability to use the 
Work (including but not limited to damages for loss of goodwill, work stoppage, computer 
failure or malfunction, or any and all other commercial damages or losses), even if such 
Contributor has been advised of the possibility of such damages. 

9. Accepting Warranty or Additional Liability. While redistributing the Work or 
Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of 
support, warranty, indemnity, or other liability obligations and/or rights consistent with this 
License. However, in accepting such obligations, You may act only on Your own behalf 
and on Your sole responsibility, not on behalf of any other Contributor, and only if You 
agree to indemnify, defend, and hold each Contributor harmless for any liability incurred 
by, or claims asserted against, such Contributor by reason of your accepting any such 
warranty or additional liability. 

END OF TERMS AND CONDITIONS 
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